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पृष्ठ भ्ूमि

शिक्षा का उद्देश्य विद्यार थ्ियो ंके लिए विभिन्न पहलुओ,ं विषयो ंमें ज्ञान प्राप्त करने को समाहित करना है जो 
उन्हें उनके भविष्य के लिए तैयार करती है। जैसे कि विज्ञान, सामाजिक विज्ञान, गणित, भाषा आदि। शिक्षा 
के माध्यम से विद्यार थ्ियो ं का व्यक्तित्व विकसित होता है, जो उन्हें सामाजिक, नैतिक, और आत्म-संज्ञान 
में सहायक होता है।  शिक्षा विद्यार थ्ियो ंके कौशल और योग्यताओ ंको विकसित करती है, जो उन्हें सक्षम 
नागरिक और एक सफल व्यक्ति बनाने में मदद करता है। शिक्षा विद्यार थ्ियो ंको उनके क्षमताओ,ं रुचियो ं
और इच्छाओ ंके आधार पर सही करियर का चयन करने में मदद करती है। शिक्षित विद्यार्थी समाज की 
सेवा में योग्य और सक्षम नागरिक बनते हैं, जो समाज में उपयोगी योगदान करते हैं। इसी सन्दर्भ मे, “सूचना 
तकनीकी, (आई .टी.) शिक्षा” का उद्देश्य विद्यार थ्ियो ं को सामान्य तौर पर उनके व्यक्तित्व को निखारना, 
आत्मविश्वास को जागृत करना है। समय बदल रहा है और इसके साथ-साथ हमारे विद्यालयी शिक्षा की  
पैरवी भी बदल रही है। वर्तमान समय मे,हमारे पाठ्यक्रम में “सूचना तकनीकी, (आई .टी.)” का विशेष 
महत्व है,जिसका उद्देश्य, छात्रों को समृद्धि की दिशा में मार्गदर्शन करना, तथा उनके सामान्य जीवन में 
जुड़े हुए क्षेत्रों को शिक्षा में सूचना तकनीकी, (आई .टी.)” द्वारा एकीकृत कर सामान्यकरण करना है। इस 
पुस्तक के माध्यम से कक्षा 9 के विद्यार थ्ियो ंके लिए उनके निजी जीवन, शैक्षिक, व्यावसायिक आदि क्षेत्रों में 
भविष्य में मार्गदर्शन करना है, ऐसी हमें आशा है। सूचना तकनीकी, (आई .टी.) शिक्षा विद्यार थ्ियो ंको इसका 
सामान्य ज्ञान,व्यवसायिक और सामाजिक संबंधो ंको समझने, दूरियो ंको कम करने,समृद्ध भविष्य के लिए 
उनकी पहचान के साथ-साथ उन्हें स्वतंत्रता और स्वाधीनता की भावना भी प्रदान में मददगार साबित हो 
सकेगी। सूचना तकनीकी, (आई .टी.) शिक्षा का व्यहवारिक ज्ञान बहुत ही सरल भाषा मे प्रस्तुत करने का 
प्रयास किया गया है, ताकि हमारे कक्षा 9 के विद्यार थ्ियो ंके भाषायी स्तर, विषयवस्तु के ज्ञान को अर्जित करने 
मे कठिनाई का सामना न करना पड़े। इसी के साथ चित्रों के माध्यम से विषयवस्तु को समझने मे एक मन 
मानचित्रण के द्वारा विद्यार्थी अपनी समझ विकसित कर सके।    

डॉ अनामिका सिह, 
समन्वयक
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इकाई - 1 

आई.टी.-आई.टी.ई.एस. उद्योग का परिचय

सीखने के प्रतिफल

विद्यार्थी:

•	 सूचना एवं सूचना प्रौद्योगिकी (IT/ आई.टी.) जैसे शब्दों की अवधारणा से परिचय प्राप्त करते हैं।

•	 डेटा और सूचना के बीच संबंध खोजते हैं।

•	 आईटी सक्षम सेवाओ ंके महत्व को समझते हैं।

•	 भारत के विकास में बी.पी.ओ. (BPO) और बी.पी.एम. (BPM) की भूमिका की सराहना करते हैं।

•	 बी.पी.ओ. और बी.पी.एम. के बीच समानताओ ंऔर अंतर के प्रति समझ बनाते हैं।

•	 आई.टी. के विभिन्न अनुप्रयोगो ंकी जानकारी प्राप्त करते हैं।

परिचय (Introduction)

कार्यकलाप (Activity)

कल्पना कीजिए कि आपको अमेरिका में अपने किसी मित्र को कागज पर लिखा एक पत्र भेजना है।

•	 इसमे कितना समय लगेगा?

•	 क्या यह आसान होगा?

•	 क्या यह महंगा होगा?

•	 क्या आपके मित्र को वह संदेश भेजने का कोई तेज़, सस्ता तरीका है?

संकेत: हाँ, तेज़ तरीका हो सकता है। शायद व्हाट्सएप, या फेसबुक, या किसी ऐसे ही सोशल मीडिया 
प्लेटफॉर्म के माध्यम से।

सोचिये:

•	 क्या आप व्हाट्सएप के माध्यम से संदेश भेजने के लिए पैसो ंका भुगतान करते हैं?
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•	 इन संदेशो ंको भेजने में कितना समय लगता है?

•	 आपको और आपके मित्र को चैटिग (संदेशो ं के आदान-प्रदान) के लिए किन-किन चीज़ों की 
आवश्यकता है?

•	 सूचना का यह ट्रान्सफर किस कारण संभव हुआ?

सूचनाओ ंके आदान-प्रदान के लिए आवश्यक प्रौद्योगिकी सूचना प्रौद्योगिकी या आई.टी. (IT) कहलाती है। 
इसमें कंप्यूटर हार्डवेयर और सॉफ्टवेयर तकनीक शामिल है जिसका उपयोग जानकारी बनाने, संग्रहीत 
करने और स्थानांतरित (ट्रांसफर) करने के लिए किया जाता है। कभी-कभी शिक्षा के क्षेत्र में IT को ICT 
यानी सूचना और संचार प्रौद्योगिकी भी कहा जाता है।

अध्याय एक नज़र में:

फ्लो चार्ट 1.1 – पाठ का सारांश
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सूचना क्या है और सूचना कैसे बनती है?

चित्र 1.1 – सूचना प्रोसेसिग

जैसे, आटे को तवे पर सेंक कर रोटी बनाई जाती है। वैसे ही: डेटा को कंप्यूटर में प्रोसेस कर सूचना प्राप्त 
होती है।

सरल शब्दों में, सूचना प्रोसेस (संसाधित) किया हुआ डेटा है, जोकि उपयोगी अथवा सार्थक है (चित्र 1.1)।

क्या आई.टी. व्यवसायो ंऔर संगठनो ंकी मदद कर सकता है?

सूचना प्रौद्योगिकी (आई.टी.) का उपयोग व्यवसायो ंऔर संगठनो ंको विभिन्न सेवाएं प्रदान करने के लिए 
किया जा सकता है। इन सेवाओ ंको आई.टी. सक्षम सेवाएं (आई.टी.ई.एस.) कहा जाता है। आई.टी. सक्षम 
सेवाएं मूल रूप से लागत कम करती हैं और सेवा मानको ंमें सुधार करती हैं।

ये सेवाएँ कैरियर विकल्पों की एक विस्तृत श्रृंखला भी प्रदान करती हैं जिनमें कॉल सेंटर, पेरोल, लॉजिस्टिक्स 
प्रबंधन, रेवेन्यू क्लेम प्रोसेसिग, मेडिकल बिलिग, कोडिग, मेडिकल ट्रांसक्रिप्शन, कानूनी डेटाबेस, बैक 
ऑफिस ऑपरेशन्स (संचालन), कंटेंट डेवलपमेंट, जी.आई.एस. (भौगोलिक सूचना प्रणाली), वेब सेवाएँ और 
मानव संसाधन (एच.आर.) सेवाएं, आदि जैसे सभी कार्यालयो ंमें अवसर शामिल हैं।

कुछ आई.टी.ई.एस. सेवाएँ इस प्रकार हैं:

1.	 मेडिकल ट्रांसक्रिप्शन,

2.	 कस्टमर रिलेशनशिप मैनेजमेंट (ग्राहक संबंध प्रबंधन),
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3.	 डेटा एंट्री और डेटा प्रोसेसिग,

4.	 सॉफ्टवेयर डेवलपमेंट,

5.	 डेटा वेयरहाउसिग (डेटा भण्डारण),

6.	 आई.टी. हेल्प डेस्क सेवाएँ,

7.	 एंटरप्राइज रिसोर्स प्लानिंग (उद्यम संसाधन योजना), और

8.	 टेलीकम्यूनिकेशन सेवाएँ (दूरसंचार सेवाएँ)।

बिजनेस प्रोसेस आउटसोर्सिंग (BPO) और बिजनेस प्रक्रिया प्रबंधन (BPM) सेवाएं आई.टी.ई.एस. 
के प्रकार कहे जा सकते हैं जो अमूमन आउटसोर्स किए जाते हैं, अर्थात भिन्न- भिन्न संस्थाओ ंसे सहायता 
संसाधन के रूप में ली जाती हैं।

बी.पी.ओ. (BPO) क्या है?

बिजनेस प्रोसेस आउटसोर्सिंग (बी.पी.ओ.) का अर्थ है किसी बाहरी सेवा प्रदाता के माध्यम से व्यवसाय 
संचालन करना।

कुछ बी.पी.ओ. सेवाएँ इस प्रकार हैं:

1.	वि त्तीय और लेखा सेवाएं

2.	 कराधान और बीमा सेवाएँ

3.	 ई-प्रकाशन और वेब प्रचार

4.	 कानूनी सेवाएँ और सामग्री लेखन

5.	 मल्टीमीडिया और डिज़ाइन सेवाएँ

6.	 दस्तावेज़ प्रबंधन सेवाएं

7.	 सॉफ्टवेयर परीक्षण सेवाएँ

8.	स्वा स्थ्य देखभाल सेवाएं
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बी.पी.ओ. सेवा उद्योग निम्नलिखित कारणो ंसे भारत में असाधारण रूप से अच्छा प्रदर्शन कर रहा 
है:

•	 भारत में बी.पी.ओ. सेवा प्रदाता सर्वोत्तम सेवाएं प्रदान करने के लिए हाईटेक हार्डवेयर और सॉफ्टवेयर 
में निवेश करते हैं।

•	 भारत सरकार बी.पी.ओ. उद्योग को प्रोत्साहित कर रही है।

•	 भारत में बी.पी.ओ. उद्योग असाधारण गुणवत्ता में विभिन्न प्रकार की सेवाएँ प्रदान करता है।

बी.पी.एम. क्या है?

बिजनेस प्रोसेस मैनेजमेंट (बी.पी.एम.) या आई.टी.-बी.पी.एम. सेवाएं ऐसी सेवाएं हैं जो व्यवसायो ंको अधिक 
कुशल, उत्पादक और लागत प्रभावी बनाने के लिए उनकी प्रक्रियाओ ंको बेहतर करती हैं।

आई.टी. बी.पी.एम. उद्योग ने भारत को व्यापक आर थ्िक और सामाजिक लाभ प्रदान किए हैं जिनमें रोजगार 
सृजन, आय स्तर बढ़ाना, निर्यात को बढ़ावा देना और जीडीपी (सकल घरेलू उत्पाद) में वृद्धि शामिल है।

बी.पी.एम. उद्योग की संरचना:

आई.टी. बी.पी.एम. उद्योग की संरचना निम्न प्रकार से है।

प्रकार मुख्यालय* कार्यालय* ग्राहक*

बहुराष्ट्री य कंपनियां 
(एमएनसी)

भारत के बाहर (विदेशी) दुनिया भर में अनेक 
स्थान

बाह्य - घरेलू और/या 
वैश्विक

भारतीय सेवा प्रदाता 
(आई.एस.पी)

भारत के अंदर (घरेलू) दुनिया भर में अनेक 
स्थान

बाह्य - घरेलू और/या 
वैश्विक

ग्लोबल इन-हाउस सेंटर 
(जीआईसी)

भारत के बाहर (विदेश) दुनिया भर में अनेक 
स्थान

आंतरिक या मूल कंपनी

* स्थान सांकेतिक हैं, अपवाद भी हो सकते हैं

बी.पी.ओ. और बी.पी.एम. में क्या अंतर है?

हालांकि बी.पी.एम. एक व्यापक शब्द है, ज़्यादातर बी.पी.ओ. और बी.पी.एम. को एक दूसरे के बदले 
इस्तेमाल किया जा सकता है। अर्थात अधिकांश आई.टी. सक्षम सेवाओ ंको बी.पी.ओ. और बी.पी.एम. दोनो ं
के अंतर्गत वर्गीकृत किया जा सकता है।
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बी.पी.एम. बी.पी.ओ.

•	 बी.पी.एम. समग्र व्यावसायिक प्रक्रिया को 
बेहतर बनाने पर ध्यान कें द्रित करता है।

•	 बी.पी.ओ. विशिष्ट कार्यों को आउटसोर्स करने 
पर कें द्रित रहता है।

•	 बी.पी.एम. का लक्ष्य पूरी प्रक्रिया की दक्षता 
और उत्पादकता में सुधार करना है।

•	 बी.पी.ओ. का लक्ष्य लागत कम करना और 
विशिष्ट सेवाओ ं की गुणवत्ता में सुधार करना 
है।

सूचना प्रौद्योगिकी (आई.टी.) के विभिन्न अनुप्रयोग (applications) क्या हैं?

आजकल सूचना प्रौद्योगिकी दुनिया भर में हर जगह देखी जा सकती है। हम सभी इसका उपयोग हर दिन 
कर रहे हैं। यहां हम अपने दैनिक जीवन में आई.टी. के कुछ अनुप्रयोगो ंपर चर्चा करें गे। हम चर्चा करें गे 
कि घर से लेकर स्कू ल और कार्यालयो ंतक आई.टी. हमारे जीवन में कैसे शामिल है (चित्र 1.2)।

चित्र 1.2 – आई.टी. अनुप्रयोग

होम कंप्यूटिग में आई.टी.

हम अपने घर पर एक पीसी (पर्सनल कंप्यूटर) का उपयोग करते हैं। कंप्यूटर का उपयोग हमारे घरो ंमें 
इंटरनेट सर्फिं ग, प्रेजेंट�शन, वीडियो, गेम आदि बनाने के लिए किया जाता है (चित्र 1.3)।
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चित्र 1.3 – होम कंप्यूटिग में आई.टी.

रोजमर्रा की जिदगी में आई.टी.

हमारे दैनिक जीवन में, हम जिन उपकरणो ं का उपयोग कर रहे हैं उनमें से अधिकांश सॉफ्टवेयर के 
साथ एम्बेडेड (अन्तर्निहित) हैं। सेट-टॉप बॉक्स में हमारे साथ बातचीत करने और हमें एक अच्छा अनुभव 
देने के लिए सॉफ्टवेयर है। ऐसे ही तापमान बनाए रखने के लिए माइक्रोवेव के पास अपना सॉफ्टवेयर है  
(चित्र 1.4)।

चित्र 1.4 – रोजमर्रा की जिदगी में आई.टी.
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लाइब्रेरी में आई.टी.

आजकल लाइब्रेरी में किताबें संभालना इतना कठिन काम नही ं है। पुस्तकालय अब कम्प्यूटरीकृत हो गए 
हैं। बहुत सारी पुस्तको ंको प्रबंधित करने के लिए बारकोड को पुस्तको ंके साथ जोड़ा जा सकता है जिससे 
उपलब्ध पुस्तको ंऔर कई अन्य पुस्तको ंकी सूची पर नज़र रखना आसान हो जाता है (चित्र 1.5)।

चित्र 1.5 – लाइब्रेरी में आई.टी.

कार्यस्थल पर आई.टी.

सभी कार्यालय कम्प्यूटर से सुसज्जित हैं। अब ज्यादातर काम कंप्यूटर पर होता है। दफ्तरो ंमें कंप्यूटर और 
सॉफ्टवेयर उनके काम को बहुत आसान और तेज बना देते हैं (चित्र 1.6)।

चित्र 1.6 – कार्यस्थल पर आई.टी.
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शिक्षा में आई.टी.

पढ़न-पढ़ाने एवं सीखने-सिखाने की प्रक्रियाओ ं के लिए सूचना प्रौद्योगिकी आई.टी. का शिक्षा में बहुत 
अधिक उपयोग किया जाता है। सॉफ्टवेयर और हार्डवेयर ने सीखने की प्रक्रिया को बहुत आसान बना 
दिया है। हम शैक्षिक वीडियो में बहुत सारे एनिमेशन देख सकते हैं जो पढ़ाई को बहुत दिलचस्प बनाते हैं। 
वास्तविक दुनिया में हम जो पढ़ रहे हैं उसकी कल्पना करने के लिए अब चित्रण के विभिन्न तरीके लाए 
गए हैं (चित्र 1.7)।

चित्र 1.7 – शिक्षा में आई.टी.

i.	 कक्षा में आई.सी.टी.

	 आई.सी.टी. का उपयोग स्कू लो ंमें विभिन्न तरीको ंसे किया जा सकता है, जैसे:

	 •	 ई-लर्निंग कक्षाएं;

	 •	 स्मार्ट-बोर्ड प्रस्तुतियाँ;

	 •	 प्रयोगो ंपर वीडियो;

	 •	 छवियो ंऔर वीडियो का निर्माण;

	 •	 पत्रिकाओ,ं पत्रों और दस्तावेजो ंका डिजिटल प्रकाशन।

ii.	शिक्षा  - कही ंभी कभी भी

	 बहुत सारी किताबें और शैक्षिक सामग्री अब डिजिटल हो गई हैं। हम जब चाहें तब सामग्री प्राप्त कर 
सकते हैं। हमारी सरकार एनसीईआरटी पुस्तको ंको ऑनलाइन रूप से प्राप्त करने के लिए वेबसाइट 
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भी उपलब्ध करा रही है।

iii.	शि क्षण सहायक सामग्री और मीडिया

	 आई.सी.टी. का उपयोग अधिकतर स्कू लो ंमें शिक्षण को सरल व रुचिकर बनाने के लिए किया जाता 
है।

	 •	�जिन  विषयो ं को समझाना कठिन है, उन्हें समझाने के लिए चित्रों, एनिमेशन और ऑडियो-
विज़ुअल का उपयोग किया जा रहा है।

	 •	 प्रस्तुतियो ंका उपयोग करके पाठो ंको रोचक बनाया जा रहा है।

	 •	 कंप्यूटर का उपयोग करके पाठ योजनाएं तैयार की जा रही हैं।

iv.	 अधिगम प्रबंधन प्रणाली (एल.एम.एस.)

	 कई स्कू लो ंद्वारा अपने स्कू ल सिस्टम को प्रबंधित करने के लिए लर्निंग मैनेजमेंट सिस्टम (एल.एम.एस.) 
का उपयोग किया जा रहा है। यह प्रणाली उपस्थिति और परिणाम के प्रबंधन के लिए बहुत उपयोगी 
है। विद्यार थ्ियो ंके डेटा को प्रभावी तरीके से रिकॉर्ड करने के लिए इसे अच्छी तरह से डिज़ाइन किया 
गया है।

मनोरंजन में आई.टी.

अब हम सब मोबाइल और कंप्यूटर का उपयोग करके फिल्में डाउनलोड कर सकते हैं, गेम खेल सकते 
हैं, चैट कर सकते हैं, वीडियो कॉल कर सकते हैं। डिजिटल प्रसारण ने दुनिया के लिए टेलीविजन देखने 
के अनुभव को बदल दिया है। डिजिटल प्रोग्राम अब अधिक इंटरैक्टिव हैं और बहुत अधिक ग्राफिक्स 
डिजाइनिंग का उपयोग करते हैं (चित्र 1.8)।

चित्र 1.8 – मनोरंजन में आई.टी.
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संचार में आई.टी.

संचार में आई.टी. की महत्वपूर्ण भूमिका है। हम सभी विभिन्न प्लेटफार्मों के माध्यम से आसानी से चैट कर 
सकता है। वीडियो कॉलिग अब और भी आसान हो गई है। आई.टी. ने वास्तव में संचार का तरीका बदल 
दिया है (चित्र 1.9)।

चित्र 1.9 – संचार में आई.टी.

व्यवसाय में आई.टी.

कंप्यूटर का उपयोग व्यावसायिक संगठनो ं में पेरोल गणना, बिक्री विश्लेषण (sales analysis), वित्तीय 
पूर्वानमान (financial forecasting), स्टॉक के प्रबंधन और रखरखाव के लिए किया जाता है। अधिकांश 
व्यवसाय अब भुगतान के डिजिटल तरीके का उपयोग करते हैं। सभी रिकॉर्ड प्रबंधित करने के लिए 
कंपनियां कंप्यूटर पर निर्भर रहती हैं।

विज्ञान और इंजीनियरिंग में आई.टी.

जटिल वैज्ञानिक गणनाएँ करने के लिए, कंप्यूटर-एडेड डिज़ाइन (CAD) या कंप्यूटर-एडेड मैन्युफैक्चरिंग 
(CAM) वैज्ञानिक और इंजीनियर सॉफ़्टवेयर एप्लिकेशन का उपयोग करते हैं। इससे उनका काम आसान 
हो गया। रेखाचित्र बनाना और गणना करना बहुत आसान हो गया।

बैंक�िग में आई.टी.

कम्प्यूटर के बिना बैंक�िग की कल्पना नही ंकी जा सकती। लेन-देन से लेकर रिकॉर्ड बनाए रखने तक बहुत 
सारा काम कंप्यूटर में होता है। आवर्ती जमा (ई-आरडी), सावधि जमा (ई-एफडी), एक खाते से दूसरे खाते 
में धन हस्तांतरण (एनईएफटी, आरटीजीएस), ऑनलाइन लेनदेन इंटरनेट का उपयोग करके किया जाता 
है (चित्र 1.10)।
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चित्र 1.10 – बैंक�िग में आई.टी.

बीमा में आई.टी.

बीमा कंपनियां अपने ग्राहको ंका डेटा संग्रहीत करने के लिए कंप्यूटर का उपयोग करती हैं। यह उनके 
डेटा का प्रबंधन करता है और उन्हें उनके प्रीमियम के लिए समय पर सूचनाएं देता है। यह उपयोगकर्ता 
को अपनी बीमा पॉलिसी के बारे में ज़रूरी जानकारी प्राप्त करने में सहायता करता है।

मार्के ट�िग में आई.टी.

मार्के ट�िग में कंप्यूटर की बहुत आवश्यकता होती है। कंप्यूटर का उपयोग विज्ञापन बनाने के लिए किया 
जाता है। इसका उपयोग बाजार में उत्पाद के प्रदर्शन की निगरानी के लिए किया जाता है। इसकी मदद से 
उत्पाद को प्रभावी और सजावटी तरीके से प्रस्तुत करने के लिए विभिन्न चित्र बनाए जा सकते हैं।

स्वास्थ्य देखभाल में आई.टी.

हमारे अस्पताल अब कम्प्यूटरीकृत हो गए हैं और बहुत सी स्वास्थ्य देखभाल गतिविधियो ंकी निगरानी अब 
कंप्यूटर द्वारा की जाती है। कुछ उच्च-स्तरीय गैजेट अस्पतालो ंमें सेवा के लिए बनाए जाते हैं।

i.	 कम्प्यूटरीकृत समर्थ टोमोग्राफी - Computer Assisted Tomography (कैट-CAT) मशीन:

	 इस मशीन का उपयोग करके शरीर के विभिन्न हिस्सों की त्रि-आयामी (3डी) छवियां बनाई जा सकती 
हैं। ये चित्र रोगो ंके निदान में सहायक हैं।

ii.	 चंुबकीय अनुनाद इमेजिग - Magnetic Resonance Imaging (एम.आर.आई-MRI) मशीन:

	 एमआरआई मशीनो ंका उपयोग मजबूत चंुबकीय क्षेत्र और रेडियो तरंगो ंका उपयोग करके शरीर के 
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आंतरिक अंगो ंकी एक छवि प्रदान करने के लिए किया जाता है। डिजिटल छवियां बीमारी का पता 
लगाने में बहुत मददगार हैं (चित्र 1.11)।

चित्र 1.11 – एमआरआई मशीन एवं एमआरआई चित्र

iii.	 इलेक्ट् रोकार्डियोग्राम (ई.सी.जी) मशीन:

	 इस मशीन का उपयोग किसी व्यक्ति के दिल की धड़कन पर नज़र रखने के लिए किया जाता है। यह 
मशीन विद्यु त आवेग (इलेक्ट्रि क इम्पल्स) को रिकॉर्ड करती है (चित्र 1.12)।

चित्र 1.12 – ईसीजी मशीन

iv.	 कार्डियक स्क्रीनिग मशीन:

	 इस मशीन का उपयोग हृदय से जुड़ी समस्याओ ंका पता लगाने के लिए किया जाता है। यह हृदय 
की आंतरिक कार्यप्रणाली पर नज़र रखता है (चित्र 1.13)।
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चित्र 1.13 – कार्डियक स्क्रीनिग मशीन

v.	 ईईजी (इलेक्ट् रो-एन्सेफलोग्राफी) मशीन:

	 मस्तिष्क की गतिविधियो ंको रिकॉर्ड करने के लिए इलेक्ट्रो -एन्सेफलोग्राफी मशीन का उपयोग किया 
जाता है। यह मशीन मरीज के सोते या जागते दोनो ंसमय काम करती है।

vi.	 ब्लड शुगर (रक्त शर्क रा) परीक्षण मशीन:

	 इसका उपयोग ब्लड शुगर (रक्त में शर्क रा) के स्तर की जांच के लिए किया जाता है (चित्र 1.14)।

चित्र 1.14 – ब्लड शुगर परीक्षण मशीन
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vii.	 ब्लड प्रेशर (रक्तचाप) मापने की मशीन:

	 ब्लड प्रेशर मापने की मशीन से ब्लड प्रेशर को डिजिटल तरीके से जांचा जा सकता है (चित्र 1.15)।

चित्र 1.15 – ब्लड प्रेशर मापने की मशीन

सरकार और सार्वजनिक सेवा में आई.टी.

सरकार अपनी योजनाओ ं को बड़ी संख्या में लोगो ं तक पहुंचाने के लिए कई कंप्यूटर एप्लिकेशन का 
उपयोग करती है। सरकार का अपना वेब पोर्टल और एप्लिकेशन भी है जहां हम किसी भी नीति और 
योजना के बारे में जानकारी प्राप्त कर सकते हैं।

सूचना प्रौद्योगिकी (आई.टी.) के उपयोग के क्या लाभ हैं?

आई.टी. सेवाओ ंका उपयोग करने के सामान्य लाभ हैं:

1.	 इससे समय की बचत होती है,

2.	 इससे पैसे की बचत होती है,

3.	 इससे कार्यकुशलता में सुधार होता है,

4.	 इससे पारदर्शिता में सुधार होता है,

5.	 इससे उत्पादकता बढ़ती है,

6.	 यह संचार एवं सम्प्रेषण को बढ़ाता है,

7.	 यह निर्णय लेने में सहायता करता है,

8.	 यह सटीकता में सुधार करता है।
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व्यवसाय के लिए भी आई.टी. के कई लाभ हैं, जैसे:

1.	 अधिक संभावित ग्राहको ंतक पहुँचना,

2.	 संभावित ग्राहको ंके साथ व्यावसायिक संबंध विकसित करना,

3.	 संचालन को सुव्यवस्थित करना,

4.	 लागत कम करना,

5.	 दक्षता में सुधार,

6.	 अधिकतम लाभ,

7.	 अपव्यय को कम करना,

8.	ग्रा हको ंको बेहतर सेवा प्रदान करना,

9.	 प्रमुख साझेदारो ंके साथ बेहतर संबंधो ंका समर्थन करना।

शब्दावली

•	 आई.टी.: सूचना के निर्माण, भंडारण और आदान-प्रदान के लिए आवश्यक तकनीक को सूचना 
प्रौद्योगिकी या आई.टी. कहा जाता है।

•	 आई.टी.ई.एस.: सूचना प्रौद्योगिकी (आई.टी.) व्यवसायो ंऔर संगठनो ंको कई प्रकार की सेवाएँ प्रदान 
करने में मदद करती है जिन्हें आई.टी.ई.एस. (आई.टी. सक्षम सेवाएँ) कहा जाता है। इनमें डेटा 
प्रोसेसिग, ग्राहक सहायता, तकनीकी सहायता और परामर्श जैसी गतिविधियो ंकी एक विस्तृत श्रृंखला 
शामिल है।

•	 डेटा: डेटा उन तथ्यों को कहा जाता है जिन्हें जानकारी प्राप्त करने के लिए संसाधित किया जाता है।

•	 सूचना: जब डेटा को उपयोगी या समझने योग्य बनाने के लिए संसाधित किया जाता है, तब वह 
संसाधित डेटा सूचना कहलाता है।

•	 इनपुट: प्रोसेसिग के लिए कंप्यूटर को भेजा गया कोई भी सिग्नल या डेटा इनपुट माना जाता है।

•	 आउटपुट: कंप्यूटर या इलेक्ट् रॉनिक डिवाइस द्वारा संसाधित की गई और भेजी गई कोई भी जानकारी 
आउटपुट मानी जाती है।
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 महत्वपूर्ण iz'u 

1.	 रिक्त स्थान भरें :

	 i.	 आई.सी.टी.: सूचना और _________ प्रौद्योगिकी। 					  

2.	 इनकी परिभाषाएँ लिखें:

	 i.	 आई.टी. 										        

	 ii.	 आई.टी.ई.एस. 									       

	 iii.	 सूचना 											         

	 iv.	 डेटा 											         

3.	नि म्नलिखित में से कौन सा आई.टी. का लाभ नही ंहै? 					   

	 a.	 काम तेजी से हो जाता है

	 b.	 कार्य पेचीदा हो जाता है

	 c.	 काम में कम पैसे लगते हैं

	 d.	 कार्य अधिक कुशल हो जाता है

4.	 आई.टी. सक्षम सेवाएं किस क्षेत्र में सहायक हैं? 						    

	 a.	स्वा स्थ्य सेवा और शिक्षा

	 b.	 घर और कार्यस्थल

	 c.	 व्यापार और सरकार

	 d.	 ऊपर के सभी

लघु उत्तरीय iz'u (2 अंक)

1.	 डेटा और सूचना के बीच निम्नलिखित को वर्गीकृत करें : 					�      (2)

a.	नीन ा के पास 3 किताबें हैं।

b.	 फातिमा के पास नीना से अधिक किताबें हैं।
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c.	 राम का वजन 45 किलोग्राम है।

d.	वि द्यार थ्ियो ंका औसत वजन 40 किलोग्राम है।

2.	व्य वसाय में आई.टी. का उपयोग करने के 4 लाभ सूचीबद्ध करें । 				�     (2)

3.	 रिक्त स्थान भरें :

	 कंप्यूटर डेटा को ________ के रूप में लेता है, इसे संसाधित करता है और परिणाम (सूचना) को 
_________ के रूप में उत्पन्न करता है। 					�      (2)

4.	 बी.पी.ओ. और बी.पी.एम. में क्या अंतर है? 						�       (2)

5.	 आई.टी. का उपयोग करने के प्रमुख लाभ चिन्हित करें । 				�     (2)

दीर्घ उत्तरीय iz'u (4 अंक)

1.	किन्हीं   चार विभिन्न क्षेत्रों में आई.टी./आई.टी.ई.एस. के अनुप्रयोगो ंका वर्णन करें । � (4)

2.	किन्हीं   चार बी.पी.ओ., बी.पी.एम., या आई.टी.ई.एस. सेवाओ ंकी सूची बनाएं। 	�  (4)

3.	 तालिका पूरा करें : � (4)

(A) (B) (C)

आटा प्रोसेस रोटी

ए)________ प्रोसेस दीवार

इनपुट प्रोसेस बी)________

डेटा सी)________ डी)________

4.	 भारत सरकार की किन्हीं  चार वेबसाइटो ंकी सूची बनाएं जो लोगो ंको आई.टी. सक्षम सेवाएं प्रदान 
करती हैं। � (4)

उत्तर/संकेत:

वस्तुनिष्ठ प्रकार:

1.	 पूर्ण रूप:

	 i.	 आई.सी.टी.: सूचना और संचार प्रौद्योगिकी
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	 ii.	 आई.टी.: सूचना प्रौद्योगिकी

	 iii.	 आई.टी.ई.एस.: सूचना प्रौद्योगिकी सक्षम सेवाएं

	 iv.	 बी.पी.ओ.: बिजनेस प्रोसेस आउटसोर्सिंग

	 v.	 बी.पी.एम.: बिजनेस प्रोसेस मैनेजमेंट

	 vi.	 एलएमएस: लर्निंग मैनेजमेंट सिस्टम

	 vii.	 जीआईसी: ग्लोबल इन-हाउस सेंटर

	 viii.	 आई.एस.पी: भारतीय सेवा प्रदाता

	 ix.	 एमएनसी: बहुराष्ट्री य कंपनियां

	 x.	 जीडीपी: सकल घरेलू उत्पाद

2.	 क) संचार.

3.	 शब्दावली का संदर्भ लें.

4.	 बी।

5.	 डी।

संक्षिप्त उत्तर प्रकार:

1.	 डेटा हैं- ए और सी,

	 सूचना हैं- बी एवं डी।

2.	 अध्याय का संदर्भ लें।

3.	 इनपुट, आउटपुट।

4.	 अध्याय का संदर्भ लें।

5.	 अध्याय का संदर्भ लें।

vvv



20

lwpuk izkS|ksfxdh (Information Technology)

SC
ER

T D
EL

HIसीखने के प्रतिफल

विद्यार्थी-

•	 कंुजियो ं(Keys) को पहचानेंगे और कंुजीपटल (Keyboard) का प्रभावी ढंग से उपयोग करते हैं। 

•	 पाठ टाइप करने के लिए उपयुक्त कंुजियो ंका उपयोग करते हैं।   

•	 सही टाइपिग एर्गोनॉमिक्स का अभ्यास करने में सक्षम होते हैं।

•	 टाइपिग सॉफ्टवेयर का उपयोग करके - आप टाइपिग सॉफ्टवेयर में टेक्स्ट टाइप करने का अभ्यास 
कर सकते हैं, अपने परिणाम, और टाइपिग गति की गणना कर सकते हैं।  

2.1	 परिचय (Introduction)

नमस्कार विद्यार थ्ियो!ं क्या आपने रेलवे रिजर्वेशन काउंटर का दौरा किया है? आप टिकट बुकिग क्लर्कों 
को देखकर चकित होगें जो कंप्यूटर पर बहुत तेजी से टिकट आरक्षित करते हैं; जहां उनके हाथ यात्रियो ं
की डिटेल टाइप करने में व्यस्त रहते हैं, वही ंउनकी नजर रिजर्वेशन फॉर्म या स्क्रीन पर टिकी होती है! 
वे टाइपिग में अपने कौशल के कारण आंखो ंऔर हाथो ंका मिलान करने में सक्षम हैं और इस तरह से 
काम करते हैं। गुड टाइपिग एक ऐसा कौशल है जो कंप्यूटर में टेक्स्ट टाइप करने या डेटा को 'जल्दी और 
सटीक' दर्ज करने में मदद करता है।

आज के समय में हर कोई मोबाइल फोन, लैपटॉप चलाता है। दरअसल, आजकल कंप्यूटर या मोबाइल 
फोन पर काम करना एक जरूरत बन गया है। हमें या तो संदेश टाइप करना है या भेजना है, इसलिए 
हमारे लिए यह जानना महत्वपूर्ण है कि टेक्स्ट कैसे टाइप किया जाए।

कीबोर्ड टेक्स्ट-आधारित इनपुट डिवाइस है। keyboarding skills  का अर्थ कंप्यूटर में कीबोर्ड के माध्यम 
से जानकारी इनपुट करना है। कीबोर्ड एक टेक्स्ट-आधारित इनपुट डिवाइस है। एक कीबोर्ड में 100 से 
अधिक कंुजियाँ होती है। यह कंुजियाँ कंप्यूटर में अल्फाबेट्स, अंको,ं और सिम्बल को एंटर करने की मदद 
करता है। लगातार प्रयासो ंके साथ, हम कीबोर्डिंग कौशल में महारत हासिल कर सकते हैं कम समय में 
अधिक परिणाम प्राप्त कर सकते हैं।

इकाई-2   
डेटा प्रविष्टि और कीबोर्डिंग कौशल



Class IX : 2024-25

21

SC
ER

T D
EL

HI
2.2	 कीबोर्डिंग कौशल (Keyboarding Skills)

कीबोर्डिंग कौशल टाइप करते समय कीबोर्ड को सुचारू रूप से संचालित करने के लिए आवश्यक कौशल 
का एक प्रकार है। एक कीबोर्ड में आमतौर पर 104 से 108 कंुजियाँ (keys) होती हैं। कंुजियो ंका उपयोग 
मुख्य रूप से पाठ टाइप करने और निर्देश भेजने के लिए किया जाता है। कीबोर्ड कंुजियाँ वे बटन हैं 
जो अक्षर (Alphabets), संख्यात्मक (numeric), अल्फ़ान्यूमेरिक (Alphanumeric) और विशेष कंुजियो ं
(Special Characters) का प्रतिनिधित्व करती हैं। जब एक कंुजी को दबाया जाता है, तो एक विद्यु त संकेत 
उत्पन्न होता है। इन विद्यु त संकेतो ंको एक कोडित रूप (ASCII फॉर्म) में कंप्यूटर पर प्रेषित किया जाता है 
जो उस-उस कंुजी से संबंधित वर्ण (character) का वर्णन करते हुए कंप्यूटर में प्रेषित होते हैं। 

चित्र: कंप्यूटर कीबोर्ड

कीबोर्ड के इस लेआउट को QWERTY कीबोर्ड के नाम से जाना जाता है। न्यूमेरिक कीपैड (Numeric 
keypad) कंप्यूटर कीबोर्ड में हाल ही में जोड़ा गया है। जैसे-जैसे व्यावसायिक वातावरण में कंप्यूटर का 
उपयोग बढ़ा, वैसे-वैसे त्वरित डेटा प्रविष्टि की आवश्यकता भी बढ़ी। चंूकि डेटा का एक बड़ा हिस्सा संख्याएं 
थी,ं इसलिए कीबोर्ड में 17 कंुजियो ंका एक सेट जोड़ा गया। कीबोर्ड की प्रत्येक कंुजी को एक एकल प्रतीक 
(Single symbol) द्वारा दर्शाया जाता है।

2.3	 कीबोर्ड कंुजियो ंका प्रकार (Type of keys)

माउस, टच स्क्रीन आदि जैसे कई इनपुट डिवाइस हैं लेकिन उपयोग किए जाने वाले सबसे आम कीबोर्ड 
को QWERTY कहा जाता है जिसका नाम ऊपर बाईं ओर से पहले छह अक्षरो ंके अनुक्रम के आधार पर 
रखा गया है। कंुजियो ं(Keys) के प्रकार नीचे दिए गए हैं –
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1.	वर्ण माला कंुजियाँ (Alphabet Keys) : कीबोर्ड पर 26 वर्णमाला कंुजियाँ (A-Z) होती हैं जो अक्षरो ं

को टाइप करने में मदद करती हैं।

2.	 संख्या कंुजियाँ (Number Keys): एक कीबोर्ड पर दस (10) संख्यात्मक कंुजियाँ (0-9) होती हैं। ये 
संख्याएँ टाइप करने में सहायक होती हैं। ये एक कीबोर्ड पर दो अलग-अलग स्थानो ंपर स्थित होते 
हैं, अर्थात् वर्णमाला कंुजियो ं(Alphabet keys) के ऊपर और कीबोर्ड के दाईं ओर। कीबोर्ड के दाईं 
ओर स्थित संख्यात्मक कंुजियो ं(Numeric Keys) को संख्यात्मक कीपैड (Numeric Keypad) कहा 
जाता है।

3.	फ़ं  क्शन कंुजियाँ (Function Keys): ये कंुजियाँ कीबोर्ड के ऊपरी तरफ (नंबर कंुजियो ंके ऊपर) 
होती हैं। इन्हे F1, F2, .......... F12 के रूप में लेबल किया गया है, जहां 'F' का अर्थ फ़ं क्शन है। इनमें 
से प्रत्येक कंुजी का उपयोग किसी विशेष कार्य के लिए किया जाता है।

 

			फ़ं    क्शन कंुजियाँ (Function Keys)		  एरो / तीर कंुजियाँ  Arrow Keys
चित्र: एक मानक कंप्यूटर कीबोर्ड

4.	 एरो/तीर कंुजियाँ (Arrow Keys): तीर कंुजियाँ दिशा कंुजियाँ हैं जो तीरो ंको अलग-अलग दिशाओ ं
में ले जाती हैं, यानी, ऊपर, नीचे, बाएँ और दाएँ। ये कंुजियाँ तब उपयोगी होती हैं जब किसी को स्क्रीन 
पर कर्सर ले जाना होता है। एरो कंुजियो ंको 'कर्सर नियंत्रण कंुजी' या 'नेविगेशन कंुजी' भी कहा जाता 
है।
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5.	 एंटर कंुजी (Enter Key): इसे ‘ENTER’ लेबल किया गया है। यह कीबोर्ड पर सबसे अधिक उपयोग 

की जाने वाली कंुजियो ंमें से एक है। कीबोर्ड पर, यह कंुजी कीबोर्ड के बीच में और निचले दाएं कोने 
में रखी जाती है। यह कर्सर को अगली पंक्ति में ले जाने और टाइप करने के बाद किसी भी निर्देश 
को निष्पादित करने में मदद करता है। इसे 'रिटर्न' कंुजी के रूप में भी जाना जाता है।

6.	 एस्के प (Esc) कंुजी: इसे कीबोर्ड के बायें कोने पर ऊपर की ओर रखा गया है। इसका उपयोग 
पिछले कार्य को रद्द करने या खुले हुए एप्लिकेशन से बाहर आने के लिए किया जाता है।

7.	 विंडो कंुजी (Window Key): यह एक चार फलक वाली कंुजी है जो आपको किसी भी प्रोग्राम और 
एप्लिकेशन को खोलने में मदद करती है।

8.	 स्पेसबार कंुजी (Spacebar Key): यह कीबोर्ड के नीचे स्थित होती है। यह दो अक्षरो ंया शब्दों के 
बीच जगह (अंतर) देने में मदद करता है। स्पेसबार कीबोर्ड की सबसे लंबी कंुजी होती है।

9.	 शिफ्ट कंुजी (Shift Key): इस कंुजी को 'शिफ्ट' और ऊपर की दिशा की ओर इशारा करते हुए 
एक तीर के साथ लेबल किया गया है। इसका उपयोग बड़े अक्षरो ं में टाइप करने या विशेष वर्ण 
(character) टाइप करने के लिए किया जाता है [@(एट द रेट), # (हैश), $ (डॉलर), % (प्रतिशत), 
^ (एक्सपोनेंट), *(एस्टरिस्क), और & (एम्परसेंड) , आदि] जब संबंधित कंुजियो ंके साथ संयोजन में 
उपयोग किया जाता है।

10.	 नियंत्रण कंुजी (Ctrl Key): नियंत्रण या निर्देश उत्पन्न करने के लिए इस कंुजी का उपयोग कीबोर्ड 
की अन्य कंुजियो ंके साथ संयोजन में किया जाता है। Alt कंुजी दूसरी नियंत्रण कंुजी की तरह है।

11.	 कैप्स लॉक कंुजी (Caps Lock Key): यह वर्णमाला को 'चालू' होने पर बड़े अक्षर में और 'बंद' होने 
पर छोटे अक्षर में टाइप करने में मदद करता है।

12.	 बैकस्पेस कंुजी (Backspace Key): इस कंुजी को 'बैकस्पेस' या बाएं तीर के साथ लेबल किया गया 
है। दबाए जाने पर, यह कर्सर के बाईं ओर मौजूद अक्षर (character) को मिटा देता है।

13.	 डिलीट कंुजी (Delete Key): इस कंुजी का प्रयोग अक्षरो ंको मिटाने के लिए किया जाता है। दबाने 
पर यह कर्सर के दाईं ओर मौजूद अक्षर को मिटा देता है।
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14.	 PrtSc कंुजी आपके मॉनिटर पर स्क्रीनशॉट लेने में आपकी मदद करती है।

15.	 पेज अप कंुजी (Page up Key) वर्तमान में देखे जा रहे एक पेज को ऊपर ले जाने में मदद करती है।

16.	 पेज डाउन कंुजी (Page down Key) आपको वर्तमान में देखे गए पेज को नीचे ले जाने में मदद करती 
है।

17.	 End कंुजी कर्सर को पंक्ति, दस्तावेज़ या स्क्रीन के अंत में ले जाती है।

18.	 होम कंुजी (Home Key) कर्सर को पंक्ति, दस्तावेज़, पृष्ठ या स्क्रीन की शुरुआत में वापस ले आती है।

19.	 गाइड कंुजी (Guide Key): 'एफ (F)' और 'जे (J)' कंुजी को गाइड कंुजी कहा जाता है। उनमें 
टाइपिस्ट को होम कंुजी पर अपनी अंगुलियो ंको सही ढंग से रखने में मदद करने के लिए एक छोटा 
सा उभरा हुआ (-) निशान होता है। अक्षर ASDF बाएं हाथ के लिए होम कंुजी है, ; (अर्धविराम) और 
LKJ दाहिन हाथ के लिए होम कंुजी है।

20.	 संख्यात्मक कीपैड (Numeric Keypad): संख्यात्मक कीपैड का उपयोग तब किया जाता है जब 
विशाल संख्यात्मक डेटा दर्ज करना होता है। इसे कीबोर्ड के दाईं ओर रखा गया है। इसमें 0 से 9 
तक संख्याएँ, जोड़ (+), घटा (-), गुणा (*) और भाग (/) चिह्न, एक दशमलव बिदु (.), नम लॉक और 
एंटर कंुजी शामिल हैं।

2.4	 टेक्स्ट टाइप करना और हटाना

	कि सी दस्तावज़ में टेक्स्ट टाइप करने के लिए आपको यह करना चाहिए - 

1.	 कीबोर्ड पर अक्षरो ंको दबाकर टाइप करें ।
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2.	कि सी दस्तावेज़ में टेक्स्ट हटाने के लिए, बैकस्पेस कंुजी या डिलीट कंुजी का उपयोग करें । बैकस्पेस 

कंुजी पीछे से टेक्स्ट को हटा देगी।

3.	कि सी दस्तावेज़ में संख्याएँ टाइप करने के लिए  संख्यात्मक कीपैड (Numric Keypad) या उस पर 
मौजूद नंबरो ंका उपयोग करें ।

बड़े अक्षरो ंमें टाइप करना (Typing Capital Letters)  

बड़े अक्षर टाइप करने के लिए कैप्स लॉक को ऑन करें ; टाइप करने से पहले कैप्स लॉक कंुजी दबाएँ। 
कीबोर्ड के ऊपरी दाहिन कोने पर एक रोशनी चमकेगी। इसे बंद करने के लिए दोबारा कैप्स लॉक कंुजी 
पर टैप करें ।

टाइपिग सिबल (प्रतीक/चिह्न) (Typing Symbols)

Shift  कंुजी को दबाकर रखें और फिर आवश्यक कंुजी को दबाएं। कंप्यूटर कीबोर्ड पर दो Shift कंुजी हैं।

वाक्य टाइप करना (Typing Sentences)

टाइप किए गए शब्दों के बीच जगह देने के लिए स्पेस बार दबाएँ एक बार और फिर अगला शब्द टाइप 
करें ।

अनुच्छे दो ं के बीच नई पंक्तियाँ और रिक्त स्थान बनाना (Creating New Lines and Spaces 
between Paragraphs)

एंटर या रिटर्न कंुजी का उपयोग नई लाइनें बनाने के लिए किया जाता है। स्पेसबार कंुजी (Spacebar Key) 
दो अक्षरो ंया शब्दों के बीच जगह (अंतर) देने में मदद करता है। स्पेसबार कीबोर्ड की सबसे लंबी कंुजी 
होती है।

टाइपिग के लिए गाइड (Guide for Typing)

कर्सर, टाइपिग के लिए एक मार्गदर्शक के रूप में काम करती हैं। कर्सर वह छोटी डैश लाइन है, जो टाइप 
करते समय वाक्य में टिमटिमाती है।

2.5	 पॉइंटिग डिवाइस (Pointing Devices)

पॉइंटिग डिवाइस का उपयोग मेनू से विकल्प का चयन करने के लिए किया जाता है या किसी आइकन का 
चयन करने के लिए किया जाता है। जैसे एक माउस (Mouse)। माउस (Mouse) एक मानक हैंड-हेल्ड 
पॉइंटिग डिवाइस (hand-held pointing device) है जो कंप्यूटर स्क्रीन के किसी भी ऑब्जेक्ट को चुनन 
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में मदद करता है। पॉइंटिग और ड्रॉ डिवाइस के अन्य उदाहरण जॉयस्टिक, लाइट पेन, टच पैड, ट्रैकबॉल 
और टच स्क्रीन हैं।

2.5.1 माउस (Mouse)

चित्र: कंप्यूटर माउस

माउस एक हैंड-हेल्ड पॉइंटिग डिवाइस है जो स्क्रीन पर किसी भी ऑब्जेक्ट का चयन करने में मदद करता 
है। इसका उपयोग स्क्रीन पर वस्तुओ,ं चित्रों आदि को खीचंने, स्थानांतरित करने और आकार बदलने के 
लिए भी किया जाता है। एक माउस में मुख्य रूप से तीन भाग होते हैं: बटन, हैंडलिग क्षेत्र और रोलिग 
ऑब्जेक्ट। डिफ़ॉल्ट रूप से, माउस को दाहिन हाथ के लिए काम करने के लिए कॉन्फ़िगर किया गया है। 
बाएं हाथ के लोग अपनी आवश्यकता के अनुसार सेटिग्स बदल सकते हैं। सामान्यतः  स्क्रीन पर सामान्य 
कार्य करने के लिए बाएँ माउस बटन का उपयोग किया जाता है लेकिन कुछ मामलो ंमें दाएँ माउस बटन 
का भी उपयोग किया जाता है।

दाहिना हाथ माउस पर रखिये, बाएँ बटन पर तर्जनी उंगली और दायां बटन पर मध्यमा उंगली रखिये। 
माउस को अंगूठा और अनामिका ऊँगली से पकड़े।  क्लिक करने के लिए हल्के  से माउस बटन दबाएँ 
और इसे तुरंत छोड़ दें।
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2.5.1.1  माउस परिचालन (Mouse Operations)

माउस पॉइंटिग (Mouse Pointing) - 'पॉइंटिग' का अर्थ है माउस पॉइंटर को कंप्यूटर स्क्रीन पर 
आवश्यक स्थान पर ले जाना। जैसे ही आप इसे घुमाएंगे, स्क्रीन के चारो ंओर माउस पॉइंटर दिखाई देगा - 

वेब ब्राउज़र पर काम करते समय, पॉइंटर फिगर सिबल वाले प्रतीक में बदल जाता है । यह एक हाइपरलिक 
की पहचान करता है।  हाइपरलिक को क्लिक करने के लिए माउस की बाईं बटन पर क्लिक करे।  

क्लिक (Click) - 'क्लिक' का अर्थ है माउस के बाएँ बटन को एक बार दबाकर छोड़ना। यह किसी 
ऑब्जेक्ट जैसे आइकन, विकल्प, टूल बटन आदि का चयन करने में मदद करता है।

डबल क्लिक (Double Click) - इसका मतलब है बाईं माउस बटन को लगातार दो बार क्रमशः  दबाना 
और छोड़ना। इसका उपयोग किसी प्रोग्राम को शुरू करने या फ़ाइल खोलने के लिए किया जाता है।

राइट क्लिक (Right Click) - इसका मतलब है माउस का दायां बटन दबाकर छोड़ना। यह शॉर्टकट 
या संदर्भ/कॉन्टेक्स्ट (Context) मेनू खोलने में मदद करता है। दायाँ माउस बटन दबाने के लिए मध्यमा 
अंगुली का प्रयोग करें ।

ड्रैग  एंड ड्रा प (Drag and Drop) - यह आइटम को एक स्थान से दूसरे स्थान पर चुनन और ले जाने की 
अनुमति देता है। ड्रैग और ड्रॉप का उपयोग करने के लिए, जिस आइटम को आप खीचंना चाहते हैं उस 
पर माउस लें जाएँ और माउस के बाईं ओर दबाकर रखें और ऑब्जेक्ट को खीचंें।

स्क्रॉल (Scroll) - यदि पेज की लंबाई मॉनिटर/स्क्रीन की लंबाई से अधिक है तो कई एप्लिकेशन स्क्रीन के 
दाईं ओर स्क्रॉल बार प्रदान करते हैं। पेज डाउन कंुजी का उपयोग करने के बजाय, ऊपर या नीचे स्क्रॉल 
करने के लिए माउस की स्क्रॉल कंुजी का उपयोग किया जा सकता है। स्क्रीन पर पृष्ठ को ऊपर या नीचे 
ले जाने के लिए माउस पर स्क्रॉल व्हील का उपयोग करें ।
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2.6	 टाइपिग एर्गोनॉमिक्स (Typing Ergonomics)

टाइपिग एर्गोनॉमिक्स कीबोर्ड उपयोगकर्ता को प्राकृतिक हाथ की मुद्रा बनाए रखने और हाथ और बांह में 
दर्द , सुन्नता और झुनझुनी, कमर दर्द  आदि जैसी चोटो ंको रोकने में मदद करता है। टाइपिग एर्गोनॉमिक्स 
कुशल और प्रभावी टाइपराइटिग के लिए सहायता प्रदान करता है।

चित्र - बैठने की सही मुद्रा

बैठने की मुद्रा (Sitting Posture)

कंप्यूटर कीबोर्ड चलाते समय सीधे बैठें  और अपनी गर्दन को थोड़ा आगे की ओर झुकाएं और अपनी पीठ 
के निचले हिस्से को कुर्सी के पिछले हिस्से के निचले हिस्से से स्पर्श करें । दोनो ंपैरो ंको फर्श से छुएं।

हाथ की स्थिति (Position of hand)

अपनी भुजाओ ं(forearm) को कीबोर्ड और माउस के बराबर रखें। अपनी कलाई सीधी रखें।

मॉनिटर प्लेसमेंट (Monitor placement)

अपनी गर्दन सीधी रखें। स्क्रीन की ऊपरी सीमा को आँख के स्तर पर रखें। लगभग 60 से 65 सेमी की 
अनुमानित दूरी रखें।
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माउस और कीबोर्ड प्लेसमेंट (Mouse and Keyboard Placement )

कीबोर्ड और माउस को लगभग 20-25 सेमी की दूरी पर एक साथ रखें।

कुर्सी और मेज का स्थान / प्लेसमेंट (Chair and Table Placement)

कम्प्यूटर उपयोगकर्ता की कुर्सी सहायक होनी चाहिए। कुर्सी और मेज की ऊंचाई आदर्श होनी चाहिए। 
कम्प्यूटर टेबल में भी पर्याप्त जगह होनी चाहिए। 

चित्र - कीबोर्ड की प्रत्येक पंक्ति पर उंगलियो ंका उपयोग करना

उंगलियो ंको कंुजियो ंका आवंटन (Allocation of keys to fingers)

दूसरी पंक्ति (होम पंक्ति) से टाइप करने की प्रक्रिया शुरू होती है, इसके बाद तीसरी पंक्ति (ऊपरी पंक्ति), 
पहली पंक्ति (निचली पंक्ति) और चौथी पंक्ति (संख्या पंक्ति) होती है। दोनो ंहाथो ंकी उंगलियां  प्रत्येक पंक्ति 
पर आवंटित कंुजी को संचालित करने के लिए उपयोग करें ।
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2.7	 संख्यात्मक कीपैड का उपयोग करना (Using Numeric Keypad)

चित्र - न्यूमेरिक कीपैड

टाइप करते समय संख्यात्मक डेटा प्रविष्टि भी उतनी ही महत्वपूर्ण है। संख्यात्मक कीपैड में चार स्तंभ 
(Four Columns) और पाँच पंक्तियाँ (Five Rows) हैं। जिस पंक्ति में 4, 5, 6 और + होते हैं उसे होम 
पंक्ति कहते हैं। यहां पर संख्या 5 मार्गदर्शक कंुजी है। इसमें एक छोटी सी उभरी हुई रेखा है जो टच 
टाइपिस्ट के लिए अन्य कंुजियो ंपर उंगलियो ंके स्थान के लिए एक मार्गदर्शक के रूप में कार्य करती है। 
'0' को दाहिन हाथ के अंगूठ से दबाना चाहिए।

2.8	 टच टाइपिग तकनीक (Touch Typing Technique)

टच टाइपिग से टाइपिग की गति और सटीकता में सुधार होता है। एक टच टाइपिस्ट कभी भी कीबोर्ड को 
नही ंदेखता हैं। टाइपिस्ट का ध्यान पूरी तरह से शब्दों और वाक्यांशो ंको पढ़न पर होता है क्योंक�ि उंगलियां 
पाठ को रिफ्लेक्सिव तरीके से टाइप करती हैं। सीखने के चरण इस प्रकार हैं –

चरण I 

इस चरण में, शिक्षार्थी कीबोर्ड की केवल होम पंक्ति (कैप्स लॉक कंुजी से शुरू होने वाली पंक्ति) का 
उपयोग करके टाइप करना शुरू करता है। इसके बाद निचली और ऊपरी पंक्तियो,ं संख्या पंक्ति, बड़े 
अक्षरो ंऔर विशेष प्रतीको ंपर कंुजियो ंका उपयोग करके टाइप करना सीखा जाता है। टाइप करते समय 
कीबोर्ड की ओर देखने से बचना चाहिए। 
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चरण II

इस चरण में, शिक्षार्थी अक्सर उपयोग किए जाने वाले अक्षरो ंको याद करता है और इन अक्षरो ंवाले शब्दों 
को टाइप करता है। 

चरण III 

शिक्षार्थी पूरे कीबोर्ड की कंुजियो ंका उपयोग करके टेक्स्ट टाइप करता है।

2.8.1 टच टाइपिग के नियम (Touch Typing Rules)

हमें टच टाइपिग के नियम पता होने चाहिए। आइये अब इन नियमो ंके बारे में जानते हैं- 

1.	 एफ, डी, एस, ए,  (FDSA) और जे, के, एल, ;  (JKL ; ) कंुजियाँ (QWERTY कीबोर्ड पर) आधार स्थिति 
का प्रतिनिधित्व करती हैं। कीबोर्ड में आमतौर पर F और J कंुजी पर एक छोटा सा उभार होता है। ये 
उभार उंगलियो ंको कीबोर्ड को देखे बिना आधार स्थिति का पता लगाने में मदद करते हैं।

2.	 संख्यात्मक कीपैड के लिए, संख्यात्मक पैड पर आधार कंुजी संख्या 5 कंुजी है, संख्या 4 कंुजी तर्जनी 
के लिए है, और संख्या 6 कंुजी अनामिका के लिए है। संख्यात्मक पैड संख्यात्मक डेटा इनपुट को 
सरल और तेज़ बनाता है।

3.	 संख्या पंक्ति (Number Row) में कंुजियो ंपर दिखाई देने वाले प्रतीक/ सिबल एक हाथ से टाइप किए 
जाते हैं; जबकि दूसरे हाथ की छोटी उंगली 'Shift' कंुजी दबाती है।

4.	 टाइप करते समय कीबोर्ड की ओर नही ंदेखना चाहिए । अपनी उंगलियो ंसे आवश्यक कंुजियाँ ढंूढने 
का प्रयास करें ।

5.	 सीखने के शुरुआती चरण में तेजी से टाइप न करें । गलतियो ं से बचने के लिए सीखने के चरण में 
अपना समय लें। जैसे-जैसे आप आगे बढ़ें गे आपकी गति स्वतः  ही बढ़ जाएगी।

6.	 अपने हाथो ंऔर उंगलियो ंको मूल स्थिति के करीब रखें। इससे टाइपिग स्पीड बेहतर होती है और 
हाथो ंपर तनाव कम होता है।

7.	 कीबोर्ड की कंुजियो ंपर यथासंभव कम दबाव डालने का प्रयास करें । 

8.	 अपर/लोअर केस के बीच स्विच करने के लिए हमेशा दूसरे हाथ का उपयोग करें ।
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2.9	 टाइपिग का अभ्यास (Practice and Learn Typing)

टच टाइपिग सीखने के लिए हमें एक सॉफ्टवेयर की आवश्यकता होती है। सॉफ्टवेयर के माध्यम से टाइपिग 
का अभ्यास करने और सीखने के लिए हमें निम्नलिखित कार्य करने होते हैं – रैपिडटाइपिग सॉफ्टवेयर 
(RapidTyping Software) एक सुविधाजनक और उपयोग में आसान कीबोर्ड ट्रेनर है जो आपकी टाइपिग 
गति को बेहतर बनाने और टाइपिग एरर (Typing Error) को कम करने में मदद करता है।

चित्र – रैपिडटाइपिग ट्यूटर सॉफ्टवेयर
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रैपिड टाइपिग ट्यूटर सॉफ्टवेयर डाउनलोड करने के लिए कृपया निम्नलिखित लिक का अनुसरण करें  -  
https://rapidtyping.com/downloads.html

वर्चुअल कीबोर्ड: यह एक प्रकार का ऑन-स्क्रीन कीपैड है जो सभी दस उंगलियो ं से टाइपिग सीखने में 
मदद करता है।

चित्र – रैपिडटाइपिग ट्यूटर सॉफ्टवेयर और वर्चुअल कीबोर्ड

2.9.1	 रैपिडटाइपिग ट्यूटर का प्रयोग - BEGIN LESSONS

1.	 कौशल के आधार पर वांछित पाठ्यक्रम का चयन करें  - 
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2.	 अपनी उंगली को कीबोर्ड की आधार स्थिति पर सेट करें  और पाठ शुरू करने के लिए कोई भी कंुजी 

दबाएं।

3.	 अपनी उंगली को कीबोर्ड की आधार स्थिति पर सेट करें  और पाठ शुरू करने के लिए कोई भी कंुजी 
दबाएं।

4.	कि सी पाठ को रोकना – ‘Pause the lesson' बटन पर क्लिक करें  या 'F5' कंुजी दबाएँ।

5.	 पाठ पुनः  आरंभ करने के लिए; टूलबार पर ‘Restart the lesson’ बटन पर क्लिक करें  या 'F8' कंुजी 
दबाएँ।

2.9.2	 परिणामो ंकी व्याख्या

हर बार जब आप कोई पाठ पूरा करते हैं, तो परिणाम संवाद विडो इस पाठ में आपकी उपलब्धियो ंको 
प्रदर्शित करती है।  परिणाम संवाद विडो में रेटिग और त्रुटियाँ नामक दो टैब होते हैं।  आप अपने मेट्रि क्स 
की समीक्षा कर सकते हैं: 

रंग संकेत इस प्रकार है:

•	  हरे अक्षर सही इनपुट दर्शाते हैं।

•	  पीले अक्षर स्वीकार्य समय सीमा से बहार के सही इनपुट के लिए हैं।

•	  लाल अक्षर स्वीकार्य समय सीमा के भीतर गलत इनपुट दर्शाते हैं।

•	  नारंगी अक्षर गलत इनपुट दर्शाते हैं जो स्वीकार्य समय सीमा से भी अधिक है (यह सबसे खराब 
परिणाम है)।

2.9.3	 टाइपिग स्पीड की गणना

टाइपिग गति को विभिन्न सटीकता के साथ निम्नलिखित तरीके से मापा जा सकता है जैसे कि – 

•	 एक निश्चित समयावधि (सबसे कम सटीक) के लिए कितने शब्द टाइप किए जाते हैं?

•	 एक निश्चित समयावधि के लिए कितने अक्षर टाइप किए जाते हैं?

•	 एक निश्चित समयावधि (सबसे सटीक) के लिए कितने कंुजी स्ट्रो क बनाए जाते हैं? यह गति पर निर्भर 
करता है जैसे:

•	 सरल गति (सकल गति)
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•	 शुद्ध गति (सकल गति शून्य त्रुटियाँ)

निम्न तालिका टाइपिग गति के प्रकारो ंका विस्तृत विवरण दिखाती है।

प्रकार (Types) विवरण (Description) Formulas

WPM एक मिनट की समयावधि में टाइप किए 
गए शब्दों की संsख्या

WPM = (त्रुटि रहित शब्द + त्रुटि युक्त 
शब्द)/मिनटो ंमें बिताया गया समय

नेट WPM  
(Net WPM)

त्रुटियो ंवाले शब्दों के बिना एक मिनट की 
समयावधि में टाइप किए गए शब्दों की 
संख्या

नेट WPM = WPM- (त्रुटियो ंवाले शब्द/
मिनटो ंमें बिताया गया समय)

CPM एक मिनट की समयावधि में टाइप किये 
गये अक्षरो ंकी संख्या

सीपीएम = (त्रुटि रहित वर्ण + त्रुटि युक्त 
वर्ण)/मिनटो ंमें बिताया गया समय

Net CPM त्रुटियो ंवाले वर्ण रहित CPM नेट सीपीएम = सीपीएम- (त्रुटियो ं वाले 
अक्षर / बिताया गया समय मिनटो ंमें)

KPM एक मिनट की समयावधि में की-स्ट्रो क्स 
की संख्या

केपीएम = (त्रुटियो ं के बिना की-स्ट्रो क्स 
+ त्रुटियो ं के साथ की-स्ट्रो क्स)/मिनटो ंमें 
बिताया गया समय

नेट केपीएम  
(Net KPM)

बिना त्रुटियो ं के साथ की-स्ट्रो क वाला 
KPM 

नेट केपीएम = केपीएम - (त्रुटियो ं के 
साथ की-स्ट्रो क्स / मिनटो ंमें बिताया गया 
समय)

उदाहरण के लिए, यदि किसी छात्र ने प्रति 2 मिनट में 140 अक्षर टाइप किए हैं और 40 अक्षरो ंमें त्रुटियां 
हैं। 

सरल गति = 140 अक्षर / 2 मिनट = 70 सीपीएम

नेट CPM = 70 CPM - (40 त्रुटियाँ /(2 मिनट)) = 50 नेट सीपीएम

2.9.4	 टाइपिग सटीकता (Typing Accuracy)

टाइपिग सटीकता को टाइप की गई कुल प्रविष्टियो ंमें से सही प्रविष्टियो ंके प्रतिशत के रूप में परिभाषित 
किया गया है।
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2.9.5	 टाइपिग लय (Typing Rhythm)

टच टाइपिग तकनीको ं में टाइपिग लय बहुत महत्वपूर्ण है। टाइपिग लय का मतलब है कि कंुजी स्ट्रो क 
समान अंतराल पर आने चाहिए। लगातार टाइपिग स्पीड को नियंत्रित करने के लिए स्लोडाउन इंडिकेटर 
का उपयोग किया जाता है।

2.9.6 समग्र रेटिग गणना (Overall Rating Calculation)

कुल रेटिग (%) = (नेट स्पीड / कोर्स लक्ष्य/स्पीड) x 100%

जहां, नेट स्पीड नेट डब्लूपीएम, नेट सीपीएम या नेट केपीएम है, तथा प्रत्येक कोर्स के लिए उपलब्ध वर्तमान 
विकल्पों पर निर्भर करता है।

अच्छी टाइपिग गति: एक औसत पेशेवर टाइपिग गति 50 से 80 शब्द प्रति मिनट है और कुछ मामलो ंमें 
टाइपिस्ट 120 शब्द प्रति मिनट से ऊपर की गति पर काम करते हैं।

अल्फ़ान्यूमेरिक कीबोर्ड पर सबसे तेज़ टाइपिग गति एक मिनट में 216 शब्द है जो 1946 में स्टेला पजुनास 
द्वारा हासिल की गई थी।

2005 में गिनीज बुक ऑफ वर्ल्ड रिकॉरड्स के अनुसार, लेखिका बारबरा ब्लैकबर्न दुनिया में सबसे तेज़ 
अल्फा न्यूमेरिकल अंग्रेजी भाषा टाइपिस्ट थी।ं ड्वोरक सरलीकृत कीबोर्ड का उपयोग करके, उन्होंन� 50 
मिनट के लिए 150 शब्द प्रति मिनट और छोटी अवधि के लिए 170 शब्द प्रति मिनट बनाए रखा। उसकी 
शीर्ष गति 212 शब्द प्रति मिनट थी।

 महत्वपूर्ण iz'u 

बहुविकल्पीय iz'u

1.	नि म्नलिखित में से कौन विराम चिन्हों  (punctuation marks) की कंुजी नही ंहै?

	 A.	 Comma (,)

	 B.	 Period (.)

	 C.	 Semicolon (; )

	 D.	 Equal sign (=)

	 E.	 Dollar ($)



Class IX : 2024-25

37

SC
ER

T D
EL

HI
2.	नि म्नलिखित में से कौन सी एरो की (Arrow Key) नही ंहै?

	 A.	 Top ( )

	 B.	 Right ( )

	 C.	 Down ( )

	 D.	 Left ( )

3.	नि म्नलिखित में से कौन सा ऑपरेशन माउस द्वारा नही ंकिया जाता है?

	 A.	 बायां क्लिक

	 B.	 राइट क्लिक

	 C.	 मध्य क्लिक

	 D.	 डबल क्लिक

4.	 रैपिड टाइपिग ट्यूटर में, निम्नलिखित में से कौन सा सत्य नही ंहै?

	 A.	 हरे अक्षर सही इनपुट दर्शाते हैं।

	 B.	 पीले अक्षर अतिरिक्त समय में सही इनपुट के लिए हैं।

	 C.	 लाल अक्षर समय के साथ गलत इनपुट दर्शाते हैं।

	 D.	न ारंगी अक्षर समय के साथ गलत इनपुट दर्शाते हैं।

रिक्त स्थान भरें

1.	 अक्षर (A-Z) और संख्या (0-9) को _______ कंुजी के रूप में जाना जाता है।

2.	 डेल कंुजी (Del Key) कर्सर ____ पर वर्ण को हटा देती है।

3.	 __________कीबोर्ड पर सबसे लंबी कंुजी है।

4.	 संख्यात्मक कीपैड में _____ कॉलम और ______ पंक्तियाँ होती हैं।
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बताएं कि नीचे दिए गए कथन सत्य हैं या गलत:

1.	 Alt कंुजी का प्रयोग हमेशा दूसरी कंुजी के साथ किया जाता है।

2.	 कीबोर्ड पर 5 एरो कँुजियाँ होती हैं।

3.	 बैकस्पेस कंुजी का उपयोग कर्सर के दाईं ओर के अक्षर को हटाने के लिए किया जाता है।

4.	 कैप्स लॉक कंुजी एक टॉगल कंुजी है।

5.	 एंटर कंुजी को रिटर्न कंुजी के रूप में भी जाना जाता है।

6.	 'F' और 'J'  कंुजी को गाइड कंुजी के रूप में जाना जाता है।

7.	 कंुजीपटल पर दो कैप्स लॉक कंुजी होती हैं।

8.	 माउस में दो स्क्रॉल बटन होते हैं।

9.	 संख्यात्मक कीपैड पर, संख्या 8 मार्गदर्शक कंुजी है।

10.	 होम कंुजी दबाने पर कर्सर दस्तावेज़ (Document) के पहले अक्षर पर चला जाता है।

11.	 रैपिड टाइपिग ट्यूटर में, दर्ज किए गए सही इनपुट को पीले रंग से दर्शाया जाता है।

12.	 अलग -अलग सॉफ़्टवेयर में फ़ं क्शन कंुजियो ंका अलग-अलग अर्थ होता है।

लघु उत्तरीय iz'u 

1.	 टाइपिग एर्गोनॉमिक्स की भूमिका स्पष्ट करें ।

2.	 कंप्यूटर कीबोर्ड की निचली पंक्ति की कंुजियो ंके फिगर आवंटन का उल्लेख करें ।

3.	 'टच टाइपिग' क्या है?

4.	 कोई चार कीबोर्डिंग टिप्स दीजिए।

5.	 टाइपिग सटीकता और टाइपिग लय से क्या तात्पर्य है?

vvv
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विद्यार्थी-

•	 वर्ड प्रोसेसिग (Word Processing) सॉफ्टवेयर शुरूआत करने की प्रक्रिया समझते है।

•	 दस्तावेज़(document) संपादित (edit) कर पाते हैं।

•	 दस्तावेज़(document) स्वरूपित (format) करना कर पाते हैं।

•	 तालिकाएँ(table) बनाएँ और उपयोग (use) कर पाते हैं।

•	 दस्तावेज़(document) प्रिंट कर पाते हैं।

•	 मेल मर्ज के माध्यम से दस्तावेज़(document) प्रिंट कर पाते हैं।

परिचय (Introduction)

एक समय ऐसा था जब कुछ लिखने के लिए manual टाइपराइटर्स का उपयोग किया जाता था, जिसे 
इलेक्ट् रॉनिक टाइपराइटर्स ने बदल दिया, और अब इस कारण computer का उपयोग होता है। एक कागज 
में लिखी सामग्री को document कहा जाता है और इसे तैयार करने की प्रक्रिया को documentation 
कहा जाता है। documentation की आवश्यकता बाकी सामग्री को एक लंबे समय तक सुरक्षित रखने के 
लिए या साक्षात्कार के रूप में उपयोग करने के लिए होती है। Paper document, पत्र (letter), रिपोर्ट 
(Report), थीसिस (thesis), किताबें (books) आदि हो सकते हैं। हाथ से लिखे गए document की कुछ 
सीमाए भी हो सकती है जैसे कि विशिष्ट handwriting को समझना। कंप्यूटर हार्डवेयर और सॉफ़्टवेयर 
टेक्नोलॉजी में उन्नति के साथ, हाथ से लिखित documents की प्रक्रिया स्वचालित रूप से कंप्यूटर वर्ड 
प्रोसेसिग में परिणामित हुई है।

शब्द प्रोसेसर (word processor) के कुशल उपयोग से उपयोगकर्ता (user) अपनी लेखनी को संशोधित 
कर सकते हैं, नए विचार जोड़ सकते हैं, और तालिकाएँ (table), चित्र (image), और अन्य सामग्री जोड़ 
सकते हैं। इसके साथ, शब्द प्रोसेसर (word processor) उपयोगकर्ताओ ं को सुरक्षित तरीके से अपनी 
लेखनी को सहेजने (save) और साझा (share) करने की सुविधा भी प्रदान करता है।

इकाई-3  
डिजिटल दस्तावज़ीकरण (Documentation)
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यह एक पेशेवर और प्रभावी तरीके से दस्तावेज़ बनाने और संशोधित करने की सुविधा प्रदान करने के 
लिए आम तौर से व्यापक तरीके से उपयोग किया जाता है और विभिन्न विधियो ंके साथ सहयोग करने की 
क्षमता होती है।

Typewriter

1 लिब्रे ऑफिस राइटर का परिचय (Introduction to Libre Office)

LibreOffice एक फ्री और ओपन सोर्स सॉफ़्टवेयर (FOSS) है, जिसमें पूरी तरह से विशेषज्ञ office suite 
शामिल है। वर्तमान में LibreOffice की संस्करण 6.0 और उससे ऊपर उपलब्ध हैं। इसे वेबसाइट www.
libreoffice.org से मुक्त में डाउनलोड किया जा सकता है। यह स्यूट कई भाषाओ ंमें उपलब्ध है और 
कई प्लेटफ़ॉर्म्स (Windows, Mac और Linux) पर चलता है। यह प्रकाशन के लिए खुले दस्तावेज़ स्वरूप 
(Open Document Format - ODF) फ़ाइल स्वरूप का उपयोग करता है। LibreOffice के घटक एक 
दूसरे के साथ मिले हुए हैं और इसमें एक समान 'लुक एंड फ़ील' होता है, जिससे इसका उपयोग और 
प्रशिक्षण करना आसान है। LibreOffice के घटक (parts) हैं:
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1.	 Writer: वर्ड प्रोसेसिग के लिए

2.	 Calc: स्प्रेडशीट तैयारी के लिए

3.	 Impress: प्रस्तुति के लिए

4.	 Base: डेटाबेस प्रबंधन के लिए

5.	 Draw: ड्रॉइंग के लिए

और अन्य। LibreOffice में प्रत्यछ रूप से और सहेजने के लिए फ़ाइलें खोलने का समर्थन शामिल है, 
जिसमें Microsoft Office, HTML, XML, WordPerfect, और PDF जैसे कई सामान्य स्वरूपो ंका समर्थन 
है।

1 वर्ड प्रोसेसिग सॉफ्टवेयर शुरू करना!

1: लिब्रे ऑफिस राइटर के साथ शुरुआत करना (Getting started with Libre Office Writer) 
(वर्ड प्रोसेसिग सॉफ़्टवयर)

इस साफ्टवेयर का पहला संस्करण 25 January, 2011 को आया था।  इसका निर्माण ‘‘The Document 
Foundation” द्वारा निः शुल्क किया गया है। यह प्रोग्राम सी प्लस प्लस, जावा, और पाइथन लैंगवेज से बना 
है। इसका प्रकार आफिस सूट है। लिब्रे ऑफिस राइटर एक ओपन सोर्स सॉफ्टवेयर है यह सभी प्रकार 
के आपरेटिग सिस्टम पर कार्य करने वाला एक एप्लिकेशन साफ्टवेयर है। इसमें फाइल का डिफाल्ट नाम 
अनटाइटिल-1 होता है तथा इसका extension .odf text document है जबकि Ms Word में .doc,.
docx के नाम से फाइल सेव होती थी।

लिब्रे आफिस में एक ही साफटवेयर के अंतर्गत Libre Writer, Libre Calc, Libre Impress के नाम से 
साफ्टवेयर होते है

वेब आधारित वर्ड प्रोसेसर

•	 Google Docs

•	 Office 365 Word

•	 Microsoft OneDrive Word
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LibreOffice Writer Window

TITLE BAR 

DOCUMENT 
AREA 

MENU BAR 

STADARD 
TOOLBAR 

FORMATING BAR 

STATUS 
BAR 

Language 
Zoom 

LibreOffice Writer का मुख्य उद्देश्य है लोगो ंको एक बेहतर और सुरक्षित तरीके से लेखन करने का 
सुविधा प्रदान करना। इसका उपयोग लेखन, रिपोर्ट्स, पत्र, और अन्य दस्तावेज़ बनाने के लिए होता है। यह 
एक मुक्त और खुला स्रोत सॉफ़्टवेयर है, इसलिए लोग इसे बिना किसी खर्च के डाउनलोड और उपयोग 
कर सकते हैं।

LibreOffice Writer के कुछ मुख्य उद्देश्य इस प्रकार हैं:

1.	 सुविधाजनक इंटरफेस: यह एक आसान और बड़े संख्या में लोगो ं के लिए उपयोगकर्ता मित्रपूर्ण 
इंटरफेस प्रदान करता है, जो लेखन को सहज बनाता है।

2.	 मुक्त और खुला स्रोत: इस सॉफ़्टवेयर के मुक्त और खुले स्रोत का होने के कारण सभी लोग इसका 
उपयोग कर सकते हैं और उसे अपनी आवश्यकताओ ंके अनुसार सांदर्भिक रूप से बदल सकते हैं।

3.	व िभिन्न स्वरूपो ं का समर्थन: यह अनेक प्रकार के दस्तावेज़ और स्वरूपो ं का समर्थन करता है, 
जिससे लोग अपने दस्तावेज़ को विभिन्न स्थानो ंपर साझा कर सकते हैं।

4.	 सुरक्षितता: इसमें डेटा सुरक्षित रूप से संरक्षित रहता है, जिससे लोग अपनी जानकारी को सुरक्षित 
महसूस कर सकते हैं।

2: 	 LibreOffice Writer को खोलने के लिए निम्नलिखित चरणो ंका पालन करें :
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	 LibreOffice Writer को Open कैसे करे?

	 Start  All program  Libre Office  Libre Writer

	 LibreOffice Writer खोलने के लिए निम्नलिखित सरल चरणो ंका पालन करें :

	 कंप्यूटर को चालू करें : सबसे पहले अपने कंप्यूटर को चालू करें ।

•	लिब्रे  ऑफिस राइटर खोलें: डेस्कटॉप पर जाएँ और "Start" बटन पर क्लिक करें  या अपने ऑपरेटिग 
सिस्टम के "Start" विकल्प का उपयोग करें । फिर "LibreOffice" या "LibreOffice Writer" जैसा 
शब्द खोजें और उस पर क्लिक करें ।

•	न या दस्तावेज़ चुनें: LibreOffice खुलने पर, "File" मेनू में जाएँ और "New" का चयन करें । फिर 
"Text Document" को चुनें।

•	 लेखन शुरू करें : एक नया LibreOffice Writer दस्तावेज़ खुलेगा, और आप अब लेखन शुरू कर 
सकते हैं।

इस तरीके से आप अपने कंप्यूटर पर LibreOffice Writer खोल सकते हैं और नए दस्तावेज़ बना सकते 
हैं।

लिब्रे राइटर पढ़ने से पहले इसके बेसिक सरंचना (structure) को समझ लेते है :- Toolbars: -

Title Bar - यह सभी प्रोग्रामो ंमें सबसे ऊपर की ओर होती है इसे टाइटल बार इसलिए कहा जाता है 
क्योंक�ि इस बार में उस प्रोग्राम का नाम लिखा होता है जिसका हम प्रयोग कर रहे है तथा राइट हैन्ड साइट 
पर तीन बटन दिये होते है जिनके नाम मिनीमाइज, मैक्सीमाइज एवं क्लोज होते है (चित्र 3. 3)।

1.	 Minimize

2.	 Restore/Maximize

3.	 Close



44

lwpuk izkS|ksfxdh (Information Technology)

SC
ER

T D
EL

HIचित्र 3. 5 मेन्यू बार

Menu Bar :- टाइटल बार के तुरन्त नीचे एक बार होती है जिसमें फाइल, एडिट, व्यू, इन्सर्ट आदि ऑप्शन 
दिये होते है जिन्हें हम मीनू बार के नाम से जानते है।

चित्र 3. 6 स्टैंडर्ड टूलबार

Standard Bar- यह बार मीनू बार के एकदम नीचे होती है इस बार में कट, कापी, पेस्ट इत्यादि विकल्प 
दिये होते है। जिसका document फाइल को बनाने के लिए save या print करने के लिए प्रयोग में लाया 
जा सकता है।

Formatting Toolbar: - इस पर भी कुछ कमाण्ड या विकल्प प्रदर्शित होते हैं। ये ऐसे विकल्प होते हैं 
जिनका प्रयोग डाक्यूमेन्ट को आकर्षक बनाने के लिए अर्थात् Formatting (चित्र 3. 8 )करने के लिए किया 
जाता है। जैसे– पैराग्राफ style, font face, font size, bold, italic, underline, superscript, bullets, 
numbering, indent, line spacing आदि।

Ruller bars 

Ruler Bar- यह बार फारमेटिग बार के नीचे स्के ल की तरह 
दिखायी देती है इस बार के द्वारा पेज की मार्जिन को सेट 
करने का काम किया जाता है।

Rulers: - Rulers दो होते हैं–

•	 horizontal: - यह फॉर्मेट�िग टूलबार के नीचे अथवा 
पेज के ऊपर प्रदर्शित होता है। यह पेज की चौड़ाई को 
मापता है। सेंटीमीटर में।
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•	 Vertical: - यह विन्डो पर बाँयी ओर ऊर्धाधर रूप में प्रदर्शित होता है। यह पेज की ऊँचाई या लम्बाई 

को मापता है।

Scroll Bar: - यह भी दो होते हैं–

•	 horizontal scroll bar: - यह विन्डो पर 

चित्र 3.10 LØksy ckj

 

Vertical 
scrollbar 

Horizontal 
scrollbar 

नीजे की ओर प्रदर्शित होता है इससे पेज 
को दायें-बाँयें खिसकाते हैं।

•	 vertical scroll bar: - यह विन्डो या स्क्रीन 
पर दायी ं ओर प्रदर्शित होती है इससे पेज 
को ऊपर या नीचे खिसकाते हैं।

Status Bar- यह बार विन्डो में सबसे नीचे की ओर होती है यह बार ऊपर किये जाने वाले सभी कार्य का 
स्थिती प्रदर्शित करती है जैसे फाइल में कितने पेज है, कितने वर्ड है इत्यादि।

Status Bar 

चित्र 3.11 fLFkfr (Status Bar)

Menu Bar: - टाइटल बार के नीचे दिखने वाली पट्टी को मीनू बार कहते हैं जिसमें 11 मीनू होते हैं, जो 
निम्नवत् हैं–

चित्र 3. 12 Menu Bar
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लिब्रे ऑफिस राइटर में मेन्यू आपको विभिन्न कार्यों और विकल्पों के लिए स्थान प्रदान करते हैं। यहां हिदी 
में कुछ मुख्य मेन्यूज़ का सरल विवरण है:

•	फ़ा इल (File): इस मेन्यू में आप नए दस्तावेज़ बना सकते हैं, पुराने को खोल सकते हैं, और अपने 
दस्तावेज़ को सहेज सकते हैं।

चित्र 3. 13

•	 संपादन (Edit): इस मेन्यू में विषय सामिग्री को 

चित्र 3. 14 Edit Menu

काटना, कॉपी करना, पेस्ट करना, और अन्य 
संपादन संबंधित विकल्प होते हैं।



Class IX : 2024-25

47

SC
ER

T D
EL

HI
•	 स्वरूप (Format): यहां आप विषय सामिग्री और पृष्ठ(page) के स्वरूप(format) से संबंधित विकल्प 

पाएंगे, जैसे कि फॉन्ट, पैराग्राफ, और बैकग्राउंड रंग।

चित्र 3.15

•	 सार्वजनिक (View Menu): इससे आप दस्तावेज़ को पूरे स्क्रीन मोड में देख सकते हैं या नेविगेशन 
और स्लाइड शो को कस्टमाइज़ कर सकते हैं।

चित्र 3.16 Edit Menu
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•	 इन्सर्ट (Insert): इस मेन्यू में आप दस्तावेज़ में चित्र, टेबल, हाइपरलिक, और अन्य ऑब्जेक्ट्स को 

इन्सर्ट करने के विकल्प पाएंगे।

चित्र 3.17

•	 उपकरण (Tools): इस मेन्यू में आप थायर्स, स्पेलिग और ग्रामर की जाँच, संग्रहण, और और भाषा 
से संबंधित उपकरण(tools options) पा सकते हैं।

चित्र 3. 18
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•	 शैली (Style): "स्टाइल मेन्यु“ में आप विभिन्न फ़ॉर्मेट�िग विकल्पों को संशोधित (change) करके 

आपके दस्तावेज़ की शैली और स्वरूप को व्यक्तिगत रूप से समर थ्ित कर सकते हैं, जैसे कि फ़ॉन्ट्, 
अंतरछाया, और अन्य संप्रेषण विकल्प।

चित्र 3.19

इन मेन्यु का उपयोग करके आप लिब्रे ऑफिस राइटर में विभिन्न कार्यों को सीख सकते हैं और अपने 
दस्तावेज़ को सुधार सकते हैं।

4:	 दस्तावज़ बनाएँ (Create a Documents)

LibreOffice Writer में एक नए दस्तावेज़ बनाने के लिए निम्नलिखित चरणो ंका पालन करें :

लिब्रे ऑफिस ओपन करें :

चित्र 3.20
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अपने कंप्यूटर में LibreOffice ओपन करें .

लिब्रे ऑफिस वार्ड पर क्लिक करें :

1.	लिब्रे  ऑफिस के मेनू से "Writer" या "वार्ड" आइकन पर क्लिक करें .

2.	न या दस्तावेज़ शुरू करें :

3.	 "File" मेनू से "New" या "नया" का चयन करें  और फिर "Text Document" को चुनें. Or use 
shortcut (ctrl+N)

4.	 पेज लेआउट चयन करें :

5.	 जब आप एक नया दस्तावेज़ शुरू करते हैं, आपको पेज लेआउट का चयन करना होगा, जैसे 
"Default," "Web," या "A4."

6.	 दस्तावेज़ में लेखन शुरू करें :

7.	 एक बार जब आपका दस्तावेज़ खुल जाए, आप लेखन शुरू कर सकते हैं. टेक्स्ट (text), छवियो ं
(pictures), शीर्षक (headings), खंड (paragraph), इत्यादि जोड़ सकते हैं.

इस रूप से, आप LibreOffice Writer में एक नया दस्तावेज़ शुरू कर सकते हैं, और उसे एक पुस्तक 
जैसे फ़ॉर्मैट में व्यावसायिक या व्यक्तिगत उपयोग के लिए संशोधित कर सकते हैं।

दस्तावज़ को लिबर ऑफिस राइटर में सहेजें (Save document in libre office writer)

नए फ़ाइल को LibreOffice Writer में सहेजने के लिए निम्नलिखित सरल चरणो ंका पालन करें :

चित्र 3.21
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दस्तावज़ बनाएँ:

LibreOffice Writer खोलें और नया दस्तावेज़ बनाएं या एक पहले से मौजूद दस्तावेज़ खोलें जिसे आप 
सहेजना चाहते हैं, सहेजने के लिए तैयारी के लिए निम्न चरणो ंका पालन करे:-

1.	 जब आप अपने दस्तावेज़ को सहेजने के लिए तैयार हो,ं "File" मेनू पर क्लिक करें .

2.	 "File" मेनू से (चित्र 3. 21)"Save" या "सहेजें" का चयन करें . or (CTRL+S)

3.	 स्थान चुनें:

4.	 एक सहेजने के लिए स्थान चुनें, जैसे कि कंप्यूटर की फ़ोल्डर या किसी अन्य स्थान।

5.	 दस्तावेज़ (Document) नाम दें :

6.	 आपकी फ़ाइल को एक नाम दें  और "Save" या "सहेजें" पर क्लिक करें .(CTRL+S)

File name 

Click save 

चित्र 3.22

इस रूप से, आप अपने नए फ़ाइल को LibreOffice Writer में सहेज सकते हैं। आप फ़ाइल को उचित 
स्थान पर सहेज सकते हैं और उसे बाद में फिर से खोल सकते हैं।

आप document को नए नाम से भी save कर सकते है।
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Step-1 फ़ाइल मेनू पर क्लिक करें  और इस रूप में सहेजें (save as) विकल्प चुनें (चित्र 3. 23)

चित्र 3.23 	चि त्र 3.24

Step-2 उस फ़ोल्डर का चयन करें  जहाँ आप दस्तावेज़ को सहेजना चाहते हैं। फ़ाइल का नाम दर्ज करें  
save as type default .ODF text document format.

Step-3 अंत में सेव बटन पर क्लिक करें  और आपका डॉक्यूमेंट चयनित डॉक्यूमेंट में दर्ज नाम के साथ 
सरंछित हो जाएगा|

3 मौजूदा दस्तावज़ (document) खोलना

LibreOffice Writer में मौजूदा दस्तावेज़ खोलने के लिए निम्नलिखित सरल चरणो ंका पालन करें :

चित्र 3. 25
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1.	 LibreOffice खोलें:

2.	 अपने कंप्यूटर में LibreOffice ओपन करें .

3.	 Writer चयन करें :

4.	 "File" मेनू से "Open" या "खोलें" का चयन करें  (चित्र 3. 25).

5.	फ़ा इल का स्थान चुनें:

6.	 आपकी दस्तावेज़ को सहेजा गया है वहां पहुंचें और उसे चुनें।

7.	 खोलें:

चित्र 3. 26

चयनित दस्तावेज़ को खोलने के लिए "Open" या "खोलें" पर क्लिक करें .

इस रूप से, आप अपने मौजूदा दस्तावेज़ को LibreOffice Writer में खोल सकते हैं और उसे संपादित 
किया जा सकता है या पढ़ा जा सकता है।

गतिविधि (Activity):

1.	लिब्रे  ऑफिस वर्ड में दस्तावेज़ को सहेजने के लिए कौन-कौन से चरण होते हैं?

2.	लिब्रे  ऑफिस वर्ड में मौजूदा दस्तावेज़ को कैसे खोला जाता है?

3.	 दस्तावेज़ को सहेजने के लिए "Save" और "Save As" में क्या अंतर है?
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2.	 दस्तावज़ (document) संपादित (edit) करें !

1:	 पाठ संपादन (text editing)

पाठ संपादन होता है जब आप किसी टेक्स्ट या दस्तावेज़ को बदलते हैं या सुधारते हैं। तब उसे पाठ संपादन 
कहते है यहां कुछ मुख्य पाठ संपादन क्रियाएं हैं जो आप एक वर्ड प्रोसेसिग सॉफ़्टवेयर जैसे LibreOffice 
Writer में कर सकते हैं:

1.	 UNDO: - पिछले टास्क को हटाने के लिए इस विकल्प का प्रयोग करते हैं। अधिकतम 100 बार 
अनडू किया जा सकता है। इसका शॉर्टकट Ctrl + Z है।

2.	 REDO: - जब अनडू विकल्प का प्रयोग किया गया हो, तभी यह विकल्प सक्रिय होता है। इसके द्वारा 
पिछले मिटाये गये टास्क को पुनः  दोहराने के लिए किया जाता है। जितनी बार अनडू किया गया हो, 
उतनी बार ही रीडू किया जा सकता है। इसका शॉर्टकट Ctrl + Y है।

3.	 CUT: - इस विकल्प से चयनित टेक्स्ट या आबजेक्ट को कट करते हैं। अर्थात् मूव करते हैं। इसका 
शॉर्टकट Ctrl + X है।

4.	 COPY: - इस विकल्प से चयनित टेक्स्ट या ऑब्जेक्ट को कॉपी करते हैं। इसका शॉर्टकट Ctrl + C 
है।

5.	 PASTE: - कट या कॉपी किये गये टेक्स्ट या ऑब्जेक्ट को पेस्ट करते हैं अर्थात् पुनः  प्राप्त करते हैं। 
इसका शॉर्टकट Ctrl + V है।

6.	 PASTE SPECIAL: - इसके अन्तर्गत निम्न विकल्प होते हैं–

चित्र 3. 27
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•	 Paste unformatted text (Ctrl + Alt + Shift + V): - इस विकल्प से कट या कापी किये गये 

टेक्स्ट को बिना फॉर्मेट�िग के पेस्ट किया जा सकता है।

•	 Paste Special (Ctrl + Shift + V): - इस विकल्प से पेस्ट स्पेशल बॉक्स प्रदर्शित होता है, जिसमें 
निम्न विकल्प होते हैं।

	 o	� Libre Office writer text document: - इससे कट या कॉपी किया गया टेक्स्ट लिब्रे ऑफिस 
के टेक्स्ट के रूप में प्राप्त होता है।

	 o	 HTML Text: - इससे कट या कापी किया गया टेक्स्ट एचटीएसएल के रूप में प्राप्त होता ह।

	 o	� RTF: - इस विकल्प से कट या कापी किया गया टेक्स्ट आरटीएफ टेक्स्ट के रूप में प्राप्त होता 
है।

SELECT TEXT (पाठ का चयन):

पाठ (text) संपादन (editing) करने के लिए, सबसे पहले उस पाठ (text) को चुनें जिसे आप संपादित 
(edit) करना चाहते हैं। आप माउस का इस्तेमाल करके या टेक्स्ट को क्लिक और ड्रैग करके पाठ को 
चुन सकते हैं।

Select All (Ctrl + A): - इस विकल्प से फाइल के पूरे टेक्स्ट को एक साथ सेलेक्ट कर सकते है(चित्र 
3. 28)s

	चि त्र 3. 28 	चि त्र 3. 29

Standard Mode: - बाई डिफाल्ट यह सेट रहता है जिससे फाइल या पेज के टेक्स्ट का चयन सदैव 
आयताकार बाक्स के रूप में होता है (चित्र 3. 29)।

Block Area Selection Mode (Alt + Shift + F8 or Ctrl + Shift + F8): - इस विकल्प से फाइल 
या पेज के टेक्स्ट को टेक्स्ट के अनुसार खण्ड के रूप में चयनित किया जाता है।
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Select text ( Ctrl + Shift + I):- इस विकल्प से फाइल के टेक्स्ट के एक-एक अक्षर का चयन करते 
हैं। इसका प्रयोग टेक्स्ट बाक्स के अन्दर में टेक्स्ट को चुनन के लिए होता है। यह प्वाइंटर की तरह प्रदर्शित 
होता है।

Find (Ctrl + F): - इस विकल्प से डाक्यूमेन्ट के किसी टेक्स्ट को ढँूढ़ते हैं इस पर क्लिक करने से स्क्रीन 
पर नीचे की ओर स्टेटस बार के ठीक ऊपर एक क्षैतिज पंक्ति प्रदर्शित होती है। जिसमें फाइंड का विकल्प 
और बाक्स होते हैं। जिस टेक्स्ट को ढँूढने है उसे फाइंड बाक्स में लिखते हैं और इंटर की प्रेस करते हैं 
फाइल से वह टेक्स्ट चयनित होकर स्क्रीन पर प्रदर्शित होता है।

 

चित्र 3. 30

Find & Replace (Ctrl + H): - इस विकल्प से दस्तावेज में कोई पाठय सामिग्री ढूढ़ कर उसे किसी 
अन्य सामिग्री में बदलते हैं इससे फाइंड और रिप्लेस बॉक्स प्रदर्शित होता है जिसमें फाइंड तथा रिप्लेस के 
बाक्स बने होते हैं जिस पाठ् (टेक्स्ट) को ढूढ़न ा है उसे फाइंड बाक्स में लिखते हैं और पाठ्s को जिस पाठ् 
से बदलना होता है उसे रिप्लेस वाले बाक्स में लिखकर इंटर(enter)की प्रेस करते हैं। रिप्लेस के लिए दो 
विकल्प होते हैं रिप्लेस और रिप्लेस ऑल।
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लिब्रे ऑफिस वर्ड में "Find and Replace" करने के लिए निम्नलिखित चरणो ंका पालन करें :

1.	 दस्तावज़ खोलें:

	 a.	� LibreOffice Writer खोलें और उस दस्तावेज़ को चुनें जिसमें आप "Find and Replace" 
करना चाहते हैं.

	 2.	 "Find" डायलॉग बॉक्स खोलें:

	 a.	 "Edit" मेनू से "Find" या "Ctrl + F" दबाकर "Find" डायलॉग बॉक्स खोलें।

8	 a.	� खोजने के लिए आप जो पाठ ढंूढ़ना चाहते हैं, उसे "Search for" या "खोज के लिए" बॉक्स में 
दर्ज करें ।

4.	व िकल्पों की निर्धारण:

	 a.	� आपको कुछ विकल्पों को निर्धारित करना होगा सकता है, जैसे कि "Match case" (मिलान 
केस), "Whole words" (पूरे शब्द), और "Regular expressions" (रेगुलर एक्सप्रेशन्स)।

5.	 "Find Next" बटन पर क्लिक करें :

	 a.	� आपके द्वारा दर्ज किए गए पाठ के पहले उपस्थिति को खोजने के लिए "Find Next" बटन पर 
क्लिक करें ।

6.	 पाठ का बदलाव:

	 a.	� अगर आप पाठ को बदलना चाहते हैं, तो "Replace" बटन पर क्लिक करें । यदि आप सभी 
उपस्थितियो ंको एक साथ बदलना चाहते हैं, तो "Replace All" बटन का उपयोग करें ।

7.	 "Close" बटन पर क्लिक करें :

	 a.	� समाप्त होने पर "Find and Replace" डायलॉग बॉक्स को बंद करने के लिए "Close" बटन पर 
क्लिक करें ।

इस रूप से, आप LibreOffice Writer में "Find and Replace" कर सकते हैं और आसानी से विशेष 
पाठ की खोज और बदलाव कर सकते हैं।

Go To (Ctrl + G):- इस विकल्प से फाइल में एक पेज से अन्य पेजेज पर सीधे आगे बड़ कर सकते हैं। 
इस पर क्लिक करने से गो टू पेज बाक्स प्रदर्शित होता है। जिसमें उस पेज का नम्बर लिखते हैं, जिस पर 
जाना है और इंटर प्रेस करते हैं।



58

lwpuk izkS|ksfxdh (Information Technology)

SC
ER

T D
EL

HI
चित्र 3. 31

शब्दसंग्रह और व्याकरण (Spelling and Grammer) की जाँच

चित्र 3. 32

लिब्रे ऑफिस बार्डर में शब्दसंग्रह और व्याकरण (Spelling and Grammer) की जाँच करने के लिए 
निम्नलिखित चरणो ंका पालन करें :

अपना दस्तावज़ खोलें:

•	 लिब्रे ऑफिस बार्डर को शुरू करें  और उस दस्तावेज़ को खोलें (चित्र 3. 33)जिसे आप शब्दसंग्रह और 
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व्याकरण (Spelling and Grammer) की जाँच करना चाहते हैं।

"Tools" मेनू में जाएँ:

•	 बार्डर विडो के शीर्ष मेनू बार में "Tools" मेनू पर क्लिक (चित्र 3. 33) करें ।

चित्र 3. 33

"Spelling and Grammar" विकल्प चुनें:

•	 ड्रॉपडाउन मेनू से "Spelling and Grammar" (शब्दसंग्रह और व्याकरण) विकल्प का चयन करें । 
एक और तरीका है "F7" कंुजी (Key)(key) दबाना, जो शब्दसंग्रह और व्याकरण चेक को खोलेगा।

शब्दसंग्रह डायलॉग बॉक्स:

•	 शब्दसंग्रह डायलॉग बॉक्स आएगा, जो पहली संभावित त्रुटि को हाइलाइट करेगा। सुझावो ं के लिए 
options दिखाई जाएँगे।

चित्र 3. 34

त्रुटियो ंकी समीक्षा और सुधार:

•	 प्रत्येक संभावित त्रुटि के लिए, आप सुझाए गए सुधारो ं की समीक्षा कर सकते हैं और "Correct" 
(बदलें), "Ignore" (नजरअंदाज करें ), या "Add" (शब्दसंग्रह में जोड़ें) का उपयोग कर सकते हैं (चित्र 
3. 35) ।
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चित्र 3. 35

व्याकरण जाँच (Grammer check):

•	 लिब्रे ऑफिस बार्डर व्याकरण त्रुटियो ंकी भी जाँच करता है। यदि इसमें कोई व्याकरण समस्या होती 
है, तो यह सुझाव और सुधार के लिए दिखाएगा (चित्र 3. 36)।

चित्र 3. 36

त्रुटि ढँूढना (Error finding):

•	 शब्दसंग्रह डायलॉग बॉक्स में जाकर दस्तावेज़ में त्रुटि ढँूढना और प्रत्येक पहचानी गई त्रुटि की समीक्षा 
करने के लिए "Next" (अगला) और "Previous" (पिछला) बटन का उपयोग करें ।

•	 शब्दसंग्रह और व्याकरण जाँच पूरी करें :

•	 आपने सम्पूर्ण दस्तावेज़ की समीक्षा और सुधार करने के बाद, शब्दसंग्रह डायलॉग आपको सूचित 
करेगा जब यह समाप्त हो जाएगा (चित्र 3. 37)।
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चित्र 3. 37

शब्दसंग्रह (Spelling and Grammer)डायलॉग को बंद करें :

•	 सभी त्रुटियो ंकी समीक्षा और सुधार करने के बाद, शब्दसंग्रह डायलॉग बॉक्स को समाप्त करने के 
लिए "Close" (बंद करें ) बटन पर क्लिक करें ।

	 इन चरणो ं का पालन करके, आप लिब्रे ऑफिस रायटर (libre office writer) में शब्दसंग्रह और 
व्याकरण की जाँच कर सकते हैं और सुनिश्चित कर सकते हैं कि आपका दस्तावेज़ विभिन्न त्रुटियो ंसे 
मुक्त है।

समानार्थक (synonyms) शब्द और थिसॉरस (thesaurus) का उपयोग करना

आप समानार्थी शब्द या संबंधित शब्द देखने के लिए थिसॉरस का उपयोग कर सकते हैं

Step1: उस शब्द पर क्लिक करें  जिसे आप देखना या बदलना चाहते हैं (चित्र 3. 38)|

चित्र 3. 38
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Step2: उपकरण (tools) मेनू चुनें और फिर थिसॉरस (thesaurus) चुनें या CTRL+F7 दबाएं वैकल्पिक 
सूची में, उस संबंधित शब्द की "इससे बदलें" पाठ बॉक्स में प्रतिलिपि बनाने के लिए किसी प्रविष्टि पर 
क्लिक करें  (चित्र 3. 39)|

चित्र 3. 39

Step 3: बदलें बटन पर क्लिक करें । प्रारंभ में, थिसॉरस दस्तावेज़ (document) में चयनित शब्द की भाषा 
का उपयोग करता है, यदि उस भाषा के लिए थिसॉरस लिब्रेरी स्थापित(installed) है (चित्र 3. 40)।

चित्र 3. 39
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अपनी प्रगति की जाँच:

1.	 टेक्स्ट एडिटिग क्या है?

2.	 REDO और UNDO के बीच बुनियादी अंतर क्या है?

3.	 हम टेक्स्ट फाइंड और रिप्लेस का उपयोग क्यों करते हैं? यह कैसे किया जा सकता है?

3 दस्तावज़ (document) को प्रारूपित (formatting) करना

1:	 Formatting Paragraph

	 Document को format करने के लिए हम menu या formatting toolbar दोनो ंमें से कोई भी 
option को उस कर सकते है, Formatting options का उपयोग कर के हम अपने document 
को बहुत ही प्रभावशाली बना सकते है (चित्र 3. 41) और (चित्र 3. 42)|

चित्र 3. 41

चित्र 3. 42

1.	 TEXT

	 Document में लिखे गए Text को Format करने के लिए इस option का use किया जाता है। इसके 
अन्दर कई options दिए हैं, जैसा कि नीचे (चित्र 3. 43) में देख रहे हैं|
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चित्र 3. 43

•	 Bold {Ctrl + B}

	 o	 Select किये गए Text को मोटा करने के लिए इस option का प्रयोग किया जाता है।

•	 Italic {Ctrl + I}

	 o	 Select किये गए Text को तिरछा करने के लिए इस option का प्रयोग किया जाता है।

•	 Underline {Ctrl + U}

	 o	 Select किये गए Text के नीचे एक line लगाने के लिए इस option का प्रयोग किया जाता है।

•	 Double Underline {Ctrl + D}

	 o	 Select किये गए Text के नीचे दो line लगाने के लिए इस option का प्रयोग किया जाता है।

•	 Strikethrough

	 o	� Select किये गए Text को बीच से काटने के लिए इस option का प्रयोग किया जाता है।इसका 
use हम ऐसी जगह पर किया जाता है, जहा पर हमें गलती दिखानी होती है।

•	 Overline

	 o	 Select किये गए Text के ऊपर एक line लगाने के लिए इस option का प्रयोग किया जाता है।

•	 Superscript {Ctrl + Shift + P}
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	 o	� Select किये गए text को Baseline के ऊपर करने के लिए इस option का प्रयोग किया जाता 

है।

		  जैसे- (A+B)2 = A2+B2+2AB

•	 Subscript {Ctrl + Shift + B}

	 o	� Select किये गए text को BaseLine के नीचे करने के लिए इस option का प्रयोग किया जाता 
है। जैसे- C6H12O6 – Glucose

•	 Shadow

	 o	 Select किये गए text पर shadow लगाने के लिए इस option का प्रयोग किया जाता है।

•	 Outline

	 o	� Select किये गए text की केवल outline को देखने व लगाने के लिए इस option का प्रयोग 
किया जाता है।

•	 Increase Size { Ctrl + ] }

	 o	 Select किये गए text के size को बड़ा करने के लिए इस option का प्रयोग किया जाता है।

•	 Decrease Size { Ctrl + [ }

	 o	 Select किये गए text के size को छोटा करने के लिए इस option का प्रयोग किया जाता है।

•	 Uppercase

	 o	� Select किये गए text को CAPITAL LETTER में लिखने के लिए इस option का प्रयोग किया 
जाता है।

फ़ॉन्ट फेस (Font face)

हम फ़ॉन्ट फेस विकल्पों के साथ चयनित टेक्स्ट का फ़ॉन्ट चेहरा (font face) बदल सकते हैं (चित्र 3. 44)|

चित्र 3. 44
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फ़ॉन्ट आकार (Font size)

हम फ़ॉन्ट आकार विकल्पों के साथ चयनित टेक्स्ट का फ़ॉन्ट आकार (font size) बदल सकते हैं (चित्र 3. 
43)|

पाठ संरेखण (Text Alignment):- एलाइनमेंट (Alignment) विकल्प का उपयोग टेक्स्ट और ऑब्जेक्ट्स 
को दस्तावेज़ में सही रूप से स्थानित करने के लिए किया जाता है। यह विकल्प पाठ, पैराग्राफ, या छवियो ं
को पृष्ठ पर कैसे स्थित करना है, उसे निर्धारित करने में मदद करता है। निम्नलिखित हैं कुछ मुख्य 
एलाइनमेंट विकल्प और उनका विवरण: office writer में चार प्रकार के पैराग्राफ संरेखण उपलब्ध हैं- 
बाएं संरेखित (left-aligned), दाएं संरेखित (right-aligned), कें द्र संरेखित (center-aligned) और उचित 
संरेखित( justify-aligned) (चित्र 3. 45).

चित्र 3. 45

•	 Left Alignment: - इस विकल्प से फाइल के टेक्स्ट के लिए लेफ्ट एलाइनमेन्ट सेट करते हैं। बाई 
डिफाल्ट यह एलाइनमेन्ट सेट रहता है। इसे पेज पर बायें से दायें बढ़ाते हुए टाइप करते हैं। बायी ं
तरफ से बिल्कु ल सीध में जबकि दायी ंतरफ आगे-पीछे ही टाइप होता हैं।

•	 Right Alignment: - इस एलाइमेन्ट को सेट करके पेज पर दायें से बायें टाइप करते हैं दायें में 
सीध में जबकी बायी ंतरफ आगे-पीछे हो सकती हैं।
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•	 Center Alignment: - इस एलाइमेन्ट को सेट करके पेज के बीचो ंबीच से टाइपिग प्रारम्भ होती है 

बायें तथा दाये समान रूप से टेक्स्ट आगे बढ़ते हैं इसमें बायें ओर दायें दोनो ंतरफ लाइनें आगे पीछे 
छोटी-बड़ी हो सकती हैं।

•	 Justified Alignment: - इस एलाइमेन्ट से पजे पर टेक्स्ट बाये से दाये टाइप होते हैं इसमें बायी 
और दायी ओर दोनो ं तरफ विल्कु ल सीध में होती हैं। इस एलाइमेन्ट में लाइन का अन्तिम शब्द 
आवश्यकता पड़न पर हाइफन (-) द्वारा दो भागो ंमें टूट जाता हैं।

3:	 बुलेट्स और नंबरिंग (List, Bullets and Numbering)

 Bullets and Numbering विकल्प के माध्यम से हम चयनित पैराग्राफ की एक सूची (list) 

बना सकते हैं|

चयनित पाठ पर बुलेट्स और क्रमांकन (bullets and numbering) लागू करने के चरण (steps):-

Step 1: - पाठ या अनुच्छे दो ंका चयन करें  (चित्र 3. 47)|

चित्र 3. 47
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Step 2: - फॉर्मेट�िग टूलबार या फॉर्मेट मेनू पर जाएँ और बुलेट और नंबरिंग विकल्प चुनें (चित्र 3. 48)|

चित्र 3. 48

Step 3:- चयनित पाठ के लिए क्रम (order, bullets list) या अक्रमित (unordered, number list) सूची 
विकल्प का चयन करें |

	चि त्र 3. 50	चि त्र 3. 51
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4 पृष्ठ स्वरूपण (Page Formatting)

पृष्ठ स्वरूपण (Page Formatting) विकल्पों का उपयोग दस्तावेज़ के पृष्ठों की दृष्टि से करना होता है। यह 
विकल्प पृष्ठ का आकार, मार्जिन, स्थिति, और अन्य स्वरूपण से संबंधित हो सकते हैं। निम्नलिखित हैं कुछ 
मुख्य पृष्ठ स्वरूपण विकल्प और उनका विवरण:

a)	 पृष्ठ का आकार (Page Size): "Format" मेनू के तहत "Page" विकल्प में, आप पृष्ठ का आकार 
(जैसे A4, Letter, आदि) चुन सकते हैं (चित्र 3. 52) और (चित्र 3. 53)।

चित्र 3. 52 और (चित्र 3. 53

b)	 मार्जिन (Margin): "Format" मेनू के 

चित्र 3.54

तहत "Page" विकल्प में, आप पृष्ठ के 
चारो ं किनारो ं के मार्जिन को सेट कर 
सकते हैं (चित्र 3. 54) ।
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c)	 पृष्ठ की दिशा (Page Orientation): "Format" मेनू के तहत "Page" विकल्प में, आप पृष्ठ की 

दिशा को पोर्ट्रे ट (ऊचाई से अधिक) या लैंडस्के प (चौड़ाई से अधिक) मोड में सेट कर सकते हैं (चित्र 
3. 55) ।

चित्र 3. 55

d)	 पृष्ठ बॉर्डर (page border): इस option को हम पेज पर Border लगाने के लिए उपयोग करते है 
(चित्र 3. 56) |

चित्र 3. 56
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Steps: -

•	 "Format" मेनू से "Page" विकल्प का चयन करें ।
•	 "पृष्ठ" टैब का चयन करें |
•	 "Page" विकल्प का चयन करने के बाद, "Page" टैब को चुनें।
•	 "पृष्ठ की सीमा" विकल्प को चुनें|
•	 "Page Border" या "पृष्ठ की सीमा" विकल्प को चुनें।
•	 सीमा विकल्पों को कस्टमाइज़ करें |
•	 यहां, आप सीमा के आकार, रंग, स्टाइल, और अन्य विकल्पों को चुन सकते हैं।
•	 "OK" पर क्लिक करें |

आपकी पसंदीदा सीमा स्टाइल और सेटिग्स को चुनन के बाद, "OK" पर क्लिक करें  ताकि यह आपके 
दस्तावेज़ में लागू हो जाए।

5 पृष्ठ विराम (page break) सम्मिलित करना (inserting page break)

आप अपने दस्तावेज़ में किसी विशिष्ट स्थान पर मैन्युअल पृष्ठ विराम सम्मिलित कर सकते हैं. यह तब 
उपयोगी होता है जब आप कुछ सामग्री को नए पृष्ठ पर प्रारंभ करने के लिए बाध्य करना चाहते हैं.

 

चित्र 3. 57
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मैनु्यअल पृष गिराम सखमिगलत करने के गलए:

1. कस्यर को वहाँ रखें जहाँ आप िया पृष्ठ प्रारंभ करिा चाहते हैं.
2. "इन्सट्य" मेियू पर जाएँ (नचत 3. 57)।
3. नवकल्पो ंमें से "मैनु्यअल बेक" या "पृष्ठ बेक" चुिें।
4. "पेज बेक" या "पृष्ठ बेक" चुिें और "ओके" पर क्क्क करें ।

6 पृष (page) कयो कॉलम (column) में बदलना |

नलबे ऑनफस राइटर में "करॉलम" शब आमतौर से एक दस्तावेि में टेक्स्ट के लेआउट को संदनभ्यत करता 
है। करॉलम आपको अपिे टेक्स्ट को एक ऐसे संरचिा में व्वक्स्त करिे कली अिुमनत देता है जो एक 
अख़बार या मैगजलीि कली तरह होतली है, जहां सामग्रली एक करॉलम से दयू सरे करॉलम में बहतली है।

Steps: -

a) कॉलम सेट करना: अपिे दस्तावेि में करॉलम लागयू करिे के नलए, सबसे पहले उस टेक्स्ट को चुिें 
नजसे आप स्वरूनपत करिा चाहते हैं, या वहां कस्यर रखें जहां से करॉलम शुरू होिा चानहए।

 नफर, मेन्ययू बार पर जाएँ और Format -> Columns  (नचत 3. 58)।
गचत्र 3. 58

b) कॉलम की संख्या: "करॉलर्" डायलरॉग बरॉक्स में, आप अपिे दस्तावेि में नकतिे करॉलम होिे चानहए 
इसे निधा्यररत कर सकते हैं। आप 1 से लेकर 32 करॉलम तक चयि कर सकते हैं (नचत 3. 58)।
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गचत्र 3. 59
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d)	 चौड़ाई और अंतरदृष्टि (width and Spacing):आप अपने कॉलम की चौड़ाई और अंतरदृष्टि को 

भी सेट कर सकते हैं। इससे तय होगा कि प्रत्येक कॉलम के लिए कितनी जगह होगी और उनके बीच 
का अंतर क्या होगा। आप चौड़ाई को मैन्युअली सेट कर सकते हैं या पूर्वनिर्धारित लेआउट का चयन 
कर सकते हैं (चित्र 3. 59)।

 

चित्र 3. 60

e)	 कॉलम के बीच रेखा (separator line): कॉलम के बीच एक रेखा जोड़न के लिए एक विकल्प भी 
है। इस सुविधा को सक्रिय करने से, कॉलम्स के बीच एक लंबवत रेखा डाली जाएगी जो दृष्टिगत रूप 
से कॉलम को अलग करेगी (चित्र 3. 60)।

f)	 समान चौड़ाई (Auto Width): यदि आप "समान चौड़ाई" विकल्प को चेक करते हैं, तो सभी 
कॉलमो ंकी एक समान चौड़ाई होगी। यदि यह चेक नही ं किया गया है, तो आप प्रत्येक कॉलम की 
विशिष्ट चौड़ाई सेट कर सकते हैं।(चित्र 3. 61)
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चित्र 3.61

g)	 ओके पर क्लिक करें : कॉलम विकल्पों को कॉन्फ़िगर करने के बाद, "ओके" पर क्लिक करें  ताकि 
परिवर्तन लागू हो सके (चित्र 3. 61)।

7 Header and Footer

Header and Footer Insert करने के लिए इसका उपयोग किया जाता है। Header Page के ऊपर Top 
Margin में जबकि Footer Page के नीचे Bottom Margin में लगाया जाता है (चित्र 3. 62)।

चित्र 3. 62
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8 Insert and use images in document

LibreOffice Writer में document में images 2 तरीको ंसे insert कर सकते हैं

1.	 insert menu  images option के साथ (चित्र 3. 63)।

2.	 Format toolbar में images option के साथ।

Libre Office Writer में document में images insert करने के steps

1.	 insert menu → images option के साथ (चित्र 3. 63)।

2.	 Format toolbar में images option के साथ।

	चि त्र 3. 63 	चि त्र 3. 64

Office Writer में document में images insert करने के steps

1.	 document को open करो।

2.	 Insert menu में Image option पर click करो या format toolbar में image      icon पर click 
करो (चित्र 3. 63) और (चित्र 3. 64)।

9. Insert Special Character

इस option का उपयोग हम किसी भी Special character को सम्मिलित करने के लिए कर सकते हैं

Step1: इन्सर्ट मेनू पर क्लिक करें  (चित्र 3. 65)|
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Step 2: विशेष वर्ण (special character) सम्मिलित करें  विकल्प का चयन करें |

 

चित्र 3. 65

Step 3: डायलॉग बॉक्स ओपन होगा (चित्र 3. 66)|

चित्र 3. 66

Step 4: किसी विशेष वर्ण का चयन करें |

Step 5: फिर इंसर्ट ऑप्शन पर क्लिक करें  (चित्र 3. 66)|
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अपनी प्रगति की जाँच:

1.	 ऑफिस लेखक (office writer) में विभिन्न प्रकार के पाठ संरेखण (text-alignment) को  
परिभाषित करें  |

2.	 दस्तावेज़ में शीर्ष लेख और पाद लेख (header and footer) सम्मिलित करने के चरण क्या हैं

3.	फ़ॉन्ट  शैली (font style) और फ़ॉन्ट आकार (font size) क्या है? इसे कैसे बदला जा सकता है

4.	 कॉलम विकल्प क्या है| हम पेज को दो कॉलम में कैसे फॉर्मेट कर सकते हैं?

4	 तालिकाएँ (table) बनाना और उनका उपयोग करना

लिब्रे ऑफ़िस राइटर में टेबल बनाने के लिए, टेबल ऑप्शन का इस्तेमाल किया जाता है. इस विकल्प की 
मदद से, अपनी ज़रूरत के मुताबिक़, रो (row) और कॉलम (column) की संख्या डालकर तालिका बनाई 
जाती है

Table: - इसमें निम्न विकल्प होते है–

चित्र 3. 67

Insert table: - इस विकल्प से इन्सर्ट टूल्स डायलाग बाक्स प्रदर्शित होता है जिससे हम अपनी 
आवश्यकतानुसार टेबल इन्सर्ट करते है व बनाते हैं (चित्र 3. 67)।

INSERT TABLE {CTRL + F12}: -
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सारणी बनाने के लिए इसका उपयोग किया जाता है। इसमे हम अपनी आवश्यकता अनुसार Rows and 
Columns की संख्या देकर Table बना सकते हैं (चित्र 3. 68)। जिनके बारे में नीचे बिस्तार पूर्वक बताया 
गया है-

चित्र 3. 68

Note: - Table में क्षैतिज ब्यवस्थापन को Rows तथा उर्ध्वाकार ब्यवस्थापन को Columns कहते हैं, जैसा 
की नीचे (चित्र 3. 69) में दर्शाया गया है-

चित्र 3. 69

Rows Above: -

Table में हमारा Cursor जिस Cell में होगा उसके ऊपर Rows Insert करने के लिए इसका उपयोग 
किया जाता है।

Note: - Cursor को Insertion point के नाम से भी जाना जाता है।

Rows Below: -

Table में हमारा Cursor जिस Cell में होगा उसके नीचे Rows Insert करने के लिए इसका उपयोग किया 
जाता है।

Rows: -
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अपनी इच्छानसार रो की संख्या देकर एक साथ कई Row Insert करने के लिए इसका उपयोग किया 
जाता है।

Columns Before: -

Table में हमारा कर्सर जिस कॉलम में होगा उस कॉलम के पहले कॉलम इन्सर्ट करने के लिए इसका 
उपयोग किया जाता है।

Columns After: -

टेबल में हमारा कर्सर जिस कॉलम में होगा उसके बाद एक कॉलम इन्सर्ट करने के लिए इसका उपयोग 
किया जाता है।

Columns: -

अपनी इच्छानसार कॉलम की संख्या देकर एक साथ कई कॉलम इन्सर्ट करने के लिए इसका उपयोग 
किया जाता है।

DELETE: -

बनाये गए टेबल में से Rows, Columns and Table को डिलीट करने के लिए इसका उपयोग किया जाता 
है। जैसा की आप नीचे (चित्र 3. 70) में देख सकते हैं-

चित्र 3. 70

SELECT: -

Cell, Row, Column and Table को सेलेक्ट करने के लिए इसका उपयोग किया जाता है। जैसा की आप 
नीचे (चित्र 3. 71) में देख सकते हैं-

चित्र 3. 71
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SIZE: -

Row Height and Column Width सेट करने के लिए इसका उपयोग किया जाता है। इसके अंतर्गत 
बिभिन्न बिकल्प दिए गए हैं, जैसा की आप नीचे (चित्र 3. 72) में देख सकते हैं-

चित्र 3. 72

MERGE CELLS: -

दो या दो से अधिक सेलेक्ट किये गए cells को एक में मिलाने के लिए इसका उपयोग किया जाता है। यह 
बिकल्प तभी कम करता है जब हम दो या दो से अधिक सेल सेलेक्ट करते हैं।

SPLIT CELLS: -

एक ही सेल को कई भागो में अर्थात कई सेल में बाटने के लिए इसका उपयोग किया जाता है।

MERGE TABLE: -

दो टेबल को एक में मिलाने के लिए इसका उपयोग किया जाता है।

SPLIT TABLE: -

एक टेबल को दो भागो में बाटने के लिए इसका उपयोग किया जाता है।

अपनी प्रगति की जाँच:

1.	 हम तालिका (table) कैसे बना सकते हैं, उदाहरण के साथ समझाएं |

2.	 तालिका (table) को कैसे हटाया (delete) जा सकता है?

3.	 मर्ज सेल (merge cell) और स्प्लिट सेल (split cell) में क्या अंतर है?
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5. दस्तावज़ (Document) प्रिंट करना

1 ऑफिस राइटर में प्रिंट विकल्प (Print option in office writer)

लिब्रे ऑफिस राइटर में, फ़ाइल मेन्यू में प्रिंट का विकल्प होता है. इस विकल्प का इस्तेमाल करके, बनाई 
गई फ़ाइल को प्रिंटर की मदद से प्रिंट किया जा सकता है. प्रिंट करने के लिए, Ctrl+P का इस्तेमाल किया 
जा सकता है.

a)	 Print preview (Ctrl + Shift + O): - इस विकल्प से फाइल या पेज का प्रिंट प्रिव्यू प्रदर्शित होता 
हैं। print preview में पेज जिस प्रकार प्रदर्शित होता है। पेपर पर भी वैसा ही प्रिंट प्राप्त होता है (चित्र 
3. 73)।

Click File Menu Print Preview

चित्र 3.73
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Close preview: - इस पर क्लिक करने से प्रिंट प्रिव्यू बंद होता है (चित्र 3. 74)।

चित्र 3. 74

b)	 Print Settings:

Print (Ctrl + P): - इससे प्रिंट डायलॉग बॉक्स प्रदर्शित होता है। जो निम्नवत् प्रदर्शित होता है (चित्र 3. 75)

चित्र 3. 75



Class IX : 2024-25

83

SC
ER

T D
EL

HI
Printer: - इस विकल्प से उस प्रिंटर का चयन करते हैं, जिससे प्रिंट लेना होता है (चित्र 3. 75)।

Range and Copies: - इसमें फाइल के पेजेज का चयन करने के लिए रेडियो बटन के विकल्प होते हैं।

•	 All pages: - बाई डिफाल्ट यह चयनित रहता है जिससे फाइल के सभी Pages का प्रिंट प्राप्त होता 
है।

•	 Pages: - इसका चयन करके फाइल के निश्चित पेज नम्बर वाले पेजेज (Pages) का प्रिंट प्राप्त करते 
हैं इसमें पेजेज का चयन करने के लिए hyphen (-) तथा Comma (,) चिन्हों का प्रयोग करते हैं। 
हाइफेन से पेज रैन्ज को दर्शाते हैं जैसे- 5 से 20 तक के पेजेज (Pages) को प्रिंट करने के लिए 5-20 
का प्रयोग करते हैं तथा अल्प-विराम चिन्हो का प्रयोग निश्चित पेज नम्बर के पेजेज को प्रिंट करने के 
लिए करते हैं। जैसे- 5, 21, 32, 35-40, 43 आदि।

•	 दोनो ं चिन्हों का एक साथ भी प्रयोग कर सकते हैं जैसा कि ऊपर के उदाहरण में दर्शाया गया है। 
नोट- इसक अतिरिक्त किसी चिन्हों का प्रयोग नही ंकरते हैं।

•	 Even pages: - इसका चयन करने पर फाइल सम स्थान के सभी पेजेज का प्रिंट प्राप्त किया जा 
सकता है। जैसे- 2, 4, 6, 8, ………….

•	 Odd pages: - इसका चयन करने पर फाइल के सभी विषम स्थान के पेजेज का प्रिंट प्राप्त होगा। 
जैसे- 1, 3, 5, 7, 9, ……

•	 Selection: – इसका चयन करन पर फाइल के चयनित टेस्ट का प्रिंट प्राप्त किया जा सकता है। 
इसमें दो विकल्प होते हैं।

1.	 Print in Only Side: - बाई डिफाल्ट यह विकल्प ही सेट रहता है। इससे पेपर के केवल एक सतह 
पर प्रिंट होता है। दूसरी तरफ नही।ं

2.	 Print in Both Sides: - इस विकल्प को सेट करने से पेपर के दोनो ंतरफ प्रिंट होता है।

Number of copies: - इस विकल्प से फाइल का प्रिंट करते समय नम्बर ऑफ कॉपी (प्रतियो ंकी संख्या) 
सेट कर सकते है बाई डिफॉल्ट 1 सेट रहता है। जिससे फाइल की एक प्रति तैयार होती है (चित्र 3. 75)।



84

lwpuk izkS|ksfxdh (Information Technology)

SC
ER

T D
EL

HI
चित्र 3.76

Page Layout: - इसमें विभिन्न आकार के पेपर के नामो ंकी लिस्ट होती है। जैसे- पत्र आकार, लीगल 
आकार, लेजर आकार, A1, A2, A3, A4, A5 आदि। बाई डिफॉल्ट लेटर साइज सेट रहता है। इसकी 
चौड़ाई 216 मिमी और लम्बाई 297 मिमी होती है। A1 पेपर की साइज की चौड़ाई 210 मिमी और लम्बाई 
297 मिमी होती है।

Orientation: -

1.	Portrait: पोर्ट्रे ट विकल्प से पेज पर टेक्स क्षैतिज लाइनो ं के 
रूप में प्रिंट होती है (चित्र 3. 77)।

2.	Landscape: लैंडस्के प विकल्प से पेज पर टेस्ट ऊर्ध्वाधर 
लाइनो ंके रूप में प्रिंट होता है (चित्र 3. 77)।

Pages per sheet: - इस विकल्प से प्रत्येक पेपर शीट पर 
फाइल के कितने पेजेज का प्रिंट आये इसे सेट करते हैं। बाई 
डिफॉल्ट 1 सेट रहता है।

Printer Setting: - इस विकल्प से उस प्रिन्टर का चयन करते हैं जिससे प्रिन्ट लेना है इससे प्रिंटर की 
प्रॉपर्टीज की भी बदल सकते हैं।

सभी सेटिग्स करने के बाद print button पर click करे।
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6.	 मेल मर्ज के माध्यम से दस्तावज़ (document) प्रिंट करें !

Word Processor, Mail Merge नामक एक tool उपलब्ध करता है, जिसका प्रयोग उस प्रकार के लैटर 
या एन्वेलोप को बड़ी संख्या में प्रिंट करने के लिए किया जाता है, जिनमे text तो एक सामान होते हैं; पर 
कुछ इनफार्मेशन जैसे- पत्र के धारक का नाम, उसका पता इत्यादि भिन्न-भिन्न होते हैं। इस प्रकार Mail 
Merge द्वारा हजारो पत्रों में type किये जाने वाले एक समान text के typing में लगाने वाले परिश्रम व 
समय दोनो ंकी बचत हो जाती है (चित्र 3.78)।

लिब्रे ऑफिस राइटर में मेल मर्ज का उपयोग करने के लिए नीचे दिए गए स्टेप्स का पालन करें :

Go to Tools Menu Tools

चित्र 3.78

Step 1: लिब्रे ऑफिस राइटर खोलें और मेल मर्ज शुरू करें  (चित्र 3. 79):

 

चित्र 3.79
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Step 4: मेल मर्ज विजार्ड शुरू करें :

Tools -> Mail Merge Wizard पर जाएँ ताकि मेल मर्ज विजार्ड खुले।

मेल मर्ज विजार्ड डायलॉग में, आपके दस्तावेज़ के रूप में कौन सा प्रकार का दस्तावेज़ बनाना चाहते हैं 
(पत्र, ईमेल, आदि) इसे चुनें और "अगला" (next) पर क्लिक करें  (चित्र 3. 79)।

Step 5: प्रारंभिक दस्तावेज़ का चयन करें : "Use the current document" विकल्प को चुनें और "अगला" 
पर क्लिक करें  (चित्र 3. 80)।

चित्र 3.80

Step 6: डेटा सोर्स सेटअप:

 

चित्र 3.81



Class IX : 2024-25

87

SC
ER

T D
EL

HI
आपके डस्तावेज़ में से उपयोग करना चाहते हैं तो "Use the current address book" विकल्प को चुनें 
और "अगला" पर क्लिक करें । या हम नई पता सूची भी बना सके है (चित्र 3.82)

चित्र 3.82

Step 7: फ़ील्ड् को संरचित करें :

यह सत्यापित करें  कि आपके दस्तावेज़ में फ़ील्ड्स आपके डेटा सोर्स के उचित फ़ील्ड्स के साथ मेल खाते 
हैं। आगे बढ़न के लिए "अगला" पर क्लिक करें ।

Step 8: मेल मर्ज पूरा करें : मेल मर्ज विजार्ड सारांश में जानकारी की समीक्षा करें ।

मेल मर्ज को पूरा करने के लिए "समाप्त" पर क्लिक करें ।

Step 9: पूर्वावलोकन और मर्ज किए गए दस्तावेज़ को सहेजें:

मेल मर्ज टूलबार दिखाई देगी। प्रत्येक रिकॉर्ड को पूर्वावलोकन करने के लिए "Next Record" और 
"Previous Record" बटन पर क्लिक करें ।

जब आप संतुष्ट हो जाएँ, "Save Merged Document" बटन पर क्लिक करके मर्ज किए गए दस्तावेज़ 
को नए फ़ाइल के रूप में सहेजें।

स्टेप 10: मेल मर्ज बंद करें :

जब आप काम खत्म करें , मेल मर्ज विजार्ड और डेटा सोर्सेज पैन बंद करें ।
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अब आपने सफलतापूर्वक लिब्रे ऑफिस राइटर में मेल मर्ज किया है, जिससे आपने डेटा सोर्स से व्यक्तिगत 
दस्तावेज़ बनाए हैं।

गतिविधि (Activity):

1.	 मेल मर्ज (mail merge) ऑप्शन क्या होता है

2.	 मेल मर्ज का उपयोग करने के लिए चरण लिखें?

 महत्वपूर्ण iz'u 

A.	 बहुविकल्पीय iz'u

निम्नलिखित में से LibreOffice Writer के कौनसे अनुभाग में नया दस्तावेज़ बनाया जा सकता है?

a)	 File							       b) Edit

c)	 View						      d) Insert

उत्तर: a) File

LibreOffice Writer में टेक्स्ट को बोल्ड करने के लिए कौनसा कीबोर्ड शॉर्टकट होता है?

a)	 Ctrl + B						     b) Ctrl + I

c)	 Ctrl + U						     d) Ctrl + L

उत्तर: a) Ctrl + B

टेक्स्ट की पैराग्राफ स्टाइल कैसे बदली जाती है LibreOffice Writer में?

a)	 Edit > Paragraph				    b)	 Format > Paragraph

c)	 Insert > Paragraph				    d)	 Tools > Paragraph

उत्तर: b) Format > Paragraph
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LibreOffice Writer में छवियो ंको डॉक्यूमेंट में डालने के लिए कौनसा ऑप्शन होता है?

a)	 Insert > Image				    b) Format > Picture

c)	 Tools > Image					    d)	 Edit > Picture

उत्तर: a) Insert > Image

डॉक्यूमेंट को सेव करने के लिए कौनसा ऑप्शन होता है LibreOffice Writer में?

a)	 File > Save As					    b)	 File > Save

c)	 File > Export					     d)	 File > Print

उत्तर: b) File > Save

टेक्स्ट को हटाने के लिए कौनसा कंुजी संविदा LibreOffice Writer में?

a)	 Delete						      b)	 Backspace

c)	 Shift						      d)	 Ctrl

उत्तर: b) Backspace

LibreOffice Writer में स्पेलिग और ग्रामर की जाँच के लिए कौनसा ऑप्शन होता है?

a)	 Tools > Check Spelling and Grammar	 b) Format > Spell Check

c)	 View > Spelling Check			   d) Edit > Check Grammar

उत्तर: a) Tools > Check Spelling and Grammar

टेक्स्ट लाइन के बीच रिक्ति कैसे दी जाती है LibreOffice Writer में?

a)	 Enter						      b) Tab

c)	 Space						      d) Shift

उत्तर: b) Tab
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टेक्स्ट की बॉक्स कैसे बनाई जाती है LibreOffice Writer में?

a)	 Insert > Text Box				    b) Format > Text Box

c)	 Tools > Text Box				    d)	 View > Text Box

उत्तर: a) Insert > Text Box

LibreOffice Writer में नया डॉक्यूमेंट किस फॉर्मेट में बनाया जाता है?

a)	 .docx						      b) .odt

c) 	 .pdf							      d) .txt

उत्तर: b) .odt

बी. रिक्त स्थान भरें

1.	 LibreOffice Writer में नया दस्तावेज़ बनाने के लिए हमे _________________ मेनू का उपयोग करना 
होता है।

	 उत्तर: फ़ाइल (File)

2.	 टेक्स्ट को बोल्ड करने के लिए _________________ कंुजी दबाएं।

	 उत्तर: Ctrl + B

3.	 टेक्स्ट को _________________ के बीच रिक्ति देने के लिए Tab कंुजी का उपयोग किया जाता है।

	 उत्तर: पैराग्राफ (Paragraph)

4.	 डॉक्यूमेंट को सेव करने के लिए _________________ मेनू का उपयोग किया जाता है।

	 उत्तर: फ़ाइल (File)

5.	 टेक्स्ट को हटाने के लिए _________________ कंुजी दबाएं।

	 उत्तर: Backspace
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6.	स्पेलि ग और ग्रामर की जाँच के लिए _________________ मेनू का उपयोग किया जाता है।

	 उत्तर: टूल्स (Tools)

7.	 टेक्स्ट की बॉक्स बनाने के लिए _________________ मेनू का उपयोग किया जाता है।

	 उत्तर: इंसर्ट (Insert)

8.	 Libre Office Writer में नए डॉक्यूमेंट को सहेजने का डिफ़ॉल्ट फॉर्मेट _________________ होता है।

	 उत्तर: .odt

9.	 स्प्रेडशीट को इंजर्ट करने के लिए _________________ मेनू का उपयोग किया जाता है।

	 उत्तर: इंसर्ट (Insert)

10.	 Libre Office Writer में एक समय में _________________ डॉक्यूमेंट्स खोले जा सकते हैं।

	 उत्तर: एक

C.  लघु उत्तरीय iz'u (50 शब्द)

11.	 Libre Office Writer में नया दस्तावेज़ बनाने के लिए कौनसे कदम अनुसरण किए जाते हैं? इन 
कदमो ंका विस्तार से वर्णन करें ।

	 उत्तर: नया दस्तावेज़ बनाने के लिए, पहले Libre Office Writer सॉफ़्टवेयर को खोलें। फिर 
"फ़ाइल" मेनू पर क्लिक करें , और फिर "नया" विकल्प का चयन करें । इसके बाद "टेक्स्ट दस्तावेज़" 
को चुनें। यह आपके लिए एक नया डॉक्यूमेंट खोलेगा।

12.	 Libre Office Writer में टेक्स्ट को बोल्ड कैसे किया जाता है? इसकी विधि को विस्तार से समझाएं।

	 उत्तर: टेक्स्ट को बोल्ड करने के लिए, पहले उस टेक्स्ट को सिलेक्ट करें  जिसे आप बोल्ड करना 
चाहते हैं। फिर "Ctrl + B" कीबोर्ड शॉर्टकट या "फ़ॉर्मेट" मेनू में जाकर "बोल्ड" ऑप्शन का चयन 
करें ।
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13.	 Libre Office Writer में डॉक्यूमेंट को सहेजने के लिए कौनसे चरणो ंका पालन किया जाता है? इन 

चरणो ंका विवरण दें।

	 उत्तर: डॉक्यूमेंट को सहेजने के लिए, पहले "फ़ाइल" मेनू पर क्लिक करें । फिर "सहेजें" विकल्प 
का चयन करें । यदि आप नया डॉक्यूमेंट बना रहे हैं, तो आपको फ़ाइल नाम और स्थान चुनन का 
अनुरोध किया जाएगा। इसके बाद "सहेजें" बटन पर क्लिक करें ।

14.	 Libre Office Writer में स्पेलिग और ग्रामर की जाँच कैसे की जाती है? इसका विवरण दें।

	 उत्तर: स्पेलिग और ग्रामर की जाँच करने के लिए, "टूल्स" मेनू में जाएं और "चेक स्पेलिग और 
ग्रामर" विकल्प का चयन करें । यह एक स्पेलिग और व्याकरण विडो खोलेगा जिसमें आपको 
गलतियो ंके लिए सुझाव दिए जाएंगे।

15.	 Libre Office Writer में टेक्स्ट बॉक्स कैसे बनाया जाता है? इसकी प्रक्रिया को विस्तार से समझाएं।

	 उत्तर: टेक्स्ट बॉक्स बनाने के लिए, "इंसर्ट" मेनू में जाएं और "टेक्स्ट बॉक्स" विकल्प का चयन करें । 
फिर, आपको डॉक्यूमेंट में बॉक्स की आकार और स्थान चुनन का विकल्प मिलेगा। जब आप ठीक 
से चयन कर लें, तो टेक्स्ट बॉक्स आपके दस्तावेज़ में जोड़ दिया जाएगा।

vvv
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विद्यार्थी-

•	 स्प्रेडशीट में शीट तैयार करने, उसे सुरक्षित करने और खोलने का कौशल अर्जित करते हैं।

•	 शीट में फार्मूला, डायरी टेक्स्ट, संख्याएँ प्रविष्ट करते हैं।

•	 शीट में और वर्क बुक की विभिन‍न शीरो ंके बीच भी नेवीगेट करते हैं।

•	 शीट में सेल (Cell) (प्रकोष्ठ), पंक्ति (Row) और कॉलम (Column) अंतः स्थापित करने व उन्हें पूर्णतः 
हटाने का कौशल अर्जित करते हैं।

•	 वर्क शीट में सेल (Cell) डाटा का चयन करने में कापी करके पेस्ट करने और इसे पूर्णतः  हटाने में 
सक्षम होते हैं।

•	 स्प्रेडशीट में दिए गए विभिन‍न सूत्रों और अन्तर्निहित (Inbuilt) कार्यों का प्रयोग करते हैं।

•	 स्पेलिग जाँच और स्वतः  सुधार (Autocorrect) जैसे विशेष उपकरणो ंके प्रयोग से त्रुटिरहित शीट 
तैयार करते हैं।

•	 पेज सेटअप तथा वांछित पेपर पर मुद्रित करने का कौशल दर्शाते हैं।

•	 वर्क शीट में समग्र अथवा चयनित डाटा को फार्मेट करने में सक्षम होते हैं। 

•	 शैली (styles) परिभाषित करने और प्रयुक्त करने में समझ दर्शाते हैं।

•	 चार्टों के प्रयोग द्वारा वर्क शीटो ंको बेहतर बनाते हैं।

परिचय (Introduction)

अपने दैनिक जीवन में, हम कई बार सारणीबद्ध रूप में लिस्ट(List) की सूची देखते हैं। उदाहरणार्थ, 
खरीदारी के बिल, वार्षिक रिपोर्ट कार्ड अथवा क्रिकेट मैच का स्कोर कार्ड। पंक्ति (Row) और कॉलम 
(Column) वाली इन सारणियो ंको स्प्रेडशीट कहते हैं। यदि हमें क्रिकेट सीरीज में भारतीय टीम के प्रदर्शन 
के लिए डाटा को सारणीबद्ध करना हो, उसका विश्लेषण करना हो और हमारे पाठ्यक्रम मूल्यांकन के अंश 

इकाई-4 
इलेक्ट् रॉनिक स्प्रेडशीट
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के रूप में परियोजना जमा करनी हो, तो हम शायद एक चार्ट पेपर लेंगे, परियोजना को डिजाइन करें गे 
और रिपोर्ट लिखेंगे तथा इसे जमा कर दें गे। हमने हमेशा से ऐसे ही किया है। परियोजना में शृंखला के सभी 
पहलू शामिल हो सकते हैं लेकिन हम इससे संतुस्ट नही ंहो पाएंगे। क्योंक�ि परियोजना रिपोर्ट स्थिर है। हम 
इस पेपर रिपोर्ट से गतिशील विश्लेषण नही ंकर सकते। फिर हम अपने दर्शको ंको कैसे आकर्षित करें गे? 
इलेक्ट् रॉनिक स्प्रेडशीट की दुनिया में आपका स्वागत है, जहाँ पर हम यह सब और इससे भी अधिक कर 
सकते हैं। आइए देखते हैं कैसे?

स्प्रेडशीट (Spreadsheet)

स्प्रेडशीट (Spreadsheet) एक ग्रिड है जो पंक्ति (Rows) और कॉलम (Columns) में डेटा (Data) को 
अंतः क्रियात्मक रूप (Interactively) से प्रबंधित (Managing) और व्यवस्थित (Organizes) करती है। इसे 
इलेक्ट् रॉनिक स्प्रेडशीट (Electronic Spreadsheet) भी कहा जाता है। यह डेटा (Data) को संग्रहीत(Store), 
हेरफेर(Manipulate) और ग्राफिकल प्रतिनिधित्व (Graphical Representations) भी बना सकता है।

चित्र 4.1

डिजिटल स्प्रेडशीट आंकड़े एक बहुत बड़ी शीट होती है जिसमें और सूचना व्यवस्थित होते हैं। कई 
पंक्तियो(ंRows) और कॉलमो ं में कई प्रकार के स्प्रेडशीट कार्यक्रम उपलब्ध हैं; कुछ पेटेंट होते हैं जैसे 
माइक्रोसॉफ्ट, लोटस 123 आदि, कुछ निः शुल्क/ खुले स्रोत के होते हैं जैसे ग्नोम ऑफिस स्प्रेडशीट 
जीन्यूमेरिक, ऑफिस केस्प्रेड, ऑपेन ऑफिस. ओआरजी कैल्क/ स्प्रेडशीट्स, इन्हें वर्क शीट्स भी कहा 
है। डाटा, सेल (CELL) (प्रकोष्ठ) में प्रविष्ट किया जाता है जो पंक्ति (ROW) और कॉलम (COLUMN) के 
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विच्छे दन को दर्शाता है। स्प्रेडशीट की सबसे बड़ी विशेषता यह है कि यदि स्रोत आँकड़ों में परिवर्तन हो 
जाता है तो यह स्वत: ही गणितीय सूत्रों के परिणाम की पुन: गणना कर लेता है। स्प्रेडशीट हमारी बड़ी संख्या 
में संख्यात्मक सूचना को तत्काल रिकॉर्ड करने, उसे प्रबंधित करने और कई प्रकार से अन्य के साथ बांटने 
में सहायता करती है। चंूकि Libra Offce Calc जो, Libra Offce का अभिन्न अंग है, में ये सभी विशेषताएँ 
और अन्य कई भी है, इसलिए हमने इसे स्प्रेडशीट कार्यक्रम के रूप में लिया है।

इसका उपयोग वित्तीय (Financial) और लेखांकन (Accounting) दस्तावेजो ं (Documents) को 
प्रबंधित(Managing) करने, डेटा (Data) रिपोर्ट बनाने, चालान तैयार करने और डेटा (Data) पर विभिन्न 
(Variety) प्रकार की गणना (Calculations) करने आदि के लिए किया जाता है।

स्प्रेडशीट (Spreadsheet) के लाभ:

स्प्रेडशीट (Spreadsheet) सॉफ़्टवयर (Software) के विभिन्न (Variety) लाभ हैं-

1.	 एक स्प्रेडशीट सॉफ़्टवेयर (Spreadsheet Software) डेटा (Data) का ग्राफिकल (Graphical) 
प्रतिनिधित्व (Representations) बना सकता है।

2.	 इसका उपयोग निर्णय लेने के लिए डेटा (Data) की गणना (Calculate) और विश्लेषण (Analyze) 
करने के लिए किया जा सकता है।	

3.	 यह सामान्य गणितीय (Mathematical), वित्तीय (Financial), सांख्यिकीय (Statistical) संचालन के 
लिए अंतर्निहित सूत्र और फ़ं क्शन भी प्रदान करता है।

4.	 इसका व्यापक रूप से डेटा (Data) विश्लेषण (Analyze) और लेखांकन (Accounting) अनुप्रयोगो ं
के लिए उपयोग किया जाता है।

स्प्रेडशीट (Spreadsheet) सॉफ़्टवयर (Software) के कुछ उदाहरण हैं

1.	 Microsoft Excel

2.	 Libre Office Calc

3.	 Open Office Calc

4.	 Apple Inc. Numbers

स्प्रेडशीट कार्यक्रम आरंभ करना (Starting Spreadsheet Function)

स्प्रेडशीट आरंभ करने के लिए निम्न चरणो ंका अनुपालन करें  –
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ओपनऑफिस कैल्क खोलने के लिए, आप यह कर सकते हैं:�

1)	नी ले ओपनऑफिस आइकन का चयन करें

2)	 स्प्रेडशीट आइकन पर क्लिक करें

3)	फ़ा इल पर क्लिक करें

4)	न या चुनें

5)	 स्प्रेडशीट का चयन करें

आप स्टार्ट सेंटर से एक नई स्प्रेडशीट भी बना सकते हैं।

https://www.youtube.com/watch?v=vioDZvlFhMg

स्प्रेडशीट के मूल तत्व (Fundamentals of Spreadsheet)

वर्क बुक और वर्क शीट (Worksheet or Workbook)

प्रत्येक स्प्रेडशीट फाइल को वर्क बुक कहते हैं और इसे .ods के डिफ़ॉल्ट एक्सटेंशन में संचित किया 
जाता है। प्रत्येक वर्क बुक में कई शीट होती हैं इसलिए एक फाइल में विभिन्न प्रकार की संबंधित जानकारी 
व्यवस्थित की जा सकती है। प्रत्येक वर्क बुक में 255 वर्क शीट होती है, लेकिन डिफ़ॉल्ट के कारण एक बार 
में केवल तीन ही दिखाई देती हैं। वर्क शीट वह क्षेत्र है जहां डाटा संचित किया जाता है और कार्य किया 
जाता है। जब भी आवश्यक हो अतिरिक्त वर्क शीट जोड़ी जा सकती है।

पंक्ति (ROW), कॉलम (COLUMN) और सेल (CELL)

वर्क शीट में पंक्तियो ं(ROWS) की वर्क शीट के बाएँ कॉलम (COLUMN) के साथ ऊपर से नीचे काउंट  की 
जाती है। कॉलम (COLUMN) बाँएं से दाएं  अक्षरो ंसे नामित होते हैं। Libra Office Calc में कुल 1048576 
पंक्तियाँ (ROWS)  और 16384 (Col A to XFD) कॉलम (COLUMN) होते हैं। पंक्तियो ं(ROWS) को 1 से 
1048576 तक क्रम में रखा जाता है। सेल (CELL), पंक्ति (ROW) और कॉलम (COLUMN) का विच्छे दन 
हैं। सेल (CELL) की पहचान पते से की जाती है जिसमें कॉलम (COLUMN) का नाम और उसके बाद पंक्ति 
(ROW) की संख्या होती हैं। उदाहरणार्थ, पहले सेल (CELL) को A1 कहा जाता है, जो दर्शाता है कि यह 
कॉलम (COLUMN) A और पंक्ति (ROW) के विच्छे दन पर स्थित है। यह सक्रिय सेल (CELL) है। सक्रिय 
सेल (CELL) किसी भी कार्यवाही अथवा इनपुट को स्वीकार करने के लिए तैयार होता है। चुने हुए सेलो ंका 
छोटा समूह रेंज होता है। रेंज को इसमें सेल (CELL) को आरंभ करने का पता, सेल (CELL) को बंद करने 
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का पता अथवा प्रतिमोलत: (Reciprocate) लिखकर संदर्भित किया जाता है। उदाहरणार्थ A1 : A10 (इसे 
A10 : A1 भी कहा जा सकता है)

वर्क शीट में नेवीगेट करना (Navigating in Worksheet)

वर्क शीट में नेवीगेट करने के लिए कर्सर की (Key), माउस और स्क्रॉल बार का उपयोग किया जा सकता 
है। लेकिन इन तकनीको ंका उपयोग करके 1048576 पंक्तियो ं(ROWS) और 16384 (Col A to XFD) 
कॉलमो ंमें नेवीगेट करना बहुत कठिन है। किसी सेल (CELL) से पूरी वर्क शीट को स्क्रॉल किए बिना सीधे 
जाने के लिए निम्न में से किसी एक शार्टकट विधि का उपयोग किया जा सकता है-

विधि 1 – की मिश्रण (Key Mixture) के उपयोग द्वारा विधि

विधि  2 – नाम बॉक्स के उपयोग द्वारा

1.	न ाम बॉक्स में सेल (CELL) का पता टंकित(Type) करें

2.	 वांछित सेल (Desired CELL) तक जाने के लिए एंटर दबाएँ। उदाहरणार्थ, सेल (CELL) D6 में जाने 
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के लिए नाम बॉक्स में D6 लिखें और एंटर दबाएँ। कर्सर सेल (CELL) में D कॉलम (COLUMN) और 
6वी ंपंक्ति (ROW) पर स्थित होता है।

वर्क शीट के बीच नेवीगेट करना (Navigating between Worksheets)

वर्क शीटो ंके बीच आने जाने के लिए, स्क्रीन के नीचे बाएँ कोने में शीट संख्या पर क्लिक करें  (चित्र 4.2)। 
यदि वर्क शीटो ंकी संख्या निर्दर्शि त की जाने वाली संख्या से अधिक है तो शीट संख्या के साथ स्थित टैब 
स्क्रॉलिग बटनो ंका उपयोग करें  और फिर चयन करने के लिए शीट संख्या पर क्लिक करें ।

चित्र 4.2

वर्क बुक खोलना (Opening Workbook)

वर्क बुक खोलने के लिए-

1.	 फाइल मेन्यू से Open विकल्प चुनें अथवा स्टैंडर्ड टूलबार पर Open बटन पर क्लिक करें ।

2.	 निर्देश�ि का का चयन करें  जिसमें फाइल सुरक्षित की गई है।

3.	 फाइल नामक फील्ड में फाइल का नाम टंकित(Type) करें  अथवा इस पर क्लिक कर नाम का चयन 
करें ।

4.	 ओपन पर क्लिक करें ।

वर्क बुक संचित करना (Saving Workbook)

वर्क बुक संचित करने के लिए

1.	 फाइल मेन्यू से Save As विकल्प चुनें अथवा स्टैंडर्ड टूलबार पर Save बटन पर क्लिक करें  अथवा 
Close बटन पर क्लिक कर वर्क बुक को बंद करें । Save As वार्ता बॉक्स स्क्रीन पर आ जाएगा।
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2.	 निर्देश�ि का चुनें जिसमें फाइल सुरक्षित करनी है।

3.	 फाइल नाम टेक्स्ट बॉक्स में फाइल का नाम टंकित(TYPE) करें ।

4.	 संचित करें  सेव पर क्लिक करें ।

सूत्रों और कार्यों के उपयोग द्वारा (By using Formulas and Functions)

सूत्र समीकरण वाली प्रविष्टियाँ होती हैं जो निर्देश�ि त किए जाने वाले मानो ं की गणना करती हैं। कृपया 
याद रखें कि सूत्रों के साथ कार्य करते हुए संख्या टॉकित न करें  लेकिन समीकरण टंकित (TYPE) 
करें । इस समीकरण का इसमें दिए गए किसी आंकड़े में परिवर्तन अथवा आंकड़े की प्रविष्टि पर स्वत: 
अद्यतन(Updates) हो जाएगा।

सूत्र प्रविष्ट करना (Entering Formulas)

वर्क शीट में सेल (CELL) में सूत्र भी हो सकते हैं जो गणना करने में सहायक होते हैं। सूत्र गणितीय समीकरण 
होते हैं। वे दो या अधिक सेलो ं के बीच संबंध स्थापित करने में सहायक होते हैं। उनमें सेल (CELL) के 
समवर्ग होते हैं जिनके उपयोग से सूत्र का परिणाम आ जाता है। सूत्र " = " चिन्ह से आरम्भ होना चाहिए 
अन्यथा इसे टेक्स्ट प्रविष्टि माना जाता है।

Note: जब किसी सेल (CELL) के मान को परिवर्तित किया जाता है, यह किसी सूत्र के मान की 
स्वत: गणना कर लेता है और इसे संगत सेल (CELL) में प्रदर्शित कर देता है।

अंकगणितीय प्रचालको ंके उपयोग द्वारा

जब सेल (CELL) में संख्याओ ंकी प्रविष्टी की जाती है तो उनके उपयोग द्वारा गणितीय गणनाएँ करना संभव 
होता है। स्प्रेडशीट्स में कई गणितीय कार्य पहले से ही निर्मित होते हैं। सर्वाधिक उपयोग किए जाने वाले 
मूल प्रचालन जोड़, घटाना व गुणा और भाग हैं। जोड़न के लिए निम्न चरणो ंका अनुपालन करें  –

1.	 सेल (CELL) A1 पर कर्सर ले जाएं। टंकित (TYPE) करें ।

2.	 सेल (CELL) A2 पर जाने के लिए ENTER दबाएँ। सेल (CELL) A में 1 टंकित (TYPE) करें ।

3.	 सेल (CELL) A3 पर जाने के लिए ENTER दबाएँ।

4.	 सेल (CELL) A3 में टंकित (TYPE) करें  = A1+ A2 नोट करें  कि सेल (CELL) A1 और A2 की सामग्री 
जोड़ दी गई है और परिणाम A3 में दर्शाया गया है |
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सेल (CELL) A3 के टंकित सूत्र में केवल परिवर्तन करके अन्य गणितीय प्रचालन करने के लिए समान चरणो ं
का अनुपालन किया जा सकता है।

स्वत: जोड़ के उपयोग

संख्याओ ंका जोड़ करना सर्वाधिक उपयोग की जाने वाली क्रिया है। अतः  टूलबार बटन, स्वत: जोड़, इस 
कार्य को करने के लिए उपलब्ध कराया गया है। स्टैंडर्ड टूलबार पर स्वतः  जोड़ बटन गंतव्य सेल (CELL) 
के ऊपर अथवा गंतव्य सेल (CELL) के बाएं ओर के मानो ंको स्वतः  जोड़ देता है। इसका ब्यौरा निम्न चरणो ं
में दिया गया है-

1.	 गंतव्य सेल अर्थात् जिस सेल (CELL) में परिणाम प्रदर्शित किया जाना है, पर क्लिक करें ।

2.	 स्वत: जोड़ बटन पर क्लिक करें , जो स्टैंडर्ड टूलबार पर है। जोड़े जाने वाली संख्याओ ंके सेल (CELL) 
स्वत: अब रेखांकित हो जाते हैं।

3.	 गंतव्य सेल (CELL) में परिणाम देखने के लिए ENTER दबाएँ।

लिब्रे ऑफिस कैल्क (Libre office Calc) : इसका उपयोग निम्नलिखित गतिविधि (ACTIVITY)यो ंको सटीक 
और कुशलतापूर्वक करने के लिए किया जाता है।

1.	 डेटा (Data) का सारणीकरण।

2.	 सरल गणितीय (Mathematical) गणना (Calculations) ।

3.	 सूत्र और फ़ंक्शं स का उपयोग करके जटिल गणनाएँ(Calculations)।

4.	 आँकड़ों को आरोही एवं अवरोही क्रम में व्यवस्थित करना।

5.	 आवश्यक डेटा (Data) फ़िल्टर करना।

6.	 डेटा (Data) की वैधता की जाँच करें ।

7.	 पासवर्ड का उपयोग कर डेटा (Data) की सुरक्षा।

8.	 भविष्य में उपयोग के लिए संचित करना।

शुरुआत लिब्रे ऑफिस कैल्क (Starting Libre Office Calc):

लिब्रे ऑफिस कैल्क (Libreoffice Calc) लिब्रे ऑफिस सूट का स्प्रेडशीट (Spreadsheet) एप्लिकेशन 
है। लिनक्स (उबंटू) ऑपरेटिग सिस्टम में, लिब्रे ऑफिस डिफ़ॉल्ट रूप से इंस्टॉल हो जाता है। विडोज़ में, 
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आपको लिब्रे ऑफिस को इसकी आधिकारिक वेबसाइट से डाउनलोड करना होगा और इसे अपने कंप्यूटर 
पर इंस्टॉल करना होगा।

विडो में लिब्रे ऑफिस कैल्क खोलने के चरण: विडोज़ में, स्टार्ट मेनू पर या डेस्कटॉप पर लिब्रे ऑफिस का 
शॉर्टकट ढंूढें। लिब्रे ऑफिस खोलने के लिए शॉर्टकट पर डबल क्लिक करें । या विडो मेनू पर क्लिक करें , 
लिब्रे ऑफिस एप्लिकेशन चुनें, फिर लिब्रे ऑफिस कैल्क (Libre office Calc) पर क्लिक करें ।

लिनक्स में लिब्रे ऑफिस कैल्क खोलने के चरण:

उबंटू लिनक्स में, एप्लिकेशन लॉन्चर पर कैल्क आइकन ढंूढें  या "एप्लिकेशन दिखाएं" पर क्लिक करके 
इसे खोजें।

लिब्रे ऑफिस कैल्क (Libreoffice Calc) के भाग:

निम्नलिखित चित्र लिब्रे ऑफिस कैल्क के भागो ंको दर्शाता है। भागो ंके बारे में संक्षिप्त विवरण नीचे दिया 
गया है।
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A. 	 Title Bar: शीर्ष पर स्थित शीर्षक पट्टी (Title Bar), वर्तमान स्प्रेडशीट (Spreadsheet) का नाम 

दिखाती है। पहली बनाई गई स्प्रेडशीट (Spreadsheet) का नाम अन्टाइटल्ड 1 है, दूसरे का नाम 
अन्टाइटल्ड 2 है और इसी तरह आगे भी।

B.	 Menu Bar: मेनू बार टाइटल बार के ठीक नीचे स्थित होता है। इसमें विभिन्न (Variety) कार्यों के 
लिए कमांड वाले मेनू शामिल हैं।

C.	 Toolbars: कैल्क डिफ़ॉल्ट रूप से कार्यस्थान के शीर्ष पर मानक और फ़ॉर्मेट�िग टूलबार के साथ 
खुलता है। ये टूलबार सामान्य कमांड और फ़ंक्शं स की एक विस्तृत श्रृंखला प्रदान करते हैं। किसी भी 
आइकन पर माउस कर्सर रखने से एक छोटा बॉक्स प्रदर्शित होता है जिसे टूलटिप कहा जाता है।

D.	 Worksheet: कैल्क में वर्क शीट को स्प्रेडशीट (Spreadsheet) भी कहा जाता है। स्प्रेडशीट 
(Spreadsheet) में कई शीट हो सकती हैं. प्रत्येक शीट में Rows और Columns में व्यवस्थित कई 
अलग-अलग सेल हो सकते हैं। शीट टैब अपना डिफ़ॉल्ट नाम शीट1, शीट2, शीट3,… दिखाता है।

E.	 Rows And Columns: शीट को ऊर्ध्वाधर कॉलम (Vertical Columns) और क्षैतिज पंक्ति 
(Horizontal Rows) में विभाजित किया गया है। प्रत्येक शीट में अधिकतम 1,048,576 (220) पंक्तियाँ 
और 1024 (210) कॉलम हो सकते हैं। Rows को 1,2,3,4,… के रूप में क्रमांकित किया गया है और 
Columns को A, B, C, D,…., Z, Aa, Ab, Ac,…., A Z… के रूप में क्रमांकित किया गया है।

F. 	 Cell And Cell Address: पंक्ति और कॉलम के प्रतिच्छे दन को सेल कहा जाता है। यह स्प्रेडशीट 
(Spreadsheet) का मूल तत्व है। इसमें डेटा (Data) होता है, जैसे- टेक्स्ट, संख्याएँ, सूत्र इत्यादि। एक 
सेल का पता उसके कॉलम (अक्षर) और पंक्ति संख्या द्वारा दर्शाया जाता है। उदाहरण के लिए- D4, 
E9, Z89 सेल एड्रेस के मान्य उदाहरण हैं।

G.	 Active Cell:  जब हम किसी सेल पर क्लिक करते हैं तो वह चयनित हो जाता है, और उपयोग  
(Managing)कर्ता से डेटा (Data) लेने के लिए तैयार हो जाता है। इस चयनित सेल को सक्रिय सेल 
कहा जाता है। इसे हमेशा मोटे बॉर्डर के साथ हाईलाइट किया जाता है।

कंुजी या कंुजी संयोजन कंुजी या संयोजन का परिणाम

तीर कंुजियाँ ) एकल सेल को तीर की दिशा में ले जाएँ

Ctrl+तीर कंुजी(Arrow Keys) सेल को एक विशेष दिशा में डेटा (Data) रेंज के अंत तक ले जाता है

घर (Home) पंक्ति के साथ कॉलम A में ले जाया जाता है जहां सक्रिय सेल है

Ctrl + होम(Home) सेल को A1 स्थिति में ले जाता है
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Ctrl + समाप्ति (End) डेटा (Data) रेंज के निचले दाएं सेल में ले जाता है

पेज अप (Page Up) वर्क शीट को एक स्क्रीन ऊपर ले जाता है

पेज नीचे (Page Down) वर्क शीट को एक स्क्रीन नीचे ले जाता है

गतिविधि (Activity) संख्या 1:-

1.	नि म्नलिखित का सेल पता (Cell Address) लिखें.

•	 पहली पंक्ति और पहला कॉलम _______________

•	 पहला कॉलम और आखिरी पंक्ति _______________

•	 पहली पंक्ति और अंतिम कॉलम _______________

•	 अंतिम कॉलम पहली पंक्ति ___________________

•	 सातवां कॉलम और दसवी ंपंक्ति _____________

•	 दसवां कॉलम और उन्नीसवी ंपंक्ति ____________

•	 सेल पता LK89 पंक्ति संख्या ______________ और कॉलम अक्षर ______________ में स्थित है

गतिविधि (Activity) का समाधान:

•	 पहली पंक्ति और पहला कॉलम A1 

•	 पहला कॉलम और अंतिम पंक्ति A1048576 

•	 पहली पंक्ति और अंतिम कॉलम XFD1 

•	 सातवां कॉलम और दसवी ंपंक्ति G10 

•	 दसवां कॉलम और उन्नीसवी ंपंक्ति J19 

•	 सेल पता LK89 पंक्ति संख्या 89 और कॉलम अक्षर LK में स्थित है
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सेल्स (Cells) की रेंज:

किसी वर्क शीट में चयनित (Selected) सेल्स (Cells) का एक ब्लॉक जिसे हाइलाइट किया गया है या चुना 
गया है, उसे सेल्स (Cells) की रेंज कहा जाता है ।

कॉलम श्रेणी कॉलम में फैली सेल्स (Cells) की संख्या है। सेल का पता एक क्रम में एकल कॉलम अक्षर 
और एकाधिक पंक्ति संख्या द्वारा दर्शाया जाता है। उदाहरण के लिए- C1 : C6, A9 : A18 आदि

पंक्ति श्रेणी पंक्ति में फैली सेल्स (Cells) की संख्या है। सेल का पता विभिन्न (Variety) कॉलमो ं के साथ 
एकल पंक्ति संख्या द्वारा दर्शाया जाता है। उदाहरण के लिए C5 : H5, A2 : J2 आदि।

पंक्ति और कॉलम श्रेणी पंक्ति और Columns में फैली सेल्स (Cells) की संख्या है। यह श्रेणी Rows की 
संख्या और Columns की संख्या वाला एक मैट्रि क्स है। उदाहरण के लिए A3 : G5, D2 : H4 आदि।

गतिविधि (Activity) संख्या 2:-

1.	 रेंज1 द्वारा प्रदर्शित प्रथम सेल का पता क्या है?

2.	 रेंज1 द्वारा प्रदर्शित अंतिम सेल का पता क्या है?

3.	 रेंज1 द्वारा प्रदर्शित सेल रेंज लिखें।

4.	 रेंज 2 द्वारा प्रदर्शित सेल रेंज लिखें।

5.	 एक पंक्ति में सेल श्रेणी का नाम क्या है?

6.	कि सी कॉलम के साथ सेल रेंज का नाम क्या है?

7.	 रेंज 3 द्वारा प्रदर्शित सेल रेंज लिखें।

8.	श्रे णी 3 द्वारा निरूपित सेल श्रेणी में सेल्स (Cells) की संख्या दें।
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चित्र 4 3

गतिविधि (Activity) का समाधान:

1.	 B5						      2.	 D5

3.	 B5 : D5					     4.	 F5 : F11

5.	 रेंज 1						      6.	 रेंज 2

7.	 B7 : C12					     8.	 12

डेटा (Data) दर्ज करना:

वर्क शीट में दर्ज किया जाने वाला डेटा (Data) लेबल, मान या सूत्र हो सकता है।

A) 	 लेबल (Label) : लेबल कीबोर्ड का उपयोग करके दर्ज किया गया कोई भी पाठ(text) है। इसे अक्षरो,ं 
संख्याओ ंऔर विशेष प्रतीको ंके साथ जोड़ा जा सकता है। डिफ़ॉल्ट रूप से लेबल संरेखित छोड़ दिए 
जाते हैं।

B)	 मान (Values): केवल संख्याओ ंसे युक्त संख्यात्मक डेटा (Data) को मान कहा जाता है। डिफ़ॉल्ट 
रूप से मान दाएँ संरेखित होते हैं.
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C)	 सूत्र (Formulae): कोई भी अभिव्यक्ति जो बराबर '=' से शुरू होती है उसे सूत्र माना जाता है।

सूत्रों में प्रयुक्त गणितीय (Mathematical) ऑपरेटर:- स्प्रेडशीट (Spreadsheet) सॉफ्टवेयर में सूत्रों का 
उपयोग करके संख्यात्मक डेटा (Data) की गणना (Calculations) करने की सबसे शक्तिशाली विशेषताएं 
हैं। लिब्रे ऑफिस कैल्क सूत्रों के लिए मानक ऑपरेटरो ंका उपयोग करता है, जैसे कि प्लस (+), माइनस 
(-), गुणन (*), अंकगणितीय (Mathematical) ऑपरेशन के लिए डिवीजन (/)।

गणितीय (Mathematical) संचालक संचालक वरीयता

जोड़ (+) पहला ()

घटाव (-) दूसरा ^

गुणन (*) तीसरा /, *

विभाजन (/) तीसरा /, *

घातांक (^)

नोट: मूल्यांकन (Evaluation) का क्रम कोष्ठक का उपयोग करके बदला जा सकता है।

गतिविधि (Activity) संख्या 3:-

ऑपरेटर का उपयोग करके निम्नलिखित समीकरणो ंका मूल्यांकन करें

प्राथमिकता और फिर स्प्रेडशीट (Spreadsheet) में परिणाम का परीक्षण करें ।

1.	 8-4/2					    2.	 5*5+8

3.	 3+5*4					    4.	 2^5+8

5.	 3+2^2				    6.	 5+6*2^2

7.	 8/4*4					    8.	 -4/2+2

9.	 1+2^2-2				    10.	 4*3/2

गतिविधि (Activity) का समाधान:

आप सरल गणित Bodmas नियम का उपयोग करके उपरोक्त अभिव्यक्ति को आसानी से हल कर सकते 
हैं या आप सेल में '=' साइन के बाद उपरोक्त अभिव्यक्ति लिखकर स्प्रेडशीट (Spreadsheet) में भी 
सत्यापित कर सकते हैं और फिर एंटर कंुजी दबा सकते हैं।
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उदाहरण के लिए  =8-4/2

उत्तर.

1.	 6						      2.	 33

3.	 23						      4.	 40

5.	 7						      6.	 29

7.	 8						      8.	 0

9.	 3						      10.	 6

नोट: सूत्र '=' चिह्न से शुरू होता है और बराबर चिह्न ('=') के बाई ंओर कुछ भी नही ंलिखा 
जाना चाहिए।

यदि आप सूत्र से पहले '=' लगाना भूल गए हैं, तो इसे एक लेबल के रूप में माना जाएगा।

शीट का नाम बदलने के चरण:

1.	 मेनू शीट → शीट का नाम बदलें (Rename) का चयन करें ।

2.	 उचित नाम दें  और ओके पर क्लिक करें

वर्क शीट को सहेजने के चरण:

वर्क शीट को सेव करने के लिए

1.	फ़ा इल → सहेजें (Save) पर क्लिक करें ।

2.	 एक सेव डायलॉग बॉक्स दिखाई देगा।

3.	 वह स्थान चुनें जहां आप फ़ाइल को सहेजना चाहते हैं।

4.	फ़ा इल का नाम दर्ज करें ,

5.	 सहेजें बटन पर क्लिक करें ।

किसी भी कॉलम से पहले कॉलम डालने के चरण:

कर्सर को उस कॉलम के किसी भी सेल पर रखें जिसके पहले आप कॉलम डालना चाहते हैं और शीट → 
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कॉलम डालें → 

कॉलम (Column) → बाएं कॉलम का चयन करें

किसी भी कॉलम के बाद (दाईं ओर) कॉलम डालने के चरण:

कर्सर को उस कॉलम के किसी भी सेल पर रखें जिसके बाद आप कॉलम डालना चाहते हैं और शीट → 
कॉलम डालें → कॉलम → कॉलम दाईं ओर चुनें ।

फंक्शन (Function)

कैल्क में फ़ंक्शं स पूर्वनिर्धारित सूत्र हैं जिनका उपयोग सेल्स(Cells) की एक श्रृंखला के लिए योग, काउंट , 
औसत, अधिकतम मूल्य और न्यूनतम मान खोजने जैसे कार्यों के लिए किया जाता है।

कैल्क में आम तौर पर उपयोग किए जाने वाले बुनियादी कार्य (Commonly used basic functions in 
Calc)

फंक्शन → सिटेक्स → उपयोग

SUM	 = SUM(Number1,Number2,…..)	सेल की रेंज में निहित मान जोड़न के लिए

AVERAGE =AVERAGE(Number1,Number2,….) सेल की श्रेणी में निहित मानो ंका औसत लौटाने के 
लिए

MAX	 =MAX(Number1,Number2,……)	सेल की श्रेणी में निहित सबसे बड़ा/अधिकतम मान लौटाने के 
लिए

MIN	 =MIN(Number1,Number2,……)	 सेल की श्रेणी में निहित सबसे छोटा/न्यूनतम मान लौटाने के 
लिए

COUNT	 =COUNT(Number1,Number2,…..) सेल की श्रेणी में सेल की संख्या की गणना लौटाने 
के लिए

वर्क शीट को फ़ॉर्मेट करना:- 

सेल डेटा (Cell Data) को फ़ॉर्मेट सेल संवाद बॉक्स का उपयोग करके स्वरूपित किया जा सकता है। 
फ़ॉर्मेट सेल संवाद बॉक्स को फ़ॉर्मेट मेनू का उपयोग करके फ़ॉर्मेट → सेल का उपयोग करके या सेल पर 
राइट क्लिक करके खोले गए संदर्भ मेनू से खोला जा सकता है। इस फॉर्मेट सेल डायलॉग बॉक्स को खोलने 
का शॉर्टकट Ctrl+1 है। फॉर्मेट सेल डायलॉग बॉक्स के विभिन्न (Variety) विकल्प नीचे दिखाए गए हैं।
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A)	 दशमलव स्थानो ं के साथ सेल्स(Cells) की एक श्रृंखला का प्रारूपण: सेल को दशमलव स्थानो ं

की आवश्यक संख्या में प्रारूपित करने के चरण निम्नलिखित हैं:

	 1.	 सेल्स की श्रेणी का चयन करें .

	 2.	 'फ़ॉर्मेट सेल डायलॉग' बॉक्स खोलें

	 3.	 'नंबर' टैब पर क्लिक करें

	 4.	 'नंबर' चुनें

	 5.	 आवश्यकतानुसार दशमलव स्थान बदलें

	 6.	 ओके पर क्लिक करें

B)	 लेबल के रूप में देखी जाने वाली सेल्स (Cells) की एक श्रृंखला को प्रारूपित करना: सेल्स की 
श्रेणी को पाठ(TEXT) के रूप में प्रारूपित करने के लिए नीचे दिए गए चरणो ंका पालन करें ।

	 1.	 सेल्स की श्रेणी का चयन करें

	 2.	 'फ़ॉर्मेट सेल डायलॉग' बॉक्स खोलें

	 3.	न बर टैब पर क्लिक करें

	 4.	 पाठ(TEXT) चुनें

	 5.	 ओके पर क्लिक करें

	 6.	 संख्याएँ दर्ज करें

C)	कि सी सेल श्रेणी को विभिन्न (Variety) दिनांक प्रारूप के रूप में स्वरूपित करना: स्प्रेडशीट 
(Spreadsheet) एप्लिकेशन में, उपयोगकर्ता कई अलग-अलग प्रारूपो ंमें दिनांक बदल सकता है। 
ऐसा करने के लिए नीचे दिए गए चरणो ंका पालन करें ।

	 1.	 सेल्स की श्रेणी का चयन करें

	 2.	 'फ़ॉर्मेट सेल डायलॉग' बॉक्स खोलें

	 3.	 'नंबर' टैब पर क्लिक करें

	 4.	 'दिनांक' श्रेणी का चयन करें

	 5.	दिन ांक प्रारूप का चयन करें



110

lwpuk izkS|ksfxdh (Information Technology)

SC
ER

T D
EL

HI
	 6.	 ओके पर क्लिक करें

D)	 समय प्रदर्शित करने के लिए सेल्स की श्रेणी को फ़ॉर्मेट करना: समय प्रदर्शित करने के लिए सेल्स 
की श्रेणी को प्रारूपित करने के लिए नीचे दिए गए चरणो ंका पालन करें ।

	 1.	 सेल श्रेणी का चयन करें

	 2.	 'फ़ॉर्मेट सेल डायलॉग' बॉक्स खोलें

	 3.	 'नंबर' टैब पर क्लिक करें

	 4.	 'समय' श्रेणी का चयन करें

	 5.	श्रे णी का चयन करें  समय प्रदर्शित होना चाहिए

	 6.	 ओके पर क्लिक करें

E)	 सेल रेंज का फ़ॉर्मेट�िग संरेखण: सेल्स (Cells) की श्रेणी के संरेखण को प्रारूपित करने के लिए नीचे 
दिए गए चरणो ंका पालन करें ।

1.	 सेल्स की श्रेणी का चयन करें

2.	 'फ़ॉर्मेट सेल डायलॉग' बॉक्स खोलें

3.	 'संरेखण' टैब पर क्लिक करें

4.	 बाएँ, दाएँ या मध्य का चयन करें

5.	 ओके पर क्लिक करें

सेल का हैंडल भरें  (Fill handle of a Cell): चयनित सेल या श्रेणी के निचले-दाएँ कोने में छोटे काले वर्ग 
को भरण हैंडल कहा जाता है।

संदर्भ (Referencing): रेफ़रेंस�िग सूत्र या फ़ं क्शन को पंक्ति या कॉलम के साथ एक सेल से अगले सेल 
तक संदर्भित करने का तरीका है। सन्दर्भ तीन प्रकार के होते हैं।

1.	 सापेक्ष संदर्भ (Relative referencing)

2.	मि क्स्ड संदर्भ (Mixed referencing)

3.	 पूर्ण संदर्भ (Absolute referencing)
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1.	 सापेक्ष संदर्भ (Relative referencing):

	 जब आप कि5सी सूत्र को किसी भी पंक्ति या कॉलम में किसी भी दिशा में खीचंते हैं, तो सूत्र संबंधित 
संदर्भ के साथ नA सेल में कॉपी हो जाता है। उदाहरण के लिए A1, H15 आदि।

2.	मि क्स्ड संदर्भ (Mixed referencing):

	मि क्स्ड संदर्भ में, पंक्ति संख्या या कॉलम नाम को स्थिर बनाने के लिए $ चिह्न का उपयोग किया जाता 
है। उदाहरण के लिए A$5, $C14 आदि।

3.	 पूर्ण सन्दर्भ (Absolute referencing):

	 निरपेक्ष संदर्भ में, किसी भी सूत्र में इसे स्थिर बनाने के लिए कॉलम नाम के साथ-साथ पंक्ति संख्या से 
पहले $ प्रतीक का उपयोग किया जाता है। उदाहरण के लिए, $C$12, $D$5 आदि।

गतिविधि (Activity) संख्या 4:-

निम्नलिखित तालिका में सेल संदर्भ को पहचानें:

उदाहरण रिफ़ें स�िग का प्रकार

A1 सापेक्ष संदर्भ (Relative referencing)

F45 सापेक्ष संदर्भ (Relative referencing)

D$4 मिक्स्ड संदर्भ (Mixed referencing)

$A23 मिक्स्ड संदर्भ (Mixed referencing)

$A$2 निरपेक्ष (Absolute)

स्प्रेडशीट (Spreadsheet) का उपयोग करके चार्ट का निर्माण

जब डेटा (Data) को संख्याओ ं के रूप में दर्शाया जाता है तो उसे समझना, तुलना करना, विश्लेषण 
(Analyze) करना या प्रस्तुत करना आसान नही ं होता है। लेकिन जब डेटा (Data) को चार्ट के रूप में 
प्रस्तुत किया जाता है तो वे संचार के लिए एक प्रभावी उपकरण बन जाते हैं। विभिन्न (Variety) प्रकार के 
चार्ट नीचे दिये गये हैं।
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चार्ट के प्रकार 

कॉलम चार्ट (Column Chart)

बार चार्ट (Bar Chart)

लाइन चार्ट (Line Chart)

पाई चार्ट (Pie Chart)

XY स्कै टर चार्ट (XY Scatter Chart)

कॉलम चार्ट बनाने के चरण:

1.	 डेटा (Data) की श्रेणी जैसे A1:F7 चुनें

2.	 सम्मिलित करें  → चार्ट पर क्लिक करें

3.	 चार्ट का प्रकार अर्थात कॉलम चार्ट चुनें

4.	 समाप्त पर क्लिक करें

 महत्वपूर्ण iz'u 

A.  बहुविकल्पीय iz'u
1)	नि म्नलिखित में से किस तकनीक का उपयोग सेल में केवल दिनांक मान की अनुमति देने के 

लिए किया जा सकता है?

	 (ए)	 डेटा स्वरूपण (Data Formating)

	 (बी)	 डेटा सॉर्टिंग (Data Sorting)

	 (सी)	 डेटा फ़िल्टरिंग (Data Fitering)

	 (डी)	 डेटा सत्यापन (Data Validation)

2)	नि म्नलिखित में से कौन सा विकल्प चयनित होने पर सभी डेटा सत्यापन हटा दिया जाता है?

	 (ए)	फ़ॉर्मेट�ि ग हटाएं (Delete Formation)

	 (बी)	 सभी को हटा दें  (Delete All)
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	 (सी)	 सूत्र हटाएं (Delete Formula)

	 (डी)	 मुझे हटा दें  (Delete Me)

3)	 हम कैल्क की निम्नलिखित में से किस सुविधा का उपयोग करके एक शब्द की एकाधिक 
घटनाओ ंको बदल सकते हैं?

	 (ए)	 खोजें और बदलें (Find and Replace)

	 (बी)	 केवल प्रतिस्थापित करके

	 (सी)	 कॉपी कमांड द्वारा

	 (d)	प्री व्यू कमांड द्वारा

4)	 डेटा को एक विशेष क्रम में व्यवस्थित करने के तंत्र का क्या नाम है?

	 (ए)	 छंटाई (Sorting)

	 (बी)	 खोजना

	 (सी)	फ़िल्ट रिंग

	 (डी)	 मान्य करना

5)	 अनावश्यक डेटा को फ़िल्टर करने के तंत्र का क्या नाम है?

	 (ए)	 छंटाई

	 (बी)	 खोजना

	 (सी)	फ़िल्ट रिंग

	 (डी)	 मान्य करना

6)	 कैल्क निम्नलिखित में से किस प्रकार के पैकेज को संदर भ्ित करता है?

	 (ए)	 स्प्रेडशीट

	 (बी)	 डबल शीट

	 (सी)	 मल्टी-शीट

	 (डी)	 निर्धारित नही ंकर सकते
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7)	नि म्नलिखित में से कौन सा कैल्क में बनाई गई वर्क शीट का विस्तार है?

	 (ए)	 .ods

	 (बी)	 .odd

	 (सी)	 .xls

	 (डी)	 .obj

8)	 कोई वर्क शीट कॉलम में दर्ज किए गए कुल मानो ंकी गणना कैसे कर सकता है?

	 (ए)	 मैन्युअल प्रविष्टि द्वारा

	 (बी)	 ऑटो-सम द्वारा

	 (सी)	 सूत्र द्वारा

	 (डी)	 योग समारोह द्वारा

उत्तर. हम ऊपर दिए गए सभी तरीको ं(ए, बी, सी, डी) द्वारा कुल मूल्यों की गणना कर सकते हैं

9)	 यदि हम वर्क शीट में किसी अन्य सेल के संदर्भ में एक सूत्र वाले सेल को स्थानांतरित करते हैं 
तो सूत्र में प्रयुक्त सेल नंबरो ंका क्या होगा?

	 (ए)	 गंतव्य पर सेल पंक्ति और कॉलम बदल दिए जाते हैं।

	 (बी)	 गंतव्य पर सेल पंक्ति बदल जाती है।

	 (सी)	 गंतव्य पर सेल कॉलम बदल दिए जाते हैं।

	 (डी)	 कोई परिवर्तन नही ंहोगा.

10)	 कैल्क में किसी फ़ं क्शन को दर्ज करने का सही तरीका क्या है?

	 (ए)	 सेल में सीधे फ़ं क्शन का नाम टाइप करना

	 (बी)	फ़ं  क्शन विज़ार्ड का उपयोग करना या टूलबार से चयन करना

	 (सी)	 दोनो ं(ए) और (बी)

	 (डी)	फ़ं  क्शन पर निर्भर करता है



Class IX : 2024-25

115

SC
ER

T D
EL

HI
B.	 दीर्घ iz'u और उत्तर

1.	 स्प्रेडशीट, वर्क शीट और शीट में क्या अंतर है?

	 उत्तर – स्प्रेडशीट, वर्क शीट और शीट में अंतर हैं –

	 स्प्रेडशीट - उपयोगकर्ता डेटा को पंक्तियो ंऔर कॉलम में व्यवस्थित करने और उस पर गणना करने 
के लिए स्प्रेडशीट सॉफ़्टवेयर का उपयोग कर सकते हैं। एक वर्क शीट इन सभी पंक्तियो ंऔर कॉलम 
से बनी होती है।

	 वर्क शीट - लिब्रेऑफिस कैल्क में डिफ़ॉल्ट रूप से 3 वर्क शीट दी गई है। वर्क शीट नोटबुक के समान 
होती हैं और इनमें संख्याएँ, वर्ण और विशेष वर्ण होते हैं।

	 शीट - सेल वह बिदु है जहां एक कॉलम और एक पंक्ति मिलती है।

2.	 स्प्रेडशीट एप्लिकेशन में बनाए गए दस्तावज़ को आप क्या कहते हैं?

	 उत्तर – स्प्रेडशीट एक कंप्यूटर प्रोग्राम है जो आपको डेटा को सारणीबद्ध प्रारूप में व्यवस्थित करने, 
विश्लेषण करने और सहेजने की अनुमति देता है।

	 स्प्रेडशीट के उपयोगकर्ता किसी भी संग्रहीत मूल्य को बदल सकते हैं और देख सकते हैं कि यह 
गणना की गई संख्याओ ं को कैसे प्रभावित करता है। क्योंक�ि मैन्युअल पुनर्गणना के बिना विभिन्न 
परिदृश्यों का त्वरित मूल्यांकन किया जा सकता है, स्प्रेडशीट “व्हाट इफ” (“what-if”) विश्लेषण के 
लिए आदर्श है।

	 आधुनिक स्प्रेडशीट सॉफ़्टवेयर में कई परस्पर जुड़ी हुई शीट हैं और डेटा को टेक्स्ट, संख्या या ग्राफ़ 
के रूप में दिखा सकते हैं।

3.	 नई स्प्रेडशीट बनाने के चरण क्या हैं?

	 उत्तर – एक नई स्प्रेडशीट बनाने के लिए आप निम्नलिखित चरणो ंका पालन कर सकते हैं

	 चरण 1 – स्टार्ट मेनू पर क्लिक करें

	 चरण 2 – लिब्रे ऑफिस 5.4 मेनू पर क्लिक करें

	 चरण 3 – लिब्रे ऑफिस कैल्क का चयन करें
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4.	वर्क  शीट का डिफ़ॉल्ट नाम क्या है? इसका नाम कैसे बदला जा सकता है?

	 उत्तर – डिफ़ॉल्ट रूप से वर्क शीट के नाम शीट1, शीट2, शीट3 हैं, आप डबल क्लिक या राइट क्लिक 
का उपयोग करके आसानी से शीट का नाम बदल सकते हैं। आप स्प्रेडशीट में एकाधिक शीट भी 
जोड़ सकते हैं।

5.	 कैल्क में वर्क शीट डालने और हटाने के चरण लिखें।

	 उत्तर - कैल्क में वर्क शीट डालने और हटाने के लिए -

	 शीट डालें

	 स्प्रेडशीट में शीट डालने के लिए इन्सर्ट टैब पर क्लिक करें

	 शीट का नाम बदलें

	 शीट हटाएं

	 शीट पर राइट क्लिक करें  और डिलीट विकल्प चुनें

6.	 सक्रिय सेल (Active CELL) क्या है? सक्रिय सेल की सामग्री को कैसे हटाएं?

	 उत्तर - जब आप टाइप करना शुरू करते हैं तो सेल सक्रिय होने लगती है, केवल सक्रिय सेल का 
उपयोग डेटा दर्ज करने के लिए किया जा सकता है।

	 सक्रिय सेल कैसे डिलीट करें  –

	 यदि आप किसी सक्रिय सेल की सामग्री को हटाना चाहते हैं, तो उसे चुनें और उस पर राइट-क्लिक 
करें , फिर डिलीट सेल का चयन करें ।

7.	 स्प्रेडशीट में सापेक्ष (Relative) और निरपेक्ष (Absolute) सेल पता क्या है?

	 उत्तर- सापेक्ष एवं निरपेक्ष में अंतर है-

	 सापेक्ष संदर्भ (Relative Reference)- एक स्प्रेडशीट में, डिफ़ॉल्ट सेल संदर्भ सापेक्ष होता है। यह 
केवल कॉलम नाम और पंक्ति संख्या का संयोजन है, बीच में कोई डॉलर ($) चिह्न नही ंहै। जब आप 
किसी सूत्र को एक सेल से दूसरे सेल में कॉपी करते हैं, तो सापेक्ष संदर्भ बदल जाता है।

	 निरपेक्ष संदर्भ (Absolute Reference)- डॉलर ($) चिह्न को निरपेक्ष संदर्भ सेल में कॉलम नाम 
और पंक्ति संख्या से पहले रखा जाता है। किसी सूत्र को एक सेल से दूसरे सेल में कॉपी करते समय, 
पूर्ण संदर्भ नही ंबदलेगा।
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8.	 स्प्रेडशीट में डेटा पर किए गए किन्हीं  दो ऑपरेशनो ंकी व्याख्या करें ।

	 उत्तर- स्प्रेडशीट में डेटा पर किए जाने वाले दो प्रमुख ऑपरेशन सूत्र और फ़ं क्शन हैं।

	 फॉर्मूला एक सॉफ्टवेयर एप्लिकेशन है जिसका उपयोग सारणीबद्ध रूप में डेटा मानो ंको व्यवस्थित 
रखने और उनका विश्लेषण करने के लिए किया जाता है।

	 स्प्रेडशीट में, योग गणना औसत अधिकतम और न्यूनतम जैसे पूर्वनिर्धारित सूत्रों का उपयोग किया 
जाता है।

9.	 स्प्रेडशीट में सूत्र कैसे काम करते हैं?

	 उत्तर - सूत्र एक सांख्यिकीय वाक्यांश है जो सेल्स(Cells) के एक समूह में मानो ंके साथ काम करता 
है। भले ही परिणाम एक त्रुटि हो, ये सूत्र एक परिणाम लौटाते हैं। आप जोड़, घटाव, गुणा और भाग 
जैसे कार्यों को निष्पादित करने के लिए स्प्रेडशीट फॉर्मूला का उपयोग कर सकते हैं।

	 उदाहरण के लिए, =A1+A2+A3 सेल A1 से A3 में मानो ंके योग की गणना करता है।

10.	 क्या आप एक सूत्र में एक से अधिक गणितीय ऑपरेटर शामिल कर सकते हैं?

	 उत्तर - हां, एक सूत्र में कई गणितीय ऑपरेटर हो सकते हैं। उदाहरण के लिए =(a1+a2)*2

11.	व ांछित टूलबार को स्प्रेडशीट में दृश्यमान कैसे बनाएं?

	 उत्तर - "स्प्रेडशीट" एक सॉफ्टवेयर एप्लिकेशन है जो आपको डेटा को सारणीबद्ध प्रारूप में संग्रहीत 
करने की अनुमति देता है। टूलबार छवियो/ंआइकनो ं का एक समूह है जो विभिन्न कार्यों के लिए 
शॉर्टकट के रूप में कार्य करता है।

	 स्प्रेडशीट में, संबंधित टूलबार कमांड बनाने और छिपाने के लिए "Ctrl+F1" कंुजी दबाएं।

12.	 स्प्रेडशीट में किन्हीं  तीन गणितीय कार्यों का वाक्य-विन्यास(Syntax) और उदाहरण दीजिए।

	 उत्तर - स्प्रेडशीट में किन्हीं  तीन गणितीय कार्यों का सिटैक्स और उदाहरण निम्नलिखित है:

	 SUM() -  यह एक फ़ं क्शन है जो सेल की श्रेणी में सभी मान जोड़ता है...

	 COUNT() - एक फ़ं क्शन है जो उन सेल्स(Cells) की संख्या की गणना करता है जिनमें एक संख्या 
होती है।

	 AVERAGE() - एक फ़ं क्शन है जो सेल्स (Cells) के एक सेट के औसत की गणना करता है।



118

lwpuk izkS|ksfxdh (Information Technology)

SC
ER

T D
EL

HI
13.	 स्प्रेडशीट में किन्हीं  तीन सांख्यिकीय कार्यों का वाक्यविन्यास(syntax) दीजिए।

	 उत्तर- एक स्प्रेडशीट में तीन सांख्यिकीय कार्य होते हैं।

	 •	 =Count() और =Counta()

	 •	 =Average()

	 •	 =Countblank()

14.	 स्प्रेडशीट में किन्हीं  तीन दिनांक और समय फ़ं क्शन का सिटैक्स और उदाहरण दें।

	 उत्तर - एक्सेल की समय और तिथियो ंको संग्रहीत और विनियमित करने की क्षमता इसकी सबसे 
महत्वपूर्ण विशेषताओ ंमें से एक है।

	 =NOW() - वर्तमान दिनांक और समय प्राप्त करने के लिए NOW फ़ं क्शन का उपयोग करें ।

	 =DATE() - DATE फ़ं क्शन में तीन तर्क  हैं: वर्ष, महीना और दिन।

	 =TIME() - कई घंटे, मिनट और/या सेकंड जोड़न के लिए TIME फ़ं क्शन का उपयोग करें ।

15.	 एक स्प्रेडशीट में किन्हीं  तीन तार्कि क (Logical) कार्यों का सिटैक्स और उदाहरण दें।

	 उत्तर- स्प्रेडशीट में तीन प्रकार के लॉजिकल फंक्शन होते हैं

	 AND - यदि सभी शर्तें सत्य हैं तो तार्कि क AND (Logical AND) फ़ं क्शन सत्य लौटाता है, और यदि 
कोई शर्त गलत है तो गलत लौटाता है।

	 उदाहरण - AND(A1>10, A1<100)

	 OR - जब कोई एक पद सत्य होता है, तो तार्कि क OR फ़ं क्शन सत्य लौटाता है; अन्यथा, यदि सभी 
शर्तें गलत हैं तो यह FALSE लौटाता है।

	 उदाहरण - OR(A1>10, B1>100)

	 NOT - तार्कि क NOT फ़ं क्शन सत्य को असत्य और असत्य को सत्य मानो ंमें परिवर्तित करता है।

	 उदाहरण – NOT(A1>10, A2>100)

16.	 स्प्रेडशीट में किन्हीं  तीन स्ट्रिंग फ़ंक्शं स का सिटैक्स और उदाहरण दें।

	 उत्तर- तीन स्ट्रिं ग फ़ंक्शं स हैं-
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	 Len() - एक्सेल में लेन फ़ं क्शन आपको एक स्ट्रिं ग की लंबाई, या उसमें वर्णों की संख्या निर्धारित करने 

की अनुमति देता है।

	 MID() - एक्सेल में, MID() फ़ं क्शन का उपयोग स्ट्रिं ग के बीच से कैरेक्टर निकालने के लिए किया 
जाता है।

	 Left() - एक्सेल का बायाँ फ़ं क्शन एक स्ट्रिं ग से बाएँ अक्षर को निकालता है।

17.	 कैल्क में चार्ट बनाने के फायदे बताएं।

	 उत्तर – कैल्क में चार्ट बनाने के कुछ लाभ निम्नलिखित हैं:

	 •	 आप डेटा को आसानी से प्रस्तुत कर सकते हैं

	 •	 यह डेटा को उचित तरीके से दिखाता है

	 •	 यह प्रत्येक संगठन के लिए एक शक्तिशाली उपकरण है

18.	व िभिन्न प्रकार के चार्टों को एक पंक्ति में समझाइये।

	 उत्तर- लाइन चार्ट - पैटर्न दर्शान के लिए लाइन चार्ट बहुत उपयोगी है। लाइन चार्ट का ऊर्ध्वाधर 
(Vertical) अक्ष (Y-अक्ष) हमेशा संख्यात्मक मान दिखाता है, जबकि क्षैतिज (Horizontal) अक्ष 
(X-अक्ष) समय या अन्य श्रेणी दिखाता है।

	 पाई चार्ट - पाई चार्ट में डेटा की केवल एक श्रृंखला प्रदर्शित की जा सकती है। डेटा श्रृंखला संख्याओ ं
का एक समूह है जिसे एक पंक्ति या कॉलम में प्लॉट किया जा सकता है।

	 कॉलम चार्ट - कॉलम चार्ट डेटा बिदुओ ंके एक या अधिक सेट की तुलना करने का एक उत्कृष्ट  तरीका 
है।

	 बार चार्ट - बार चार्ट एक कॉलम चार्ट के समान है। संख्यात्मक संख्याएँ बार चार्ट के क्षैतिज अक्ष पर 
प्रदर्शित होती हैं।

	 एरिया चार्ट - एरिया चार्ट लाइन चार्ट के समान होते हैं, एरिया चार्ट का उपयोग आमतौर पर समय के 
साथ या अन्य श्रेणियो ंमें पैटर्न प्रदर्शित करने के लिए किया जाता है।

	स्कै  टर चार्ट - स्कै टर चार्ट का लक्ष्य समय या किसी अन्य श्रेणी में दो श्रृंखलाओ ंके मूल्यों की तुलना 
करना है।
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19.	 कैल्क में चार्ट डालने के चरण लिखें।

	 उत्तर - कैल्क में चार्ट डालने के लिए

	 चरण 1 - इन्सर्ट टैब पर क्लिक करें

	 चरण 2 - चार्ट का चयन करें

	 चरण 3 - चार्ट में अपना डेटा दर्ज करें

20.	 स्प्रेडशीट पैकेज में चार्ट के किन्हीं  पांच घटको ंको नाम दें और समझाएं।

	 उत्तर – स्प्रेडशीट पैकेज में चार्ट के पांच घटक इस प्रकार हैं:

	 •	 चार्ट क्षेत्र (Chart area)

	 •	 चार्ट शीर्षक (Chart Title)

	 •	 अक्ष शीर्षक (Axis Title)

	 •	 निश्चित भूभाग का क्षेत्रफल (Plot Area)

	 •	 अक्ष मान (Axis Values)

vvv
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विद्यार्थी-

•	 एक प्रभावी प्रेजेंट�शन (presentation) की विशेषताओ ंको समझते हैं।

•	 प्रभावी प्रेजेंट�शन बनाने और स्लाइडस पर काम करने का कौशल अर्जित करते हैं।

•	 टेक्स्ट को फ़ॉर्मेट करने और एनिमेशन लागू करते हैं।

•	 तालिकाएँ (table) बनाते और उनका उपयोग करते हैं।

•	 प्रेजेंट�शन में चित्र (pictures) प्रारूपित करते हैं।

•	 स्लाइड मास्टर के साथ कार्य करने और टेम्पलेट का उपयोग करके प्रेजेंट�शन बनाते हैं।

•	 प्रेजेंट�शन को पीडीएफ में सेव करना, प्रेजेंट�शन में एक नई स्लाइड और डुप्लिकेट स्लाइड का प्रयोग 
करने का कौशल अर्जित करते हैं।

•	 स्लाइड की सामग्री को कॉपी, स्थानांतरित (move) और हटाने (delete) का कौशल प्राप्त करते हैं।

•	 फ़ॉर्मेट�िग टूलबार में विभिन्न विकल्पों (options) को पहचानें और सूचीबद्ध (list) करते हैं।

•	 उचित फ़ॉर्मेट�िग विकल्प (options) चुनते हैं।

•	 प्रेजेंट�शन में पाठ को संरेखित करने में सक्षम होते हैं।

•	 ग्राफ़िक ऑब्जेक्ट का उपयोग करके रेखाएँ बनाने और आकृतियाँ बना सकते हैं।

•	 वस्तुओ ंको समूहीकरण और असमुहिकरण करते हैं।

•	 प्रेजेंट�शन में एनिमेशन का प्रयोग करने और स्लाइड् में आरोपित करते हैं।

इकाई-5  
डिजिटल प्रजेंट��शन (Digital Presentation)
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परिचय (Introduction)

अपने संदेश या राय को लोगो तक पहुँचाने के लिए जानकारी को स्पष्ट और प्रभावी ढंग से प्रस्तुत करना 
एक महत्वपूर्ण कौशल (skill) है। आज लगभग हर क्षेत्र में प्रेजेंट�शन स्किल की अत्यधिक आवश्यकता है। 
प्रेजेंट�शन कौशल में सामग्री (content) के साथ-साथ अच्छी प्रस्तुति (presentation) भी शामिल होती 
है। कंप्यूटर से तैयार प्रेजेंट�शन का उपयोग करने के कई फायदे हैं; जैसे कि नीचे दिए हुए चित्र 5.1 
में दिखाया गया हैं- प्रेजेंट�शन का उपयोग शैक्षिक कार्यशालाओ ं (educational workshops), प्रशिक्षण 
सत्र (training sessions), खाना पकाने की कक्षाओ,ं DIY ट्यूटोरियल, प्रौद्योगिकी प्रदर्शन (technology 
demonstrations) आदि में किया जाता हैं।

प्रेजेंट��शन की अवधारणा (concept)

प्रेजेंट�शन का उपयोग व्यावसायिक संगठनो ंमें परियोजना प्रस्ताव (project proposal) प्रस्तुत करने के लिए 
किया जाता है। शिक्षण एवं प्रशिक्षण में प्रेजेंट�शन का अत्यधिक उपयोग किया जाता है। जिन अवधारणाओ ं
या विचारो ंको समझाना कठिन है, उन्हें किसी भी प्रेजेंट�शन सॉफ़्टवेयर का उपयोग करके सरल तरीके से 
दर्शको ंके सामने आसानी से प्रस्तुत किया जा सकता है। उदाहरण के लिए, शिक्षक मानव जैविक प्रणाली 
(biological system of human) को पढ़ाना चाहते है तो, वे एक प्रेजेंट�शन द्वारा चित्रों और एनीमेशन का 
बहुत प्रभावी ढंग से उपयोग करके मानव की एक संपूर्ण प्रणाली को प्रदर्शित कर सकते हैं।

प्रस्तुति/प्रेजेंट��शन के तत्व 

•	 मूलपाठ (text)

•	 वस्तुओ ंको सूचीबद्ध (list) करना

•	 सारणी (table) बनाना

•	 ग्राफ़िक्स

•	 ध्वनि एवं वीडियो

•	 एनिमेशन

अच्छी गुणवत्ता (quality) वाली प्रस्तुति (प्रेजेंट��शन) की विशेषताएँ:

लोगो तक संदेश को स्पष्ट रूप से पहुंचाने के लिए अच्छी गुणवत्ता वाली प्रेजेंट�शन की आवश्यकता होती है। 
अच्छी गुणवत्ता वाली प्रेजेंट�शन तैयार करते समय निम्नलिखित बातो ंया दिशानिर्देशो ंका ध्यान रखना चाहिए:
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I.	 पंक्तियो ं(lines) की संख्या: एक पृष्ठ या स्लाइड पर 5 से 8 पंक्तियाँ शामिल करने का प्रयास करें । 

अधिक संख्या में पंक्तियाँ या पैराग्राफ जोड़न से पढ़न में अधिक समय लग सकता है क्योंक�ि फ़ॉन्ट 
का आकार बहुत छोटा हो सकता है।

II.	 फॉन्ट साइज: प्रेजेंट�शन तैयार करते समय आपको जगह के साइज, स्क्रीन और दर्शको ंके बीच की 
दूरी का ध्यान रखना होगा। इसके अनुसार प्रेजेंट�शन में टेक्स्ट का फॉन्ट साइज तय किया जा सकता 
है। फ़ॉन्ट का आकार 32 अंक या उससे अधिक रखना उचित होगा, ताकि दर्शक आसानी से लिखा 
हुआ पढ़ सकें ।

III.	 व्याकरण और भाषा का सही उपयोग: आपकी प्रस्तुति में व्याकरण और भाषा सही होनी चाहिए। 
यदि आप भाषा संबंधी कोई गलती करते हैं तो पाठको पर नकारात्मक प्रभाव पड़ेगा। इसलिए सही 
व्याकरण और भाषा के साथ बिना किसी गलती के सामग्री को स्लाइड पर प्रस्तुत करना चाहिए।

IV.	 छवियाँ, रेखाचित्र (drawings), टेबल्स या ग्राफ़ सम्मिलित करना: किसी भी स्लाइड में दो से 
अधिक ग्राफ़िक्स (चित्र, रेखाचित्र, तालिकाएँ या चार्ट) सम्मिलित करने से बचने का प्रयास करें । बहुत 
अधिक ग्राफ़िक्स डालना दर्शको ंके लिए भ्रमित करने वाला हो जाता है।

V.	 रंगो ं का उपयोग: कुछ चीज़ो ं को उजागर करने के लिए गहरे रंगो,ं अलग-अलग फ़ॉन्ट वाले मोटे 
अक्षरो ंका उपयोग करने का प्रयास करें । बैकग्राउंड और फोरग्राउण्ड  के रंगो ं के अंतर पर ध्यान 
दें। गहरे रंग के बैकग्राउंड पर गहरे रंग के फ़ॉन्ट का उपयोग करना, या पूरी प्रस्तुति में केवल एक 
रंग लेना अच्छा अभ्यास नही ंहै। शब्दों के महत्व को दर्शान के लिए प्रेजेंट�शन के बीच में कही-ंकही ं
अलग-अलग रंगो ंका प्रयोग करें ।

VI.	 एनिमेशन और वीडियो: एक स्लाइड में एक से अधिक एनिमेशन या वीडियो शामिल न करें । एक 
से अधिक को शामिल करने से ध्वनियाँ ओवरलैप हो जाएंगी और दर्शको ंको भ्रम हो सकता है।

VII.	 लक्षित दर्शको पर ध्यान दें: प्रेजेंट�शन बनाते समय, लक्षित दर्शको ं (target audience) की 
आवश्यकताओ ंको पूरा करने पर ध्यान दें। विषय की सामग्री (content) और अनुक्रम (sequence) 
इस तरह से बनाएँ की दर्शको ंका ध्यान पूरे समय आपकी प्रेजेंट�शन पर बना रहे।

प्रेजेंट��शन सॉफ्टवेयर का परिचय:

इम्प्रेस (Impress) Document Foundation में LibreOffice suite का एक महत्वपूर्ण अंग हैं। यह मुफ़्त, 
ओपन सोर्स और बड़े समुदाय द्वारा व्यापक रूप से प्रेजेंट�शन बनाने के लिए उपयोग किया जाता है। 
आप कक्षा लेक्चर, कॉर्पोरेट प्रशिक्षण (training) और आमंत्रित बातचीत के लिए टेक्स्ट, ग्राफिक्स और 
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एनिमेशन का उपयोग करके प्रेसेंट�शन बना सकते हैं। लिबरऑफिस इम्प्रेस में बनाए गए प्रेजेंट�शन को MS 
PowerPoint जैसे अन्य प्रेजेंट�शन सॉफ्टवेयर में भी खोला जा सकता है।

Impress का उपयोग करके हम MS PowerPoint और उसके टेम्पलेटस को भी पढ़ सकते हैं। हम MS 
PowerPoint में Impress की प्रेसेंट�शन्स को अलग रूप और अनुभव (look & feel) के साथ भी खोल 
सकते हैं। LibreOffice Impress विडोज़ (windows), लिनक्स (Linux) और मैक (mac) पर चलता है 
और यह अलग-अलग ऑपरेटिग सिस्टम पर थोड़ा अलग लग सकता है। LibreOffice Impress में, विभिन्न 
मल्टीमीडिया तत्वों का उपयोग करके एक प्रभावी प्रेजेंट�शन बनाया जा सकता हैं। 

लिबरऑफिस इम्प्रेस के साथ शुरुआत करना

लिबरऑफिस इम्प्रेस (LibreOffice Impress) प्रारंभ करना

लिबरऑफिस इम्प्रेस शुरू करने के लिए, बस डेस्कटॉप पर इसके शॉर्टकट आइकन पर डबल-क्लिक 
करें । सामान्य तौर पर आपको डेस्कटॉप पर या क्विक लॉन्च टास्कबार पर लिबरऑफिस का शॉर्टकट 
मिलेगा। आपके द्वारा उपयोग किए जा रहे ऑपरेटिग सिस्टम (विडोज़ या लिनक्स) के अनुसार प्रक्रिया 
थोड़ी भिन्न हो सकती है।

विडोज़ में लिबरऑफिस इम्प्रेस शुरू करने के लिए, डेस्कटॉप पर इसके शॉर्टकट आइकन पर डबल 
क्लिक करें  या स्टार्ट या विडोज बटन पर क्लिक करें , एप्लिकेशन विडो से LibreOffice → LibreOffice 
Impress चुनें।

Ubuntu Linux में, निम्न में से किसी भी विकल्प से LibreOffice Impress खोलें:

I.	 एप्लिकेशन लॉन्चर पर लिब्रे ऑफिस इंप्रेस आइकन ढंूढें , और 
एप्लिकेशन शुरू करने के लिए उस पर क्लिक करें ।

II.	 लॉन्चर पर "Show Application" आइकन के माध्यम से लिब्रे 
ऑफिस इंप्रेस आइकन ढंूढें। खोजने के लिए, "Impress" 
शब्द दर्ज करें  और खोज परिणामो ंसे LibreOffice Impress 
चुनें।

इम्प्रेस शुरू करने के बाद इसकी शुरुआती विडो खुलेगी जैसा 
कि चित्र 5.2 में दिखाया गया है। यह इम्प्रेस एप्लिकेशन विडो के 
विभिन्न भागो ंको प्रदर्शित होता है।
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इम्प्रेस विंडो के भाग:

इम्प्रेस मुख्य विंडो के हिस्से चित्र 5.2 में दिखाए गए हैं।

•	 टाइटल बार (Title Bar): इसमें एक्सटेंशन (.odp) के साथ प्रेजेंट�शन फ़ाइल का नाम और 
लिबरऑफिस इम्प्रेस के रूप में प्रेजेंट�शन एप्लिकेशन होता है। यह हमेशा लिबरऑफिस इम्प्रेस 
टाइटल बार विडो के शीर्ष पर होता है। विडो मैनिपुलेशन बटन दाएं कोने में स्थित हैं। ये मिनिमाइज, 
मैक्सिमाइज/रिस्टोर और क्लोज बटन होते हैं।

•	 मेनू बार (menu bar): इसमें तार्कि क (logically) रूप से समूहीकृत (group) कमांड वाले मेनू 
शामिल होते हैं। प्रेजेंट�शन बनाने के लिए आवश्यक सभी कमांड यहां पाए जाते हैं। विभिन्न मेनू नीचे 
दिए गए चित्र 5.3 में दर्शाए गए है:

	 i.	� फ़ाइल (file): फ़ाइल मेनू का उपयोग प्रेजेंट�शन पर बुनियादी संचालन करने के लिए किया 
जाता है जैसे save करना, मौजूदा फाइल को open करना और नई फाइल बनाना आदि।

	 ii.	� एडिट (edit): इस मेनू में टेक्स्ट के किसी भी हिस्से को कॉपी करना, कट और पेस्ट के फ़ं क्शन 
शामिल हैं।

	 iii.	� व्यू (view): इसका उपयोग विडो पर जो आपको दिखाई दे रहा हैं, उसका चयन, ज़ूमिग और 
टूलबार जोड़ने आदि करने के लिए किया जाता है।
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	 iv.	� सम्मिलित (Insert): इस मेनू का उपयोग प्रेजेंट�शन में विभिन्न ऑब्जेक्ट जैसे आकृतियां 

(shapes), टेक्स्टबॉक्स और चार्ट डालने के लिए किया जाता है।

	 v.	�फ़ॉर्मे ट (format): इसमें टेक्स्ट फ़ॉर्मेट�िग के लिए फ़ंक्शं स शामिल हैं।

	 vi.	� स्लाइड (slide): इसका उपयोग नई स्लाइड डालने, डुप्लिकेट स्लाइड डालने या स्लाइड हटाने 
के लिए किया जाता है।

	 vii.	 स्लाइड शो (slide show): यह प्रेजेंट�शन प्रदर्शित करने का एक साधन (tool) है।

	 viii.	� उपकरण (tools): इनका उपयोग प्रेजेंट�शन में स्पेलिग को नियंत्रित करने के लिए किया जाता 
है।

	 ix.	�व िंडो (window): इसका उपयोग पहले से खोले गए प्रेजेंट�शन को देखने के लिए किया जाता 
है।

	 x.	� हेल्प (help): इसका प्रयोग इम्प्रेस पर किसी भी टॉपिक संबंधी हेल्प देखने के लिए किया जाता 
है।

•	व िभिन्न टूलबार: इम्प्रेस की GUI को प्रबंधित करने के लिए विभिन्न टूलबार हैं। आप विभिन्न कार्यों के 
लिए आवश्यकता पड़न पर इन टूलबार का उपयोग कर सकते हैं।

	 i.	� मानक (standard) टूलबार: मेनू बार के प्रत्येक मेनू को आसान संचालन के लिए आइकन के 
रूप में यहां रखा गया है।

	 ii.	� स्लाइड पेन (pane): किसी भी स्लाइड पर आसानी से नेविगेट करने के लिए स्लाइड को छोटे 
आकार में देखने के लिए यह एक वर्टीकल pane है। जैसे ही आप किसी विशेष स्लाइड पर 
क्लिक करें गे, वह स्लाइड विडो के मध्य में बड़े आकार में दिखेगी।

	 iii.	� कार्यक्षेत्र (workspace): यह विडो का कें द्रीय भाग है, जहां प्रेजेंट�शन स्लाइड बनाई जाती हैं, 
टेक्स्ट लिखा जाता है, चित्र और अन्य ऑब्जेक्ट डाले जाते हैं।

	 iv.	� स्लाइड्स (slides): यह विडो के बाएं हिस्से में है, प्रेजेंट�शन स्लाइड्स को थंबनेल (thumbnail) 
रूप में दिखते है। यदि आप व्यू मेनू में स्लाइड पेन कमांड पर क्लिक करते हैं तो pane को बंद 
और खोला जा सकता है।

	 v.	� टास्क पेन (pane): कार्य पेन (pane) विडो के दाएँ भाग पर है। कार्य फलक पाँच अंगो से बना 
है।
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	 vi.	� मास्टर पेज (master page): आप स्लाइड के बेस आर्कि टेक्चर को बदल सकते हैं। आप 

इसका उपयोग करके सभी स्लाइडो ं के लिए प्रेजेंट�शन बेस और सामान्य शैली (common 
style) बना सकते हैं। इम्प्रेस में कुछ डिफ़ॉल्ट स्लाइड मास्टर पेज भी उपलब्ध हैं।

	 vii.	� लेआउट (layouts): आप इस सॉफ़्टवेयर का उपयोग करके अपना स्वयं का लेआउट तैयार 
कर सकते हैं और भविष्य में उपयोग के लिए इसे सुरक्षित रख सकते हैं।

	 viii.	� टेबल डिज़ाइन (table design): यह टेबल बनाने के लिए स्टाइल्स देता है। कोई भी अपनी 
पसंद के अनुसार स्टाइल में बदलाव किया जाता है।

	 ix.	� कस्टम एनीमेशन (custom animation): स्लाइड में टेक्स्ट, रेखाचित्र आदि के लिए कई 
एनीमेशन सुविधाएँ हैं। इस सुविधा का उपयोग करके आप एनीमेशन फीचर्स में किसी भी प्रकार 
का बदलाव कर सकते है।

	 x.	� स्लाइड ट्रांज़ि शन (slide transition): स्लाइड ट्रांज़िशन का उपयोग करके, आप यह निर्धारित 
कर सकते हैं कि प्रेजेंट�शन के दौरान स्लाइड कैसे दिखाई देगी। 

	 xi.	� ड्रा इंग टूलबार (drawing toolbar): ड्राइंग टूलबार का उपयोग करके आप अपने प्रेजेंट�शन 
को प्रभावशाली बनाने के लिए प्रेजेंट�शन में विभिन्न कलात्मक कार्य कर सकते हैं।

	 xii.	� इंसर्शन पॉइंट (insertion point): यह कर्सर का एक स्थान है जहां कुछ भी टाइप करते ही 
आपका टेक्स्ट दिखाई देगा।

	 xiii.	� स्टेटस बार (status bar): यह सक्रिय प्रेजेंट�शन, कर्सर की वर्तमान स्थिति और ज़ूम स्लाइडर 
के बारे में जानकारी दिखाता है। इसे यूजर की पसंद के अनुसार एडजस्ट किया जा सकता है। 

	 xiv.	� ज़ूम कंट्रो ल (zoom control): इस टूल का उपयोग स्लाइड को ज़ूम इन या ज़ूम आउट करने 
के लिए किया जाता है।

Libre Office Impress को बंद करना 

Impress एप्लिकेशन को सीधे बंद करने के लिए, मैनिपुलेशन बटन क्लोज (×) बटन का चयन करें , या File 
Menu  Exit कमांड का चयन करें  या कीबोर्ड शॉर्टकट Alt+F4 या Ctrl+Q का उपयोग करें ।
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प्रेजेंट��शन बनाना

टेम्प्लेट का उपयोग करके प्रेजेंट�शन बनाने, या नया blank प्रेजेंट�शन बनाने के लिए, File Menu→ New 
का चयन करें  या आइकन न्यू पर क्लिक करें  या Ctrl + N की (key) का उपयोग करें ।

एक विडो 'Select a window' दिखाई देगी। प्रेजेंट�शन बनाने के लिए चित्र 5.4 में दिखाए अनुसार टेम्पलेट 
पर क्लिक करके अपनी पसंद के अनुसार एक टेम्पलेट चुनें। टेम्पलेट का उपयोग करके अपना प्रेजेंट�शन 
बनाए। चयनित टेम्प्लेट टाइटल स्लाइड लेआउट के रूप में दिखाई देती है जैसा 

चित्र 5.4 में दिखाया गया है। 

प्रेजेंट�शन बनाते समय, पहली स्लाइड आम तौर पर टाइटल स्लाइड होती है। अब इस स्लाइड में टाइटल 
टेक्स्ट दर्ज करें  जैसा कि चित्र 5.5 में दिखाया गया है।
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स्लाइड लेआउट का चयन

उपयुक्त लेआउट को प्रॉपर्टी विडो में लेआउट ऑप्शन से चुना जा सकता है। लिबरऑफिस में शामिल 
लेआउट एक खाली स्लाइड से लेकर छह कंटेंट बॉक्स वाली स्लाइड तक होते हैं जैसा कि चित्र 5.6 में 
दिखाया गया है।



130

lwpuk izkS|ksfxdh (Information Technology)

SC
ER

T D
EL

HI
आप मेनू, Slide→ Slide Layout → Title slide का उपयोग करके भी स्लाइड लेआउट का चयन कर 
सकते हैं जैसा कि चित्र 5.7 में दिखाया गया है। आपके द्वारा चुना गया लेआउट विडो के दाईं ओर होगा। 
वैकल्पिक रूप से, आप स्लाइड pane में स्लाइड का चयन कर सकते हैं, यह वर्कस्पे स में दिखाई देगा 
और यहाँ आप साइडबार में लेआउट सेक्शन से आवश्यक लेआउट का चयन कर सकते हैं।

प्रेजेंट��शन सेव करना:

प्रेजेंट�शन बनाते समय आप उसे किसी भी नाम से डिस्क पर सेव कर सकते हैं, ताकि कंटेंट गुम न हो या 
प्रेजेंट�शन को आगे भी उपयोग कर सके।

(i) 	जि स प्रेजेंट�शन पर आप काम कर रहे हैं उसे सेव करने के लिए, नीचे दिए गए चरणो ंका पालन करें : 
File Menu→ Save, या, शॉर्टकट की(key) Ctrl+S का उपयोग करें , या स्टैण्डर्ड टूलबार पर सेव 
बटन पर क्लिक करें । यह सेव डायलॉग बॉक्स खोलेगा जैसा चित्र 5.8 में दिखाया गया है, जो डिस्क 
पर स्थान का चयन करने और प्रेजेंट�शन को सेव करने के लिए नाम देने की अनुमति देता है।
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(ii) 	प्रेजेंट��शन को अलग नाम से और अलग फॉर्मेट में सेव करना:

	प्रे जेंट�शन को अलग नाम से सेव  करने के लिए, फ़ाइल → इस रूप में सहेजें या, शॉर्टकट की (key) 
Shift+Ctrl+S का उपयोग करें । 

	 Save as बॉक्स में, एक नया फ़ाइल नाम दर्ज किया जा सकता है और किसी प्रेजेंट�शन को किसी अन्य 
फ़ाइल प्रकार में सेव करने के लिए, डायलॉग बॉक्स में से ड्रॉप-डाउन (drop down) मेनू पर क्लिक 
करें  और दिए गए फोर्मट्स में से विकल्प का चयन करें , जैसा कि चित्र 5.9 में दिखाया गया है। सेव 
बटन का उपयोग करके सेविग समाप्त हो जाती है।

स्लाइड शो चलाना:

(i) 	 स्लाइड शो चलाने के लिए, मुख्य मेनू बार पर Slide Show→ start from First Slide पर क्लिक 
करें  या प्रेजेंट�शन टूलबार या स्लाइड सॉर्टर टूलबार पर स्लाइड शो आइकन पर क्लिक करें  या F5 
दबाएँ। इससे स्लाइड शो चलने लगता है।

(ii) 	 माउस बटन पर क्लिक करके आप अगली स्लाइड पर जा सकते हैं या आप अगली स्लाइड या पिछली 
स्लाइड पर जाने के लिए कीबोर्ड पर एरो कीज़ (keys) का उपयोग कर सकते हैं। अगली स्लाइड पर 
जाने के लिए आप कीबोर्ड पर स्पेसबार की (key) भी दबा सकते हैं।
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(iii)	 यदि आप किसी भी समय स्लाइड शो से बाहर निकलना चाहते हैं, तो बस Esc की (key) दबाएँ।

किसी फ़ाइल को पीडीएफ प्रारूप में सहेजें:

किसी फ़ाइल को पीडीएफ प्रारूप में सेव करने के लिए प्रेजेंट�शन का एक पोर्टेबल दस्तावेज़ प्रारूप 
(पीडीएफ) बनाया जा सकता है, जिसे मुफ्त एडोब एक्रोबैट रीडर के साथ देखा जा सकता है। किसी फ़ाइल 
को पीडीएफ फॉर्मेट में सेव करने के लिए:

(i) 	फ़ा इल → PDF के रूप में निर्यात (export) करें  पर क्लिक करें

(ii)	 वह डायरेक्टरी चुनें जिसमें आप फ़ाइल सहेजना चाहते हैं

(iii)	फ़ा इल नाम दर्ज करें  और सेव पर क्लिक करें

प्रेजेंट��शन बंद करना

किसी प्रेजेंट�शन को बंद करने के लिए, File Menu→ Close चुनें या कीबोर्ड शॉर्टकट कंुजियो ंCtrl+W 
का उपयोग करें ।

सहायता का उपयोग करना

हेल्प फ़ं क्शन हेल्प मेनू में स्थित है। लिब्रे ऑफिस हेल्प टैब का चयन करने पर, उपलब्ध सहायता विषयो ंकी 
सूची के साथ एक विडो खुलती है। खोज आइटम टेक्स्ट बॉक्स में आप एक्सप्लोर करने के लिए एक शब्द 
दर्ज कर सकते हैं। हेल्प फ़ं क्शन को खोलने का सबसे तेज़ तरीका F1 फ़ं क्शन कंुजी का उपयोग करना है। 

चित्र 5. 11 सहायता का उपयोग करना 			चि   त्र 5. 10 सहायता का उपयोग करना
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चित्र 5. 12 डुप्लीकेट स्लाइड आइकन

स्लाइड के साथ कार्य करना

अब प्रेजेंट�शन कार्य को आगे बढ़ान के लिए अगली स्लाइड को जोड़ना होगा।

डुप्लिकेट स्लाइड सम्मिलित करना

(i)	 स्लाइड फलक से वह स्लाइड चुनें जिसे आप डुप्लिकेट बनाना चाहते हैं।

(ii)	 मेनू बार से स्लाइड → डुप्लिकेट स्लाइड चुनें।

(iii)	 या, स्लाइड पर राइट-क्लिक करें  और मेनू से डुप्लिकेट स्लाइड चुनें।

(iv)	 या, वर्कस्पे स में स्लाइड पर राइट-क्लिक करें  और मेनू से स्लाइड → डुप्लिकेट स्लाइड चुनें।

आइए अभ्यास करें :

1.	 एक आकर्षक प्रस्तुतीकरण करते समय विचार किए जाने वाले महत्वपूर्ण बिदुओ ंकी सूची बनाएं।

2.	प्रे जेंट�शन बनाते समय शामिल की जाने वाली संभावित मल्टीमीडिया सामग्री की सूची बनाएं।



134

lwpuk izkS|ksfxdh (Information Technology)

SC
ER

T D
EL

HI
(v)	 या, प्रेजेंट�शन टूलबार में डुप्लिकेट स्लाइड आइकन पर क्लिक करें । जैसा कि चित्र 5.12 में दिखाया 

गया है।

नई स्लाइड सम्मिलित करना

नई स्लाइड सम्मिलित करने के लिए निम्नलिखित में से किसी एक तरीके का उपयोग करें ।

(i)	 मेनू बार से स्लाइड → नई स्लाइड चुनें।

(ii)	 या, स्लाइड पर राइट-क्लिक करें  और संदर्भ मेनू (context menu) से नई स्लाइड चुनें।

(iii)	 या, वर्कस्पे स में खाली जगह पर राइट-क्लिक करें  और संदर्भ मेनू (context menu) से स्लाइड → 
नई स्लाइड चुनें।

(iv)	 या, प्रेजेंट�शन टूलबार में न्यू स्लाइड आइकन पर क्लिक करें ।

(v)	 या, जैसा कि दिखाया गया है, कीबोर्ड शॉर्टकट Ctrl+M का उपयोग करें  जैसा कि चित्र 5.13 में 
दिखाया गया है।

चित्र 5. 13 नई स्लाइड का कीबोर्ड शॉर्टकट

स्लाइड लेआउट

नई स्लाइड डालने के बाद, लेआउट में एक या अधिक कंटेंट बॉक्स होते हैं। इनमें से प्रत्येक कंटेंट बॉक्स 
को टेक्स्ट, मूवी, चित्र, चार्ट या टेबल्स को शामिल करने के लिए कॉन्फ़िगर किया जा सकता है। आप 
संबंधित आइकन पर क्लिक करके कंटेंट के आधार पर आइकन का चयन कर सकते हैं जिसे आप दिखाना 
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चाहते हैं जैसा कि कंटेंट बॉक्स के मध्य में दिखाया गया है (चित्र 5.14)। किसी स्लाइड का लेआउट बदलने 
के लिए, बस स्लाइड pane में स्लाइड का चयन करें ।

स्लाइडो ंको कॉपी करना और मूव करना:

•	 कट और पेस्ट करें : स्लाइड को स्लाइड शॉर्टर व्यू में या स्क्रीन के बाईं ओर सामान्य व्यू में चिह्नित 
करके चुनें, राइट माउस बटन पर क्लिक करें , और कट विकल्प (यदि आप इसे मूव करना चाहते हैं) 
या कॉपी विकल्प (यदि आप इसे कॉपी करना चाहते हैं), प्रेजेंट�शन में उस स्थान को चिह्नित (mark) 
करें  जहाँ आप स्लाइड को ले जाना या कॉपी करना चाहते हैं। माउस बटन पर राइट क्लिक करें , 
कॉन्टेक्स्ट मेनू से पेस्ट विकल्प चुनें। जैसा की चित्र 5.15 में दिखाया गया है।

चित्र 5. 15 स्लाइड को कॉपी, कट और पेस्ट करना



136

lwpuk izkS|ksfxdh (Information Technology)

SC
ER

T D
EL

HI
•	 कीबोर्ड शॉर्टकट का उपयोग करना: कट, कॉपी और पेस्ट ऑपरेशन  

को कंुजियो ंके द्वारा भी किया जा सकता है:

	 (i)	 कट - Ctrl + X

	 (ii)	 कॉपी - Ctrl + C

	 (iii)	 पेस्ट करें  - Ctrl + V

स्लाइड्स को डिलीट करना:

प्रेजेंट�शन से किसी भी स्लाइड को डिलीट करने के लिए सबसे पहले उसे 
सेलेक्ट करना होगा। एक या अधिक स्लाइड हटाने के लिए

(i) 	 स्लाइड फलक (pane) में स्लाइडो ंको चिह्नित (mark) करके उनका 
चयन करें

(ii) 	 चयनित स्लाइड पर माउस बटन पर राइट क्लिक करें

(iii) 	संदर्भ (context) मेनू में डिलीट स्लाइड विकल्प का चयन करें

iv) 	 स्लाइड को हटाने का एक और तरीका यह है कि बस स्लाइड का चयन करें  और कीबोर्ड से डिलीट 
बटन दबाएं 

स्लाइड का नाम बदलना:

स्लाइडो ंको डिफ़ॉल्ट रूप से स्लाइड 1, स्लाइड 2,… नाम दिया गया है। स्लाइड का नाम बदलकर उसे 
नाम देना संभव है। किसी स्लाइड का नाम बदलने के लिए:

(i)	 स्लाइड फलक में उन्हें चिह्नित करके स्लाइड का चयन करें

(ii)	 चयनित स्लाइड पर माउस बटन पर राइट क्लिक करें

(iii)	 संदर्भ मेनू में स्लाइड का नाम बदलें विकल्प चुनें

(iv)	 स्लाइड का नाम बदलें संवाद बॉक्स दिखाई देगा जहां आप स्लाइड को नया नाम दे सकते हैं जैसा 
कि चित्र 5.17, 5.18 and 5.19 में दिखाया गया है।

चित्र 5. 16 स्लाइड डिलीट करना



Class IX : 2024-25

137

SC
ER

T D
EL

HI
चित्र 5. 17 स्लाइड का नाम बदलना	चि त्र 5. 18 स्लाइड का नाम बदलना	चि त्र 5. 19 स्लाइड का नाम बदलना

एक प्रेजेंट��शन देखें

इम्प्रेस में बनाए गए प्रेजेंट�शन को कई तरीको ंसे देखा जा सकता है। प्रेजेंट�शन को बड़े या छोटे या मध्यम 
आकार में देखा जा सकता है। उपयोगकर्ता की आवश्यकता के अनुसार प्रेजेंट�शन देखना संभव है।

दृश्य के आकार को नियंत्रित करना

व्यू टैब में ज़ूम और व्यू लेआउट डायलॉग बॉक्स खुलता है। ज़ूम बढ़ान के लिए प्रस्तावित मानो ंमें से चयन 
करना या अपना स्वयं का मान (value) दर्ज करना संभव है, जो एक पूर्ण संख्या (whole value) होनी 
चाहिए।

चित्र 5. 20 दृश्य के आकार को नियंत्रित करना
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ज़ूम करने के अन्य तरीके हैं:

(i)	स्टे टस बार पर ज़ूम स्लाइडर का उपयोग

(ii) 	 मानक (standard) टूलबार पर ज़ूम बटन का उपयोग

(iii) 	मेनू विकल्प View → Zoom →Zoom का उपयोग करें , ज़ूम और व्यू लेआउट संवाद बॉक्स खुल 
जाएगा। इसमें से उपयुक्त विकल्प का चयन करें  स्टेटस बार पर 

ज़ूम स्लाइडर(zoom slider) में दो चिन्हित (marked) सेक्शंस हैं। यदि आप पहले हाइलाइट किए गए 
अनुभाग में स्थित हैं, तो संपूर्ण स्लाइड कार्यक्षेत्र(work area) में प्रदर्शित होगी। यदि आप स्वयं को दूसरे 
स्थान पर रखते हैं, तो स्लाइड की 100% वृद्धि प्रदर्शित की जाएगी।

कार्यक्षेत्र के दृश्य (workspace views)

विभिन्न कार्यक्षेत्र दृश्य व्यू मेनू की ड्रॉप-डाउन सूची में हैं। ये दृश्य हैं नॉर्मल, आउटलाइन, नोट्स, स्लाइड 
सॉर्टर, स्लाइड मास्टर, नोट्स मास्टर, हैंडआउट मास्टर। दृश्य मेनू से उपयुक्त दृश्य का चयन किया जा 
सकता है।

I.	 नार्मल व्यू: जैसा कि चित्र 5.21 में दिखाया गया है, यह अलग-अलग स्लाइडो ं के साथ काम करने 
का मुख्य दृश्य है। इस दृश्य का उपयोग प्रारूपित करने और डिज़ाइन करने तथा टेक्स्ट, ग्राफ़िक्स 
और एनीमेशन प्रभाव जोड़न के लिए किया जाता है। इस दृश्य में, स्लाइड विडो के बीच में प्रदर्शित 
होती है। विडो के बाईं ओर, स्लाइड थंबनेल (स्लाइड) वाला फलक प्रदर्शित होता है (यदि दृश्य मेनू 
से स्लाइड फलक चुना गया है)।
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II.	 आउटलाइन व्यू: जैसा कि चित्र 5.22 में दिखाया गया है, इसमें प्रस्तुति की सभी स्लाइड एक क्रम में 

शामिल हैं। यह प्रत्येक स्लाइड को आउटलाइन फॉर्मेट में दिखाता है। प्रत्येक स्लाइड में मौजूद केवल 
टेक्स्ट ही वर्कस्पे स के अंदर प्रदर्शित होता है। यह स्लाइड टेक्स्ट को स्ट्र क्चर के रूप में प्रदर्शित करता 
है।

III.	 नोट्स व्यू: जैसा कि चित्र 5.23 में दिखाया गया है, इसका उपयोग प्रस्तुतकर्ता की जानकारी के लिए 
स्लाइड में नोट्स जोड़न के लिए किया जाता है। प्रेजेंट�शन दिखाते समय यह दर्शको ंको नजर नही ं
आता। यह उस क्षेत्र को प्रदर्शित करता है जिसमें प्रेजेंट�शन के दौरान मदद के लिए नोट्स का उपयोग 
किया जाता है।

IV.	 स्लाइड सॉर्टर व्यू: जैसा कि चित्र 5.24 में दिखाया गया है, इसमें सभी स्लाइड थंबनेल (thumbnail) 
शामिल हैं। यह स्लाइड क्रम को पुन: व्यवस्थित करने के लिए उपयुक्त है। इसका उपयोग स्लाइड्स 
को 'ड्रैग एंड ड्रॉप (drag & drop)'  विधि से क्रमबद्ध करने के लिए किया जाता है। स्लाइडो ंके समूह 
के साथ या केवल एक स्लाइड के साथ काम करने के लिए इस व्यू का उपयोग करें ।

फॉर्मेट�िग टेक्स्ट (Formatting Text)

स्लाइड की सामग्री(content) को विभिन्न तरीको ंसे फॉर्मेट (format) किया जा सकता है। फ़ॉर्मेट�िग टूलबार 
पर फ़ॉर्मेट�िग आइकन का उपयोग करना सबसे आम तरीका है। दूसरा तरीका मेनू बार से Format→ 
Text का चयन करना है, और तीसरा तरीका कीबोर्ड शॉर्टकट का उपयोग करना है। विभिन्न formatting 
विकल्पों को नीचे समझाया गया है और चित्र 5.25 में दिखाया गया है।
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यह फॉन्ट
का नाम 
दिखाता
है।

फॉरे्मटटिंग टूलबार ऑप्शन्स
इससे फॉन्ट
का साइज 
एडजस्ट 
ककआ जा 
सकता है।

इससे 
फॉन्ट का 
साइज 
बढ़ा 
सकत ेहै।

इससे हम 
टेक्सस्ट को बोल्ड 
कर सकत ेहैं
(Ctrl+B)

इससे हम 
टेक्सस्ट को 
इटैलऱक कर 
सकत ेहैं (Ctrl+I)

इससे हम टेक्सस्ट 
को अडंरऱाइन कर 
सकत ेहैं (Ctrl+U)

इससे हम टेक्सस्ट 
के बीच में ऱाइन
डाऱ सकत ेहैं

इससे हम अपने 
टेक्सस्ट को ऱेफ्ट,

राइट या बीच में 
कही भी अऱाइन कर 
सकत ेहैं

इससे हम 
फॉन्ट का 
कऱर बिऱ 
सकत ेहैं

इससे फॉन्ट का 
साइज कम कर 
सकत ेहैं।
(ctrl+*)

गचत्र 5.25 फॉमकेकगटंि टूलबार ऑप्शन्

 गचत्र 5.27 बुलेट्ठस और नंबररंि गचत्र  5.26 बुलेट्ठस और नंबररंि
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बुलेट्स और नंबरिंग: चयनित पैराग्राफ से एक बुलेटेड या नंबरिंग सूची बना सकते है। ड्रॉप डाउन सूची से 
बुलेट या नंबरिंग फ़ॉर्मेट�िग विकल्प का चयन करने के लिए आइकन के दाईं ओर छोटे त्रिकोण(triangle) 
पर क्लिक करें  जैसा कि चित्र 5.26 में दिखाया गया है। इन ड्रॉप-डाउन सूचियो ंके नीचे अधिक विकल्पों पर 
क्लिक करने से बुलेट और नंबरिंग संवाद (dialog box) खुल जाता है जैसा चित्र 5.27 में दिखाया गया है।

तालिकाओ ं(टेबल्स) के साथ काम करना

टेबल सम्मिलित (add) करना

मानक (standard) टूलबार पर टेबल आइकन का चयन करके या इन्सर्ट टैब 

चित्र 5.28 टेबल 
सम्मिलित(add) करना

पर टेबल कमांड का चयन करके टेबल्स ऐड की जाती हैं। टेबल्स ऐड करें  
डायलॉग बॉक्स में, rows की संख्या और कॉलम (column) की संख्या दी 
जाती है।

चित्र 5. 29 टेबल सम्मिलित(add) करना

टेबल्स को मानक टूलबार पर 
टेबल आइकन का चयन करके 
भी सम्मिलित (add) किया जा 
सकता है, जैसा कि चित्र 5.28 में 
दिखाया गया है। टेबल आइकन 
के आगे वाले तीर (arrow→) 
पर क्लिक करने से टेबल ड्रॉप 
डाउन मेनू खुल जाता है, कर्सर 

खीचंकर वांछित संख्या में रोज़ (rows) या कॉलम चुन सकते हैं।

इन्सर्ट → टेबल का चयन करके इन्सर्ट मेनू से एक टेबल डाली जा सकती है। 
टेबल ऐड करें  डायलॉग बॉक्स में, रोज़ (rows) की संख्या और कॉलम (column) की संख्या दी जाती है, 
जैसा कि चित्र 5.29 में दिखाया गया है। 

टेबल में डेटा दर्ज करना और एडिट करना

एक टेबल में कंटेंट डालने के लिए उसके सेल के इंसर्शन पॉइंट पर टेक्स्ट को इंटर करते हैं। टेबल में 
इंसर्शन पॉइंट को तीन तरीको ंसे मूव किया जा सकता है:

I.	 माउस राइट क्लिक दबाकर

II.	 कीबोर्ड पर TAB कंुजी दबाकर

III.	 कीबोर्ड पर तीर (arrow) कंुजियो ं(keys) का उपयोग करके
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एक सेल (cell) का चयन करना:

चित्र 5. 30 सेल(cell) का चयन 
करना

किसी टेबल के अंदर एक सेल(cell) को चुनन के लिए, माउस कर्सर को 
उसके बाएं(left) किनारे पर रखें, और जब कर्सर ढलान वाले सफेद एरो में 
बदल जाए, तो दायां(right) माउस बटन दबाएं (चित्र 5.30)।

row/column का चयन करना:

किसी टेबल में row और column सेलेक्ट करने के लिए row और column की पोजीशन पर जाएं और 
माउस का कर्सर जब व्हाइट कलर में चेंज हो जाए तो लेफ्ट माउस बटन को प्रेस कीजिए और इसको तब 
तक ड्रैग कीजिए जब तक कि वह और कॉलम के एंड तक ना पहुंच जाए।

चित्र 5. 31 row/column का चयन करना

आप जिस row या column का चयन करना चाहते हैं उस पर दायाँ माउस बटन दबाकर भी एक row 
या column का चयन किया जा सकता है, जैसा कि चित्र 5.31 में दिखाया गया है।
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टेबल का चयन करना: 

पूरी टेबल का चयन करने के लिए सबसे पहले उसके किनारे पर क्लिक करें । जब माउस कर्सर झुके हुए 
सफेद तीर में बदल जाए, तो बाईं माउस बटन पर क्लिक करें । टेबल को मूव करने के लिए, उसके किनारे 
पर स्थिति बनाएं, और जब कर्सर एक झुके हुए सफेद तीर में बदल जाए, तो टेबल को एक चुनी हुई जगह 
तक खीचंें।

माउस का उपयोग करके column की चौड़ाई और row की ऊंचाई समायोजित (adjust) करना

कॉलम की चौड़ाई बदलने के लिए, दो कॉलमो ंके बीच सीमा रेखा पर पोजीशन बदलें, और जब कर्सर (↔) 
चिह्न में बदल जाए, तो बाईं माउस बटन दबाएं, उसे तब तक दबाए रखें और खीचंें जब तक कि कॉलम 
सही चौड़ाई प्राप्त न कर ले। Row की ऊँचाई को एडजस्ट करने के लिए भी ऐसा ही किया जा सकता है।

टेबल के बॉर्डर्स और बैकग्राउंडस 

राइटर की तरह ही टेबल पर विभिन्न टेबल फ़ॉर्मेट�िग विकल्प लागू किए जा सकते हैं। बॉर्डर्स और 
बैकग्राउंडस को टेबल में डाला जा सकता है। ऐसा करने के लिए टेबल बॉर्डर पर राइट क्लिक करें , टेबल 
प्रॉपर्टीज डायलॉग बॉक्स खुलेगा जैसा कि चित्र 5.32 में दिखाया गया है, जहां से आप टेबल के बॉर्डर और 
बैकग्राउंड बदल सकते हैं।

चित्रों  को ऐड और फ़ॉर्मेट करना

अधिक जानकारी देने के लिए प्रेजेंट�शन में ग्राफिक्स डाले जा सकते हैं। जो फाइल्स कंप्यूटर में स्टोर है 
पिक्चर्स को गैलरी में से वहां से डाला जा सकता है।
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किसी फ़ाइल से कोई पिक्चर ऐड करना

चित्र 5. 33 किसी फ़ाइल से कोई पिक्चर ऐड करना

(i)	कि सी प्रेजेंट�शन में एक इमेज डालने के लिए Insert → Image पर क्लिक करे या स्टैण्डर्ड टूलबार 
में इन्सर्ट इमेज का जो ऑप्शन हे उसे चुने, उससे इन्सर्ट इमेज का एक डायलॉग बॉक्स ओपन होगा।

(ii)	 डायरेक्टरी से आपको जो फाइल चूस करनी हे उसे सेलेक्ट करें । Preview ऑप्शन को सलेक्ट करने 
के बाद सिलेक्टेड इमेजेज का थंबनेल, preview pane में ओपन होगा, जैसा की चित्र 5.33 में दिखाया 
गया है।

गैलरी से एक चित्र (image) सम्मिलित (add) करना

गैलरी में वे छवियाँ हैं जिनका उपयोग प्रेजेंट�शन में किया जा सकता है। गैलरी से एक इमेज डालने के लिए:
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(i)	 मेनू से Insert → Media → Gallery चुनें। गैलरी उपलब्ध थीम को

चित्र 5. 34 गैलरी से एक इमेज 
सम्मिलित (add) करना

 
चित्र के साथ दिखाती है (चित्र 5.34)।

(ii)	 एक थीम चुनें और उपयुक्त इमेज ढंूढने के लिए स्क्रॉल करें ।

(iii)	चित्र  पर क्लिक करें  और उसे कार्यस्थान पर खीचंें।

(iv)	 माउस बटन छोड़ें और चित्र आपकी स्लाइड में आ जाएगी।

चित्र (images) फ़ॉर्मेट करना

किसी इमेज को फ़ॉर्मेट करने में चित्र को हिलाना, आकार बदलना, घुमाना 
शामिल है। प्रेजेंट�शन में डाली गई इमेज को फॉर्मेट किया जा सकता है।

मूविंग इमेजेज/पिक्चर्स 

चित्र 5. 35 मूविंग इमेजेज/पिक्चर्स

(i)	   स्लाइड में इमेज को मूव करने के लिए, इमेज पर 
क्लिक करें , देखें कि कर्सर हाथ के आकार में बदल 
जाता है (चित्र 5.35)।

(ii) चित्र  पर क्लिक करें  और उसे जहाँ आपको वो 
इमेज चाहिये उसे वहां तक खीचंें और माउस बटन 
को छोड़ दें।

इमेजेज का आकार बदलना (resize)

(i) 	 इमेज पर क्लिक करके उसे सेलेक्ट करें । ध्यान दें  कि 

चित्र 5. 36 इमेजेज का आकार बदलना(resize)

सिलेक्शन हैंडल दिखाई दे।

(ii) 	 कर्सर को किसी एक सिलेक्शन हैंडल पर रखें। 
कर्सर आकार बदलने की दिशा का ग्राफिकल 
रिप्रजेंट�शन देकर आकार बदलता है।

(iii)	 इमेज का आकार बदलने के लिए क्लिक करें  और 
खीचंें (चित्र 5.36) और नए आकार से संतुष्ट होने 
पर माउस बटन छोड़ दें।
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रोटेटिग इमेजेज (rotating images)

(i)	 रोटेट आइकन का उपयोग करके इमेज को किसी भी

चित्र 5. 37 रोटेटिग इमेजेज(rotating images)

दिशा में घुमाया जा सकता है। किसी इमेज को 
मैन्युअल रूप से घुमाने के लिए:

	 •	� चयन हैंडल प्रदर्शित करने के लिए इमेज का 
चयन करें  और लाइन और फिलिग टूलबार पर 
रोटेट आइकन पर क्लिक करें ।

	 •	� चयनित इमेज पर फिर से क्लिक करें  और 
चयन हैंडल का आकार और रंग बदल जाता 
है (चित्र 5.37)।

	 •	� माउस पर क्लिक करें  और उस दिशा में ले 
जाएँ जिसमें आप इमेज को घुमाना चाहते हैं और संतुष्ट होने पर माउस बटन छोड़ दें।

इमेज टूलबार का उपयोग करके फ़ॉर्मेट करना�

चित्र 5. 38 इमेज टूलबार का 
उपयोग करके फ़ॉर्मेट करना

जब कोई इमेज चुनी जाती है, तो इमेज टूलबार विडो के अंतर्गत उपलब्ध 
हो जाती है जैसा चित्र 5.38 में दिखाया गया है। यह टूलबार कई फ़ॉर्मेट�िग 
विकल्प प्रदान करता है। इमेज टूलबार को मेनू बार से व्यू → टूलबार→इमेज 
(View→Toolbars→Image) का चयन करके भी प्रदर्शित किया जा सकता 
है।

ग्राफ़िक ऑब्जेक्ट प्रबंधित (manage) करना

ड्रा इंग टूल्स (drawing tools)

इम्प्रेस विभिन्न ड्राइंग टूल्स प्रदान करता है। जैसा कि चित्र 5.39 में दिखाया 
गया है, ड्राइंग टूलबार में ग्राफ़िकल ऑब्जेक्ट बनाने के लिए अधिकांश टूल 
का उपयोग किया जाता है। इस टूलबार को सक्रिय करने के लिए, मुख्य मेनू 
बार से व्यू → टूलबार → ड्राइंग(View → Toolbars → Drawing ) चुनें।

चित्र 5. 39 ड्रा इंग टूल्स(drawing tools)
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रेखाएँ खीचंना:�

चित्र 5. 40 रेखाएँ खीचंना

रेखा खीचंने के लिए नीचे दी गई प्रक्रिया का पालन करें ।

(i) 	 लाइन टूल के दाईं ओर छोटे त्रिकोण(triangle) पर 
क्लिक करें  और उपलब्ध चयन से जैसे चाहिए वैसी 
लाइन का चयन करें  (चित्र 5.40)।

(ii)	 लाइन या आकार बनाने के लिए स्लाइड पर क्लिक 
करें , खीचंें और माउस बटन छोड़ दें।

आकृतियाँ (shapes) बनाना:

रेखाएँ खीचंने के समान, आप उपलब्ध चयन से जैसे चाहिए

चित्र 5. 41 आकृतियाँ(shapes) बनाना

वैसी आकृतियाँ चुनकर, स्लाइड पर क्लिक करके और 
खीचंकर आकृतियाँ बना सकते हैं। मानव चेहरे की आकृति 
बनाने का एक उदाहरण चित्र 5.41 में दिखाया गया है।

वस्तुओ ंका समूह बनाना (Grouping)

एक से अधिक वस्तुओ ंको एक साथ समूहीकृत (ग्रुप) किया 
जा सकता है और एक ही वस्तु के रूप में माना जा सकता 
है। वस्तुओ ंको समूहीकृत (ग्रुप) करके बनाए गए समूह को 
एक ही वस्तु के रूप में बनाया जा सकता है, हिलाया (move), घुमाया (rotate), हटाया (delete) जा 

चित्र 5. 42 वस्तुओ ंका समूह 
बनाना (Grouping)

सकता है,  इत्यादि। वस्तुओ ंको एक साथ समूहित (group) करने के लिए:

(i)  ड्रॉइंग टूलबार पर चयन टूल का उपयोग करके समूहीकृत की जाने 
वाली वस्तुओ ंका चयन करें  और समूहीकृत की जाने वाली वस्तुओ ंके 
चारो ं ओर एक आयत (square) बनाएं, या Shift कंुजी (key) दबाए 
रखें और प्रत्येक ऑब्जेक्ट पर क्लिक करें । सभी ऑब्जेक्ट का चयन 
करने के लिए, मुख्य मेनू बार पर Edit → Select All का चयन करें  
पर जाएं या कीबोर्ड कीज़ Ctrl+A का उपयोग करें ।

(ii)  जब सिलेक्शन हैंडल दिखाई दे, तो मुख्य मेनू बार पर Format→Group 
पर जाएं या कीबोर्ड कीज़ (keys) Ctrl + Shift + G का उपयोग करें  
या चयनित समूह के भीतर किसी ऑब्जेक्ट पर राइट-क्लिक करें  और 
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स्टैण्डर्ड मेनू से ग्रुप का चयन करें । समूहीकृत वस्तुओ ंका एक उदाहरण चित्र 5.42 में दिखाया गया 
है।

असमूहीकृत करना (Ungrouping)

ऑब्जेक्ट्स को असमूहीकृत (ungropup) करने के लिए नीचे दी गई प्रक्रिया का पालन करें :

(i) समूह में किसी भी एक ऑब्जेक्ट पर क्लिक करके समूह का चयन करें ।

(ii) जब सिलेक्टेड हैंडल दिखाई दे, तो मेनू बार पर फ़ॉर्मेट → ग्रुप → अनग्रुप (Format → Group → 
Ungroup) पर जाएं या कीबोर्ड कीस (keys) Ctrl+Alt+Shift+G का उपयोग करें  या ग्रुप पर राइट-
क्लिक करें  और स्टैण्डर्ड मेनू से अनग्रुप (ungroup) का चयन करें ।

प्रायोगिक कार्य

एक प्रेजेंट�शन बनाएं जो आपकी पसंद की किसी भी कंपनी द्वारा लॉन्च की गई कार का विवरण 
प्रदर्शित करे। निम्नलिखित स्लाइडर शामिल करें :

(i)	 कंपनी का परिचय

(ii)	 कंपनी द्वारा बेची जाने वाली कारो ंकी सूची।

(iii)	लांच की गई नई कार का परिचय।

स्लाइड मास्टर्स के साथ काम करना

इम्प्रेस विभिन्न स्लाइड मास्टर्स के साथ आता है। ये स्लाइड मास्टर्स साइडबार के मास्टर पेज सेक्शन में 
उपलब्ध हैं। इसके तीन उपखंड(सबसेक्शन्स) हैं, नामतः  इस प्रेजेंट�शन में प्रयुक्त (used), हाल ही में प्रयुक्त 
(used), और उपयोग के लिए उपलब्ध। इसे विस्तृत (expand) करने के लिए नाम के आगे विस्तृत मार्क र 
(expand marker) पर क्लिक करें  (चित्र 5.43 देखें)। यह स्लाइड्स के थंबनेल दिखाएगा। थंबनेल को 
छिपाने के लिए सबसेक्शन को कंप्रेस  या छोटा करने के लिए बस कलापसे मार्क र (collapse marker) 
पर क्लिक करें । उपयोग के लिए उपलब्ध में दिखाए गए प्रत्येक स्लाइड मास्टर में समान नाम वाले फॉर्म 
टेम्पलेट सूचीबद्ध (list) होते हैं।
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चित्र 5. 43 स्लाइड मास्टर्स के साथ काम करना
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ट्रांज़ि शन जोड़ना�

चित्र 5. 44 ट्रांज़ि शन जोड़ना

(i)	 साइडबार में, स्लाइड ट्रांज़िशन सेक्शन खोलने के 
लिए स्लाइड ट्रांज़िशन आइकन का चयन करें ।

(ii)	 स्लाइड्स फलक (pane) या स्लाइड सॉर्टर व्यू में, 
ट्रांज़िशन लागू करने के लिए स्लाइड्स का चयन करें । 
यदि आप सभी स्लाइडो ं पर ट्रांज़िशन लागू (apply) 
करना चाहते हैं, तो किसी भी स्लाइड का चयन न 
करें ।

(iii)	 चयनित स्लाइड पर अप्लाई लिस्ट में, एक ट्रांज़िशन 
चुनें।

(iv)	 मॉडिफाई ट्रांजीशन सेक्शन (modify transition 
section) में, गति बदलकर या ध्वनि जोड़कर चयनित 
ट्रांजीशन को संशोधित (change) करें । ट्रांज़िशन के 
दौरान ध्वनि (sound) चलाने के लिए, ध्वनि सूची से 
एक ध्वनि चुनें।

(v)	 यदि एक ध्वनि का चयन किया जाता है, तो अगली 
ध्वनि तक लूप विकल्प सक्रिय हो जाता है। जब तक 
कोई अन्य ध्वनि प्रारंभ न हो जाए तब तक ध्वनि को बार-बार चलाने के लिए इस विकल्प का चयन 
करें ।

(vi)	 अगली स्लाइड पर आगे बढ़न का तरीका चुनें: मैन्युअल रूप से (माउस क्लिक द्वारा) या स्वचालित 
रूप से (स्वचालित रूप से बाद में)। स्वचालित रूप से आगे बढ़न का चयन करने के लिए, आपको 
यह बताना होगा कि अगली स्लाइड पर स्वचालित (ऑटोमेटिकली) रूप से आगे बढ़न से पहले स्लाइड 
कितनी देर तक दिखती रहनी चाहिए।

(vii)	सभी स्लाइडो ंपर ट्रांज़िशन लागू करने के लिए, सभी स्लाइड्स पर लागू करने के लिए क्लिक करें ।

(viii)	वर्तमान स्लाइड से स्लाइड शो शुरू करने के लिए, ट्रांज़िशन जांचें, स्लाइड शो पर क्लिक करें ।
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प्रायोगिक कार्य

अभ्यास :1 

स्लाइड 1

विषय: आईसीटी तकनीक पर कार्य करना 

रंग: हरा  विभिन्न आईसीटी तकनीकें  (फ़ॉन्ट आकार: 25) 

बैकग्राउंड: आसमानी नीला 

एनीमेशन: फ़े ड इन

स्लाइड ट्रांजिशन:.................अलग-अलग रंग के साथ विभिन्न आईसीटी तकनीकें

अभ्यास :2

आप अपनी प्रेजेंट�शन की पहली स्लाइड में किसी कंपनी का लोगो (चित्र) कैसे लगाएंगे?

 महत्वपूर्ण iz'u 

बहुविकल्पीय iz'u

1.	नी चे सूचीबद्ध कौन सा व्यू बटन कार्यक्षेत्र में उपलब्ध व्यू बटनो ंमें से एक नही ंहै?

	 (ए)	 सामान्य दृश्य				    (बी)	 रूपरेखा दृश्य

	 (सी)	थ बनेल दृश्य 				    (डी)	न ोट (टिप्णियाँ)

2.	 शो के दौरान किसी भी समय स्लाइड शो को निम्नलिखित में से कौन सी कंुजी दबाकर बाहर निकाला 
जा सकता है?

	 (ए)	स्पे स बार 					     (बी)	 एंड कंुजी

	 (सी)	ब्रे क कंुजी 					    (डी)	 Esc कंुजी

3.	 निम्नलिखित में से कौन सा कार्य फलक का अनुभाग नही ंहै?

	 (ए)	 मास्टर पेज 				    (बी)	 लेआउट

	 (सी)	 कस्टम व्यू 					    (डी)	 कस्टम एनीमेशन
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4.	 आमतौर पर स्लाइड बनाने, फ़ॉर्मेट करने और डिज़ाइन करने के लिए किस दृश्य का उपयोग किया 

जाता है?

	 (ए)	 सामान्य दृश्य 				    (बी)	 रूपरेखा दृश्य

	 (सी)	न ोट्स 					     (डी)	 स्लाइड सॉर्टर व्यू

5.	 निम्नलिखित में से कौन सा विकल्प प्रेजेंट�शन विज़ार्ड पर उपलब्ध नही ंहै?

	 (ए)	 खाली प्रस्तुति				    (बी)	 फॉर्म टेम्पलेट

	 (सी)	न या प्रेजेंट�शन खोलें  			   (डी)	 मौजूदा प्रेजेंट�शन खोलें

6.	 निम्नलिखित में से कौन सा मुख्य इम्प्रेस विडो का हिस्सा नही ंहै?

	 (ए)	 स्लाइड फलक 				    (बी)	 कार्यक्षेत्र

	 (सी)	 कार्य फलक 				    (डी)	 कार्य फलक

7.	वि षय पर बोलते समय स्लाइड शो को अपने आप आगे बढ़ान के लिए निम्नलिखित में से किस सुविधा 
का उपयोग किया जाता है?

	 (ए)	 कस्टम एनीमेशन 				    (बी)	 रिहर्सल टाइमिग

	 (सी)	 स्लाइड ट्रांज़िशन 				    (डी)	 (ए) या (बी)

रिक्त स्थान भरें

1.	कि सी प्रेजेंट�शन को सेव करने के लिए हम________________कंुजी संयोजन का उपयोग कर सकते 
हैं।

2.	लि बरऑफिस इम्प्रेस में डिफ़ॉल्ट रूप से प्रेजेंट�शन___________एक्सटेंशन के साथ सेव होता है।

3.	 स्लाइड शो के लिए____________________कीबोर्ड शॉर्टकट कंुजी है।

4.	 स्लाइड को संशोधित करने के लिए मास्टर पेज________________का प्रयोग किया जाता है।

5.	 _________________प्रेजेंट�शन पर बुनियादी ऑपरेशन करने के लिए उपयोग किया जाता है

6.	लि बरऑफिस इम्प्रेस को बंद करने की शॉर्टकट कंुजी__________________है।
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7.	 हर प्रेजेंट�शन में पहली स्लाइड होनी चाहिए________________________।

8.	न ई स्लाइड डालने की शॉर्ट कट कंुजी_________________________है।

9.	 एक नया रिक्त प्रेजेंट�शन बनाने के लिए,_______________ कंुजी संयोजन का उपयोग करें ।

सही/गलत को चिन्हित करें

1.	 उपयोगकर्ता अपना खुद का टेम्प्लेट बना सकता है और प्रेजेंट�शन विज़ार्ड में इसका उपयोग कर 
सकता है।

2.	 एक बार पूर्व-निर्धारित स्लाइड मास्टर का चयन करने के बाद, स्लाइड की पृष्ठभूमि को नही ंबदला 
जा सकता है।

3.	 स्लाइड में जोड़े गए नोट्स प्रेजेंट�शन के दौरान देखे जा सकते हैं।

4.	फ़ु  टर में जोड़ा गया टेक्स्ट केवल अंतिम स्लाइड पर प्रदर्शित होता है।

5.	 एक बार लागू होने के बाद एनिमेशन को बदला तो जा सकता है लेकिन हटाया नही ंजा सकता।

6.	 एक प्रेजेंट�शन में एकाधिक स्लाइड मास्टर हो सकते हैं।

7.	न ोट्स व्यू का उपयोग दर्शको ंके लिए किया जाता है।

8.	 एक उपयोगकर्ता अपना स्वयं का स्लाइड मास्टर बना सकता है।

9.	 हेडर में जोड़ा गया टेक्स्ट केवल पहली स्लाइड पर प्रदर्शित होता है।

10.	 स्लाइड नाम रूपरेखा दृश्य में शामिल हैं।

लघु उत्तरीय iz'u 

1.	प्रे जेंट�शन में तालिका बनाने के चरण लिखिए।

2.	प्रे जेंट�शन में स्लाइड ट्रांज़िशन जोड़न के चरण लिखें।

3.	प्रे जेंट�शन का उपयोग करने के क्या फायदे हैं?

4.	प्रे जेंट�शन के पाँच दृश्य कौन से हैं?
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5.	 आप प्रत्येक स्लाइड के नीचे आप स्लाइड संख्या कैसे जोड़ेंगे?

6.	 स्लाइड में चार्ट डालने के चरण लिखिए।

7.	 इम्प्रेस में स्लाइड में कौन से ऑब्जेक्ट डाले जा सकते हैं?

8.	 स्लाइडर्स पर हेडर या फ़ू टर में टेक्स्ट कैसे जोड़ा जा सकता है?

9.	 आप हर स्लाइड के ऊपर कंपनी का नाम कैसे जोड़ेंगे?

10.	 टेम्पलेट बनाने के चरण लिखिए।

vvv
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खंड ए: वस्तुनिष्ठ प्रकार के iz'u

प्र.1	 रोजगार कौशल (Employbility Skills) पर दिए गए 6 iz'uksa में से किन्हीं  4 के उत्तर दें 

� (1 x 4 = 4 अंक)

i.	 एक सीधी (खड़ी) शारीरिक मुद्रा क्या बताती/दिखाती है?� 1

	 (ए)	 शर्म						     (b)	 डर

	 (c)	 आत्मविश्वास				    (d)	 बुद्धिमत्ता	

ii..	 जब हम मौखिक रूप से संवाद करते हैं, तो हमें ________ का उपयोग करना चाहिए.� 1

	 (a)	 कठिन शब्दों				    (b)	 आसान शब्द

	 (c)	भ्रा मक शब्द				    (d)	 लघुरूप

iii.	 यह अप्रत्याशित, कठिन, भ्रमित करने वाली और चुनौतीपूर्ण स्थितियो ं से उत्पन्न मनोवैज्ञानिक तनाव 
और परेशानी की स्थिति को संदर्भित करता है।� 1

	 (a)	 तनाव प्रबंधन				    (b)	 समय प्रबंधन

	 (c)	व्य क्तित्व आत्मविश्वास			   (d)	 आत्म प्रबंधन	 1

सूचान प्रौद्योगिकी 
(Information Technology)

(विषय कोड - 402)

कक्षा – IX

Sample Paper– 2024-25

अधिकतम. समय: 2 घंटे� अधिकतम. अंक: 50
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iv.	कि सी व्यक्ति का अपने निर्णय, क्षमताओ ंऔर योग्यता में यथार्थवादी भरोसा और विश्वास होना� 1

	 (a)	 स्व प्रेरणा					     (b)	 अतिआत्मविश्वास

	 (c)	 आत्मविश्वास				    (d)	 टीम के खिलाड़ी

v.	डिजि टल तकनीक में सूचना(information) को ___________ में बदला जाता है� 1

	 (a)	बि ट्स (0 और 1)				    (b)	 इलेक्ट्रि क स्पंदन(Electric Pulses)

	 (c)	 यांत्रिक\स्पंदन(Mechanical Pulses)	 (d)	 अंक (0 से 9) ( digits (0 to 9)

vi.	 आईसीटी कौशल (ICT Skill)___________में हमारी मदद करते हैं.� 1

	 (a)	 दूसरो ंके साथ संचार			   (b)	 हमारे व्यवसाय को बढ़ावा दें

	 (c)	 दोस्तों के साथ जुड़े रहें			   (d)	 उपरोक्त सभी	

प्र.2	दि ए गए 6 iz'uksa में से किन्हीं  5 के उत्तर दें (1 x 5 = 5 अंक)	

i. 	 सूचना प्रौद्योगिकी (Information Technology) जो सेवा की गुणवत्ता में सुधार करके व्यवसाय को 
सक्षम बनाती है:� 1

	 (a)	 आईटी					     (b)	 आईसीटी

	 (c)	 आईटीईएस					    (d)	 इनमे से कोई भी नही ं

ii.	 बीपीएम (BPM) का मतलब है______� 1

	 (a)	व्य वसाय प्रक्रिया प्रबंधन			   (b)	बि जनेस प्रक्रिया प्रबंधन

	 (c)	बि जनेस प्रोटोकॉल प्रबंधन			  (d)	 इनमे से कोई भी नही	ं1

iii.	 बहुराष्ट्री य कंपनियो ंके मुख्यालय भारत के_________हैं।

	 (a)	 बाहर					     (b)	 अंदर

	 (c)	 इनमे से कोई भी नही ं
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iv.	 _____________टाइप की गई कुल प्रविष्टियो ं में से सही प्रविष्टियो ं के प्रतिशत के रूप में परिभाषित 

करता है।� 1

	 (ए)	 शुद्धता					     (b)	 पढ़न की सटीकता

	 (c)	 टाइपिग सटीकता				    (d)	 लेखन सटीकता

v.	 ________मुकेश की टाइपिग स्पीड 45 WPM है। WPM का पूर्ण रूप है� 1

	 (a)	 शब्द भाग मिनट				    (b)	 शब्द प्रति मिनट

	 (c)	 शब्द प्रति मास्टर 				    (d)	 इनमें से कोई भी नही	ं1

vi.	 ________F1 से F12 लेबल वाली विशेष कीज़ कहलाती हैं 	 .

	 (a)	 रिटर्न की 					     (b)	फ़ं  क्शन कीज़  

	 (c)	 Ctrl की  					     (d)	 इनमे से कोई भी नही	ं1

प्र.3	दि ए गए 6 iz'uksa में से किन्हीं  5 के उत्तर दें (1 x 5 = 5 अंक)

i.	 FOSS का मतलब है______________.� 1

(a)	 मुफ़्त और मुक्त सॉफ्ट सॉफ़्टवेयर (Free and Open Soft Software)

(b)	 मुफ़्त और मुक्त स्रोत सॉफ़्टवेयर(Free and Open Source Software)

(c)	 मुफ़्त और मुक्त स्रोत(Free and Open Source)

(d)	 इनमे से कोई भी नही ं

ii.	 राइटर में, डिफ़ॉल्ट रूप से, फ़ाइल _____________प्रारूप में सहेजी जाती है� 1 

	 (a)	 .odf					     (b)	 .ods

	 (c)	 .odt					     (d)	 इनमे से कोई भी नही	ं1

iii.	 राइटर विडो का सबसे ऊपरी बार है � 1

	 (a)	 शीर्षक टाईटल				    (b)	 बार मेनू

	 (c)	स्टे टस बार					     (d)	 स्क्रॉल बार
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iv.	 जब आप माउस पॉइंटर को किसी टूल पर लाते हैं और उस टूल का अर्थ देखते हैं तो उसे कहा जाता 

है� 1

	 (a)	टि प टूल					     (b)	 टूल का अर्थ

	 (c)	 टूल टिप					     (b)	 टूल का विवरण

v.	 मेल मर्ज विज़ार्ड का उपयोग करके मेल मर्ज करने के चरण________________हैं।

	 (a)	 2						      (b)	 3

	 (c)	 4						      (d)	 5	

vi.	 राधा एक टेबल को दो भागो ंमें बाँटना चाहती है। निम्नलिखित में से कौन सा विकल्प उसकी मदद 
करेगा? 

	 (a)	 टेबल -> स्प्लिट टेबल			   (b)	 टेबल -> टेबल मर्ज करें

	 (c)	 फॉर्मेट -> टेबल -> टेबल मर्ज करें 	 (d)	 फॉर्मेट -> टेबल -> स्प्लिट टेबल	 1

प्र. 4	दिए गए 6 iz'uksa में से किन्हीं  5 के उत्तर दें (1 x 5 = 5 अंक)

i.	 निम्नलिखित में से कौन सा चिह्न गणितीय ऑपरेटर है/हैं?� 1

	 (a)	 जोड़ना					     (b)	 घटाव

	 (c)	 गुणा					     (d)	 उपरोक्त सभी	

ii.	 निम्नलिखित में से कौन सा का विस्तार CalC में बनाई गई वर्क शीट का है� 1

	 (a)	 .ods					     (b)	 .odd

	 (c)	 .xls						     (d)	 .obj 

iii.	कि सी फ़ं क्शन की शुरुआत इससे होनी चाहिए� 1

	 (a)	 '=' चिन्ह					     (b)	 अक्षर

	 (c)	न बर					     (d)	 उपरोक्त सभी	
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iv.	 वर्क शीट एक_________________है� 1

	 (a)	 कार्यपुस्तिकाओ ंका संग्रह			

	 (b) 	प्रो सेसिग सॉफ्टवेयर

	 (c)	 पंक्तियो ंऔर स्तंभो ं(रोज़ और कॉलम्स ) का संयोजन

	 (d)	 इनमे से कोई भी नही ं

v.	 CalC में डिफ़ॉल्ट पेज ओरिएंटेशन है� 1

	 (a)	 लैंडस्के प 					     (b)	क्षैति ज

	 (c)	 तसवीर					     (d)	 इनमें से कोई नही ं

vi.	 एक सेल रेंज में सेल संदर्भों के बीच   प्रतीक हमेशा होता है� 1

	 (a)	 ; (अर्धविराम)				    (b)	 . (पूर्ण विराम)

	 (c)	 , (अल्पविराम)				    (d)	 : (कोलन)

प्र.5	दि ए गए 6 iz'uksa में से किन्हीं  5 के उत्तर दें (1 x 5 = 5 अंक)

i.	डिफ़ॉल्ट  रूप से प्रेजेंट�शन___________विस्तार के साथ सहेजा जाता है।� 1

	 (a)	 .odp					     (b)	 .odc

	 (c)	 .odw					     (d)	 इनमे से कोई भी नही ं

ii.	 स्लाइड शो चलाने के लिए आप_____________शॉर्टकट का उपयोग कर सकते हैं।

	 (a)	 एफ8					     (b)	 एफ7

	 (c)	 एफ6					     (d)	 एफ5

iii.	कि सी स्लाइड का लेआउट बदलने के लिए, बस उस स्लाइड में    का चयन करें  

	 (a)	 स्लाइड शो					    (b)	 स्लाइड सेटिग

	 (c)	 स्लाइड फलक (पेन)			   (d)	 उपरोक्त में से कोई नही ं
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iv.	 इम्प्रेस (Libre office Impress) में विभिन्न कार्यक्षेत्र दृश्य क्या हैं?� 1

	 (a)	 सामान्य एवं रूपरेखा			   (b)	न ोट्स मास्टर और हैंडआउट मास्टर

	 (c)	 स्लाइड सॉर्टर और स्लाइड मास्टर	 (d)	 उपरोक्त सभी

v.	 _________दो या दो से अधिक स्लाइडो ंके बीच एनीमेशन बनाने में मदद करता है।

	 (a)	 कस्टम एनीमेशन				    (b)	 स्लाइड ट्रांज़िशन

	 (c)	 ड्राइंग टूल्स					    (d)	 सम्मिलन बिदु	

vi.	प्रे जेंट�शन बनाते समय, पहली स्लाइड सामान्यतः _______________होती है। 

	 (a)	वि वरण स्लाइड				    (b)	 शीर्षक स्लाइड

	 (c)	 अंत स्लाइड				    (d)	  इनमे से कोई भी नही ं

खंड बी: व्यक्तिपरक प्रकार के iz'u

रोजगार कौशल पर दिए गए 5 iz'uksa में से किन्हीं  3 के उत्तर दें (2 x 3 = 6 अंक)।

प्रत्येक iz'u का उत्तर 20-30 शब्दों में दें।	

प्र.6	 दृश्य संचार(Visual communication) के लिए उपयोग किए जाने वाले किन्हीं  चार सामान्य संकेतो ं
के उदाहरण दीजिए।� 2

प्र.7	 सहकारी समिति से आप क्या समझते हैं?� 2

प्र.8	 पर्यावरणीय निम्नीकरण क्या है?� 2

प्र.9	 स्व-प्रबंधन कौशल(self management skills) के विभिन्न प्रकार क्या हैं?� 2

प्र.10	कंप्यूटर पर ब्राउज़र का उपयोग किस लिए किया जाता है?� 2
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दिए गए 6 iz'uksa में से किन्हीं  4 iz'uksa का  20-30 शब्दों में उत्तर  दें (2 x 4 = 8 अंक)	

प्र. 11 वर्क शीट का डिफ़ॉल्ट नाम क्या है? इसका नाम कैसे बदला जा सकता है?	� 2

प्र. 12 बैंक�िग प्रणाली में आईटी के विभिन्न उपयोगो ंकी सूची बनाएं।	�  2

प्र.13	प्रेजेंट�शन का उपयोग करने के क्या फायदे हैं?	� 2

प्र.14	"गाइड कीज़" और "होम कीज़" से आप क्या समझते हैं?	�  2

प्र.15	 मेल मर्ज के लिए कौन से दो दस्तावेज़ आवश्यक हैं?	�  2

प्र.16	 एमएस वर्ड/लिबरे ऑफिस राइटर में कितने प्रकार के अलाइनमेंट होते हैं?	�  2

दिए गए 5 iz'uksa में से किन्हीं  3 iz'uksa का  50-80 शब्दों में उत्तर  दें (4 x 3 = 12 अंक)	

प्र.17	निम्नलिखित क्षेत्रों में आईटी के उपयोग का एक उदाहरण दीजिए:� 4

	 ए)	 ऑनलाइन बैंक�िग				    b)	 ई-सीखना (E-Learning)

	 c)	 वैज्ञानिक अनुसंधान और इंजीनियरिंग	 d)	 अस्पताल प्रबंधन प्रणाली	

प्र.18	अपनी प्रस्तुति (presentation) में स्लाइड ट्रांज़िशन जोड़न के चरण लिखें।	�  4

प्र.19	 परिणाम विडो (Results Window) के विभिन्न रंग संकेत बताएं।	�  4

प्र.20	 एकल फ़ं क्शन(single function) का उपयोग करें  और सूत्र (formula) बनाएं।� 4

नाम गणित विज्ञान अंग्रेजी आईटी सामाजिक 
विज्ञान

कुल औसत

अमित        
आलोक        
अनीता        
अमिता        

	 अमित द्वारा प्राप्त कुल अंको ंकी गणना के लिए सूत्र को G2 में दर्ज करें । 

	 अमित द्वारा प्राप्त औसत की गणना के लिए सूत्र को H2 में दर्ज करें ।
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	वि ज्ञान के लिए प्राप्त उच्चतम अंक जानन के लिए C6 में सूत्र दर्ज करें ।

	 गणित के लिए प्राप्त न्यूनतम अंक जानन के लिए B6 में सूत्र दर्ज करें ।	�  4

प्र.21	टेबल के क्या फायदे हैं? आठवी ंकक्षा का अपना रिपोर्ट कार्ड तालिका प्रारूप में तैयार करें ।	 4

vvv

uksV % bl iqLrd esa iz;qDr lkexzh ,oa fp= iw.kZr% 'kS{kf.kd mn~ns'; ds fy, gS] fdlh O;kolkf;d mi;ksx ds fy, ughaA
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